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SOP: D1.01 Prevention of DNA Cross-Contamination

Summary

Glen Canyon NRA Laboratory is dedicated to reducing cross-contamination by assigning
specific work areas for molecular processes, using prescribed order of entry to reduce the
likelihood of contamination, and by using bleach and UV light to clean surfaces and
equipment. The outer laboratory is designated for Post-PCR applications; the inner laboratory
is used for Pre-PCR applications.

Procedure — Assigned Work Areas and Order of Entry

_— Wall
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w Hood
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A. Order of Entry: to reduce the risk of contamination, one should only move from more-

to less-clean areas if using separate lab spaces on the same day. The cleanest area is the
inner lab-hood (ILH), then the inner lab-general (ILG), and least clean (most likely to
have DNA contamination) is the outer lab (OL) area used by the molecular lab,
specifically the hood and counters adjacent to it.

a. If you've worked in ILH, you can move to ILG or OL. If you’ve worked in ILG, you
can move to OL. If you’ve worked in OL, you cannot work in ILH or ILG until you
change clothes and shower (until the next day).

B. Outer Lab: This space is designated for the following equipment and molecular

applications. OL coats and gloves must be worn at all times when working with PCR-
amplified DNA. Office supplies used in the OL (pens, scissors, etc.) should be marked
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with red tape to make it easier to track any potential cross-contamination by movement
of materials between labs.

a. DNA amplification - side workbench

Equipment: Mycycler thermocycler

b. DNA visualization - side workbench, hood

Equipment: gel chambers, trays, casting chamber and combs,
microwave, Erlenmeyer flasks, graduated cylinder, Core electronic
balance, power supply, hot pad grip, pipettes designated for
electrophoresis, shockshield, biohazard rack, pipette rack

Supplies: nitrile gloves, laboratory coats, agarose, TAE buffer, ethidium
bromide, filtered tips, molecular ladders, biohazard bags, 10% bleach
solution

Inner laboratory-general: This space is designated for the following equipment and
molecular applications. ILG coat and gloves must be worn at all times when working -
coats are in the coat closet section on the far right. Office supplies used in the ILG
should be marked with colored tape to make it easier to track any potential cross-
contamination. Office supplies used at the counters by the NanoDrop, where DNA
concentration (including that of amplified DNA that will be sequenced) is measured,
should be marked with yellow tape. Green tape is used for supplies by the
microcentrifuge, where DNA extraction and template addition to PCR master mix is
performed. Orange tape is used in areas used for beach monitoring (by the window),
where there is a lot of traffic back-and-forth between the inner and outer labs.

a. Plankton filtering and centrifugation — ILG workbench by sink

Equipment: 250 and 64 pum strainers, LW Scientific centrifuge

Supplies: nitrile gloves, laboratory coats, 10% bleach solution, vinegar,
wash bottle with water, 50 ml conical tubes, PBS solution, 10ml
pipettes, pipette bulb

b. DNA extractions — ILG workbench with UV light

Equipment: pipettes designated for ILG applications only, Eppendorf
5424 microcentrifuge, vortex, vortex adapter, Eppendorf Thermomixer,
biohazard rack

Supplies: nitrile gloves, laboratory coats, filtered pipette tips, extraction
kit(s), tube racks, pipette rack, biohazard bags

c. DNA quantification — ILG workbench beside ILG hood

Equipment: Nanodrop 2000, pipette, computer
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ii. Supplies: nitrile gloves, laboratory coats, filtered pipette tips, Kimwipes,
T3 buffer/blank, DI water

d. Template addition to PCR mastermix — ILG workbench with UV light
i. Equipment: pipettes designated for ILG applications only

D. Inner lab-hood: this space is a “clean room” used for PCR master mix setup and primer
re-suspension and dilution, and is designated for the following equipment. ILH coats
and gloves must be worn at all times when working in the inner hood. These coats are
in the coat closet section on the far right. Office supplies used in the ILH are not marked
with tape; they should never leave the hood.

a. Equipment: Lab dancer vortex, personal microcentrifuge, pipettes designated
for ILH only, ice blocks, tube racks, pipette rack, biohazard rack

b. Supplies: Promega Core System | (GoTaq, dNTPs, buffer, MgCl,), primers,
molecular grade water, filtered pipette tips, laboratory coat for ILH use only,
biohazard bags

1. Procedure — Decontamination of Countertops and Selected Equipment

A. Bleach — Bleach is more reliable for destroying and degrading DNA than UV light.
Bottles containing 10% bleach solution are located in the inner and outer labs and
should not be removed.

a. Countertops should be bleached before and after any processing is done.

b. Equipment that can be soaked in bleach (test tube blocks, PCR ice blocks,
glassware) should be soaked in a 10% bleach solution for at least 1 hour after
each use, then rinsed thoroughly and allowed to air-dry. There is a dish tub
beneath the ILG sink that can be used for soaking.

B. UV light — UV lights are found in three areas of the lab — in each of the hoods and above
the ILG workbench that holds the microcentrifuge. Each light has a programmable timer
so that the area can be decontaminated at night when no personnel are present, to
prevent exposure to UV rays. The light can damage plastics; to limit the damage, lights
should be used only on the days when the area is used. UV lightbulbs should be
replaced every few years as they lose efficacy over time.

_a. After using one of the hoods or the ILG workbench, program its timer to come
on for 1 hour that evening.

i, For the timers in the inner lab, press “Program” and use the dial to set
the date and times as desired. Press “OK” when done.
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ii. Forthe timer in the outer lab, press “Program” and use the day and
time buttons to set. Press “Clock” when done.

b. Lights should be turned off when the molecular lab is not in use, such as over
periods of furlough when no molecular lab technicians are present.
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Attached Documentation:
Thermo Scientific’s Good Laboratory Pipetting Guide (A1.06)

SOP: D1.02 Pipetting

Summary

Proper techniques must be used when pipetting any liquid material to ensure accurate
results are obtained.

Equipment

Finnpipettes F2 series
Filtered pipette tips

Procedure

A. Every Molecular Laboratory technician must first read pages 4-7, 9-11, and 14 of

Thermo Scientific’s Good Laboratory Pipetting Guide before using any Finnpipettes.

Always check your pipette at the beginning of your work day for dust and dirt on the
outside, if needed wipe with 70% ethanol.

Make sure you are using the correct tips for each pipette.

For improved accuracy, pre-rinse (3-5 times) the tip with the liquid which will be
pipetted.

Avoid turning the pipette on its side when there is liquid in the tip. The liquid might
get into the interior of the pipette and contaminate the pipette. If this does occur,
follow the maintenance guide for cleaning pipettes (Refer to SOP 6.03: Finnpipette
Calibration and Maintenance).

Avoid contamination to or from hands by always using the tip ejector.

You may sometimes use one pipette tip for more than one measurement (i.e., when
aliquotting a solution into many tubes). Avoid contamination by changing the tip if
it touches anything other than the inside of the tube holding the solution you are
aliquotting (i.e., tube exterior, glove, other solution, etc.).

When not in use, always store pipettes in an upright position on the pipette stand

provided.
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To pipette, select an appropriate pipette for the task and arrange pipettes, racks
and other accessories so that you can easily reach them.

If possible use a chair with adjustable height so that you can have a good working
posture. An armrest and footrest can help reduce fatigue.

Keep your wrists straight and use a relaxed grip while pipetting.
Take a 1 to 2 minute break at least after every 20 minutes of pipetting.

Change body position, if possible (sitting/standing).

Forward pipetting

Note: use the forward method when pipetting and mixing a sample or reagent
into another liquid.

Press the operating button to the first stop.

Dip the tip into the solution to a depth of 1 cm, and slowly release the operating
button. Withdraw the top from the liquid, touching it against the edge of the
reservoir to remove excess liquid.

Dispense the liquid into the receiving vessel by gently pressing the operating
button to the first stop. After one second, press the operating button to the
second stop. This action will empty the tip. Remove the tip from the vessel,
sliding it along the wall of the vessel.

Release the operating button to the ready position.

For repetitive pipetting (as when aliquotting PCR master mix) refer to A1.06,
page 7.

Reverse pipetting

Reverse pipetting is typically used for pipetting samples or reagents when no
mixing into another liquid is required.

Reverse pipetting avoids the risk of splashing, and foam or bubble formation.
This technique is used for pipetting solutions with a high viscosity or a tendency
to foam.

Reverse pipetting is also recommended for dispensing small volumes.

To begin, press the operating button to the second stop.
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Dip the tip into the solution to a depth of 1 cm, and slowly release the operating
button. This action will fill the tip. Withdraw the tip from the liquid, touching it
against the edge of the reservoir to remove excess liquid.

Dispense the liquid into the receiving vessel by depressing the operating button
gently and steadily to the first stop. Hold the button in this position. Some

‘liquid will remain in the tip, and this should not be dispensed.

The liquid remaining in the tip can be pipetted back into the original solution or
thrown away with the tip.

Release the operating button to the ready position.
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Attached Documentation:

Molecular Lab Chemical Supply Inventory

Molecular Lab Equipment Inventory

Molecular Laboratory Equipment Documentation (A6.00)

SOP: D1.03 Maintaining a Molecular Laboratory Chemical Supply inventory

Summary

An accurate record of all laboratory supplies and chemicals must be kept for future
reference.

Procedure

Receipt of Lab Supplies

When supplies are received in the Molecular Laboratory, document the date received,
technician initials, and description of each item including company, quantity, lot
number, and reason for ordering the item on the Molecular Laboratory Supplies
Inventory Sheet located in the Supply Log.

When chemicals, media, or disposable supplies are received, record the item, grade,
lot number, date received, expiration date, and technician initials in the
Chemical/Media Log (Attachment A1.07). The date opened and date disposed,
along with the technician initials, should also be recorded when appropriate.

When chemicals, media, and disposable supplies are received, record the date
received and technician initials on each box/container. Write all relevant information
for the new supplies at the bottom of the most current Chemical Supply Inventory.
When these items are opened, record the date opened and technician initials on the
box/container and in the Chemical Supply Inventory.

When non-disposable supplies are received, write all relevant information for the
new supplies at the bottom of the most current Equipment Inventory.

Initial and date the shipping receipt and accompanying documentation regarding
origin, purity, and traceability for all materials and keep in the supply log.

B. Chemical Supply Inventory

1. The laboratory must maintain a Chemical Supply Inventory documenting all of the

chemicals and disposable items in the laboratory.
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The Chemical Supply Inventory will include the name of the product, manufacturer,
lot numbers, maximum quantity, current quantity, dates received and opened with
technician initials, expiration date, “disposed of” date with technician initials, hazard
warnings, and the equipment’s location in the lab.

The Chemical Supply Inventory is an electronic document that will be printed out as
a hard copy as it is updated. Each time it is updated it will be saved as a new file
with the date included in the file name. Hard copies may be disposed of after an
updated inventory is printed and filed.

The Chemical Supply Inventory will be updated once a month and used to order
needed products.

After used-up and disposed-of supplies’ “disposed of date” has been recorded, they
will be deleted from the next month’s Chemical Inventory, as long as they have been
re-ordered.

C. Equipment inventory

1.

The laboratory must maintain an Equipment Inventory documenting all of the non-
disposable items in the laboratory.

The Equipment Inventory will include the name of the equipment, manufacturer, lot
number, model, serial number, NPS property number, maximum container quantity,
current quantity, date received with technician initials, special precautions, whether
or not there is Equipment Documentation (A6.00), and the equipment’s location in
the lab.

The Equipment Inventory is an electronic document that will be updated as needed
(when new equipment arrives in the lab) and the updated copy printed as a hard
copy. Each time it is updated it will be saved as a new file with the date included in
the file name. Hard copies may be disposed of after an updated inventory is printed
and filed.
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SOP: D1.04 Recording Molecular Laboratory Data

Summary

Guidelines for recording Molecular Laboratory data are described below.

Procedure

A.

Record data directly, promptly, and legibly in ink. The use of waterproof ink for the
field (labels and data recording) is recommended. Pens should be assigned to a
given area (inner lab-hood, outer lab, etc.) to prevent cross-contamination — see
SOP 1.01 for how supplies are marked to show divisions.

All data sheets will have a minimum left margin of 0.8 inches. Additional space
needs to be left at the bottom of the page for any notes or entry errors that need to
be recorded. Any notes or entry errors will be recorded at the bottom of the data
sheet. NO entries are to be made in the left-hand margin.

All data entries shall be dated on the day of the entry and initialed by the recorder.
Changes in data shall be made so as not to obscure the original entry by crossing out
any errors with a single line. Use an asterisk paired with a number to make a
footnote with the corrected record. The correction must indicate the reason for
correcting the record, the information to correct the record, and be dated and
initialed by the laboratory worker.

When recording time of events use Mountain Standard Time on a 24-hour clock.

Record dates as day / month / year with the month written out or abbreviated (i.e.,
do not indicate the month with numbers).

When recording data, one should sign his/her initials as it appears on the signature
sheet.

There should be no blank spaces on a completed data sheet. Where applicable,
enter “0,” “x,” or “-” in blank spaces. Cross out (X) the remainder of any unused
portion of the data sheet.

No data entries should be made on the back of data forms.

All data generated must be retained.
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Attached Documentation:

Laboratory Study Notes (A1.01)

Plankton Tow Field Data (A2.00)

DNA Extraction and Quantification (A3.03)

PCR Mastermix Setup (A4.05)

PCR Well Assignment (A4.06)

PCR Clean-up (A4.07a and A4.07b)

Sample Dilution for LVS and HVS (A4.08)

BLAST of Samples Submitted ddMMMyy (A4.09)
Gel Electrophoresis (A5.00)

SOP: D1.05 Molecular Laboratory Data Entry and Storage

Summary

All documents listed in “Attached Documentation” are stored in the appropriate year’s
Molecular Laboratory Data notebook in order by date; the sole exception is A2.00,
which is stored in the Microscopy Lab notebook. Information from the Plankton Tow
Field Data, DNA Extraction and Quantification, and Gel Electrophoresis attachments
must be entered into the appropriate year’s Molecular Laboratory Database Access file
on the U: drive. When all analyses for samples collected in that year are complete, the
database is reviewed by the technician before being reviewed by the Quality Assurance
Officer. If corrections are needed, they are performed by the technician and the data is
reviewed again by the Quality Assurance Officer. When no errors exist in the database,
it is transferred to a secure network drive by the Laboratory Director. The final P: copy
for the year is saved indefinitely on both the P: drive and a read-only CD.

Equipment

Computer with network access

Molecular Laboratory notebook

Procedures

A. Obtain data sheets with data that need to be entered into the database.

B. A properly trained Laboratory Technician must log onto the computer network using
their alias and password.

C. Open the Molecular Laboratory Data folder at
U:\Resources\Aquatic\Waterlab\Water Lab-ZM Molecular\Molecular Lab Data.
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The relevant Plankton Tow Field Data (A2.00) sheet is removed from the
Microscopy Lab binder and the data is entered in the table “Plankton tow
data” in the Molecular Lab Database Access file; the sheet is then returned
to the Microscopy binder.

Data from DNA Extraction and Quantification (A3.03) is entered in the
current month’s “DNA extraction records” Excel file, where formatting is
easier to accomplish than in Access. Data should be entered in the
“LPowell” worksheet.

a. New data should be regularly copied and pasted into the “DNA
extraction” table in the Molecular Lab Database Access file.

b. To append data from Excel into the Access file:

i. Make sure all fields are the same (title, type of data inside)
in the Excel sheet and Access table.

ii. Just before copying the Excel data, insert an empty column
at the beginning of the data to correspond to the “ID”
column in Access. Access will populate this column with
sequential numbers automatically.

iii. Highlight all the fields in Excel that you want to append to
the Access table; press CTRL+C.

iv. In Access, open the “DNA extraction” table. Select the
“Home” tab. Select the “Paste” drop-down and select
“Paste append”.

c. A new Excel file should be generated every month to create an
historic record of changes to the data.

Data from Gel Electrophoresis (A5.00) are entered in the current month’s
“PCR run records” Excel file, where formatting is easier to accomplish than
in Access. Data should be entered in the “Ram Q and Z” worksheet.

a. New data should be regularly copied and pasted into the “PCR run
records” table in the Molecular Lab Database Access file, but only
after the photo of the gel has been downloaded from the PhotoDoc-
It imaging system (SOP 5.02) and the analysis reviewed using the
digital image on a computer screen, as it allows higher accuracy
than with the printed image..

b. A new Excel file should be generated every month to create an
historic record of changes to the data.

Data from BLAST analysis of sequence data should be entered into the
relevant Excel sheet and saved as described in SOP 5.07.

Page 2 of 3



SOP D1.05 Issue 2

Whenever a PCR is run that is unusual (samples not from Lake Powell, testing
sensitivity of PCR, trying new PCR protocol, etc.) summarize the work you have done
in Laboratory Study Notes (A1.01) for future reference, saving in the appropriate
folder in the “Molecular laboratory study notes” folder. Append the date to the file
name when you save. Print a copy of the notes and include in the Molecular Lab
notebook with the relevant datasheets.

The Quality Assurance Officer must review the electronic database and the hard
copies for errors.

Errors are noted on the hard copy and the Laboratory Technician is informed that
corrections must be made.

The Quality Assurance Officer records “Proofed,” dates, and initials error-free hard
copies.

The data sheets are then permanently stored in their proper Water Quality Data
notebooks.

The Quality Assurance Officer informs the Laboratory Director when no errors exist
in the electronic database. The Laboratory Director then immediately saves the
entire database to their P: drive as GLCAlabs(date of transfer) as a read only file.
The date of transfer is recorded as the year, month, and day (20050401).

At the end of the season the Quality Assurance Officer checks the last version of the
U: and the Laboratory Director’s P: drive databases against each other to detect

errors.

A compact disk containing all of the databases from the P: drive is created as a read-
only CD. The CD is stored in the respective Molecular Lab notebook.
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Attached Documentation:
Signature Sheet and Ethical Policy Attestation (A1.04)

SOP: D1.06 Molecular Laboratory Data Integrity System

Summary

The Glen Canyon NRA Molecular Laboratory data integrity system consists of several
components. All laboratory personnel, including the Laboratory Director and Quality
Assurance Officer, must annually complete Data Integrity Training, provide their official
signature and initials that will be used on all required laboratory documentation, and
sign an ethical policy attestation statement. Laboratory management is responsible for
in-depth periodic monitoring of data integrity and maintaining a procedure for
employees to report data integrity issues.

Procedures

A. Data Integrity Training is provided to new laboratory personnel and annually for all
current personnel by laboratory management. An attendance sheet must be signed
by those in attendance.

B. Topics covered in the Molecular Laboratory Data Integrity Training must include a
discussion of how and when to report data integrity issues, record keeping, and the
organizational mission and its relationship to the critical need for honesty and full
disclosure in analytical reporting.

C. Following the Molecular Laboratory Data Integrity Training, new personnel must
provide their official signature and initials that will be used on all required
laboratory documentation. All personnel must sign an ethical policy attestation that
states:

“I will uphold the commitments of Glen Canyon National Recreation Area (NRA) Molecular
Laboratory as listed in the Quality Manual. | hereby acknowledge that the falsifying of
data is unethical, and [ shall not do so while working in the Glen Canyon NRA Molecular
Laboratory. | understand that not upholding the aforementioned commitments and/or
behaving unethically may lead to my termination. | understand that any deviation from a
Standard Operating Procedure must be documented with a corrective action report. "

D. Copies of official signatures, initials, and ethical policy attestations must be retained
by the employee and laboratory management.
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Laboratory management assures a receptive environment in which all employees
may privately discuss ethical issues or report items of ethical concern. Potential
issues will be handled in a confidential manner until a follow up evaluation,
investigation, or other appropriate actions have been completed and the issues
clarified.

An employee may report an ethical concern either verbally or in writing to the
Laboratory Director or Quality Assurance Officer.

It is the responsibility of the laboratory management to investigate and take action
in response to any reports of unethical behavior. Findings of inappropriate activity
must be documented and include any disciplinary actions involved, corrective
actions taken, and notification to the client.

Other Quality Assurance activities such as the Proactive Quality Assurance Program
(SOP 7.03) and Quality Assurance Audits (SOP 7.04) also provide opportunities to

detect unethical behavior.

Unethical behavior will result in a detailed investigation that could lead to
disciplinary action including termination.
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Attached Documentation:
Molecular Laboratory Training Document (A1.02)
Molecular Laboratory Demonstration of Capability Log (A7.00)

SOP: D1.07 Molecular Laboratory Technician Training

Summary

Molecular Laboratory technicians must be adequately trained in the methods and
procedures of the laboratory. A Training Document is used to record training in specific
methods and procedures. Laboratory personnel who regularly prepare and analyze
samples from start to finish (DNA extraction->Gel electrophoresis) must successfully
complete a Demonstration of Capability (See SOP 7.01) before performing the certified
method unsupervised. Laboratory management must maintain records on all laboratory
personnel that include qualifications, experience, training records, Demonstration of
Capabilities, Signature Sheet and Ethical Policy Attestations, and documentation of any
courses or workshops attended.

Equipment

Glen Canyon NRA Molecular Laboratory Quality Manual

Procedures
New laboratory personnel must be given a copy of the current Glen Canyon NRA
Environmental Laboratory Quality Manual and current Standard Operating
Procedures. Additionally, a copy of the manual is available in the laboratory at all
times.

The Laboratory Technician must read and understand the manual.

A Training Document (Attachment A1.02) is used to record training in specific
methods and procedures that are needed by an employee to perform their duties.

The Laboratory Director, QA Officer, or a previously trained technician must train new
technicians in each procedure. It is the responsibility of the trainer to observe and

review the work of the new technician.

The date of initial training will be recorded on the technician’s Training Document.
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When the trainer feels the trainee can perform the procedure unsupervised, the
trainer will sign and date the Training Document.

When the trainee feels that they can perform the procedure unsupervised, the trainee
will sign and date the Training Document.

Training Documents must be completed and maintained for all key personnel and
technicians. Each technician is responsible for making sure their training record is
accurate and current. Each technician must give a copy of their Training Document to
the Laboratory Director and Quality Assurance Officer whenever the document is
updated.

Each technician who regularly prepares and analyzes plankton samples from start
(DNA extraction) to finish (Gel electrophoresis) must annually complete a
Demonstration of Capability (refer to SOP 7.01) for each certified method before
performing the method unsupervised.

Copies of the Demonstration of Capability Log (A7.00) are to be given to the
technician, Laboratory Director, and Quality Assurance Officer.
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Attached Documentation:
Plankton Sampling Site ID Key (Attachment C/A2.01)

SOP D2.01: Plankton Sampling Site Selection

I, Summary
Plankton samples are taken throughout Lake Powell to monitor the spreading quagga mussel
invasion and to detect newly invaded areas. Samples are taken at locations where the
introduction and propagation of Dreissenid mussels are likely or known; at randomly selected
sites in un-infested areas; and at reported sites as needed to clarify earlier results, expand a
search area, or to sample an area of particular concern.

li. Procedures

A. Routine sites are sampled monthly or bi-monthly.

e Routine sites at quagga-infested developed areas (Antelope Point, Stateline, and
Wahweap Marinas and the Glen Canyon Dam upstream of the buoy line) are sampled
monthly May-January to monitor veliger occurrence and bi-monthly February-April to
monitor veligers and capture the onset of reproduction.

e Routine sites in quagga-infested undeveloped areas (ZON3 and ZON4) are sampled
monthly to monitor veliger occurrence. ’

e Routine sites up-lake (Bullfrog and Hall’s Crossing Marinas) are sampled bi-monthly to
monitor for veliger presence/absence.

e The mid-lake routine site (Dangling Rope Marina) is sampled monthly to monitor for
veliger presence/absence.

e The Glen Canyon Dam draft tubes are sampled as available to monitor veliger
occurrence.

B. Secondary sites (inflows and confluences of rivers into the lake are sampled when time
and staffing allows.

C. Sampling frequency in un-infested areas is not as stringent during the winter when water
temperatures drop below 50°F (10°C) because mussel reproduction is unlikely to occur in
these colder temperatures.

D. Random sampling is done in May and October. Three samples are taken in each un-
infested (Transitional or Mussel-Free) Visitor Use Zone. Random sampling sites are
generated using GIS (Refer to SOP 2.04: Random Plankton Sampling Site Selection Using
ArcMap).
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Attached Documentation:
Plankton Tow Field Data (Attachment A/A2.00)
Plankton Sampling Site ID Key (Attachment C/A2.01)

SOP: D2.02 Plankton Field Sampling Techniques

.

Summary

Sampling shall be performed in such a manner as to minimize the amount of variation in the data
due to the technician performing the sampling. Record any environmental conditions that may
affect the test results or any departure from the procedures in the comments section of the
Plankton Tow Field Data Form (Attachment A/A2.00). The following field sampling procedures shall
be followed.

Equipment

Site-appropriate plankton net and cod-end piece with attached line

125 mi and/or 250 ml sample bottles Spray bottle filled with vinegar
95% denatured ethanol RO water wash bottle
Plankton tow data sheets Black pens

Permanent black markers Thermometer

Thales® MobileMapper Handheld GPS Unit 4 AA batteries

Secchi disk attached to meter tape Aquascope

Hach portable WQ meter
Procedure

A. Locate the site to be sampled and bring the boat to rest. If boat continues to drift due to wind
or currents tie off to an available buoy or structure if it is safe to do so.

B. Use a field thermometer to read the water temperature 4 inches below the surface; allow the
thermometer to acclimate to the water temperature before recording.

C. Record the water temperature and all other requested information except for depth of tow and
water volume sampled on the Plankton Tow Datasheet (A/A2.00).

1. Refer to Plankton Sampling Site ID Key (C/A2.01) if needed. The first sample taken at a
site/in a random zone will be labeled by the site ID followed by “1”. Subsequent samples
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taken from the same site/zone that day will be labeled by the site ID followed by numbers in
ascending order.

2. GPS file names are “RZyymmdd” for random samples, “Zyymmdd” for routines.

3. Separate nets are used for sampling at or near the Dam, at other sites downlake (DL), and at
sites uplake (UL); circle the net used on the datasheet.

4. See the relevant SOPs for Secchi disk and Hach WQ meter operation.

Record the GPS position during the field collection using procedure in SOP 2.06 Electronic
Recording of Sample Sites Using GPS. Note any failures in the comments.

Unlock and open drop door on side of boat if present; unlock and set up pulley arm if available
on boat, fitting the line connected to plankton net onto pulley wheels.

Rinse cod-end piece and plankton net separately in lake before screwing cod-end piece on to
bottom of net.

Plankton samples are collected using the following procedure:

1. Drop net down to a maximum of 50 m or 3 m above the substrate and record depth. Let the
line straighten out and hold net at desired depth for about 30 seconds.

2. Manually retrieve net using a hand-over-hand technique at a constant rate of 0.5m/s. Slow
and steady retrieval is the key to collecting a good plankton tow.

3. After the top of the net has breached the surface, rinse the organisms into the cod-end
piece of the net. Lower the net back into the water, keeping the opening above the water
surface, then quickly raise the net straight up. Repeat several times to ensure all the
organisms inside the net are concentrated into the cod end.

4. Unscrew the cod-end piece and let the water drain out through the mesh slits, leaving the
plankton behind.

5. Label sample bottles as described in SOP 2.03 Plankton Sample Bottle Labeling.

6. Using the RO water wash bottle gently rinse the sides of the cod-end to condense the
plankton. After letting excess water drain out, pour plankton into properly labeled sample
bottle of appropriate size; use 250ml bottle when samples are especially dense. Rinse
plankton into the sample bottle until cod-end piece appears clean.

7. Preserve samples in a 70% EtOH solution immediately after collection to ensure sample
integrity. To make this solution, note the amount of sample in the bottle and add 3 times
that volume of 95% EtOH to the sample. It is important that the amount of sample not
exceed % of the sample bottle before ethanol is added.
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(1) You may split sample into two bottles if it's too large for a single bottle. Cap and shake
the bottle before splitting, make note of it on the datasheet, and label bottles as
described in SOP 2.03.

8. Collect one tow at quagga-infested sites and two tows at quagga-free and transitional sites;
one will be processed by the FlowCam and microscopy, while the second (if taken) will be
processed by the Molecular Lab.

H. Decontamination of the net after sampling at each site is mandatory to ensure independence of
samples taken from different locations. It is not necessary if taking a replicate sample from the
same location.

1. With the cod-end piece disconnected, hold up the top of the plankton net and spray vinegar
liberally to the inside and outside black portion of the net.

2. Flip the net over and spray the inside and outside of the plastic at the end of the net where -
the cod-end connects. Hold the net upside-down and spray the entire outer part of the
mesh until it is saturated with vinegar.

3. Spray the inside and outside of the cod-end liberally.

4. Letthe net dry while traveling to the next site; upon arriving at the next site, rinse the
plankton net and cod-end separately and thoroughly in the water before collecting another
sample.

I.  After a day of sampling flush the net and cod ends used thoroughly with water to remove any
plankton that may remain. If leaving for the day put the nets in their totes and leave in the lab;
if someone will be present at the lab hang the net outside the lab to dry completely before
storing. Plankton samples for the microscopy lab should be immediately stored in the
Flammables Cabinet in the outer lab; those for the molecular lab should be stored in the
Flammables Cabinet in the inner lab.
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Attached Documentation:
Plankton Sampling Site ID Key (Attachment C/A2.01)

SOP: D2.03 Plankton Sample Bottle Labeling

l. Summary

Proper protocol must be followed when labeling bottles for plankton sample collection.

1. Equipment
125 ml and 250 ml sample bottles Permanent markers
It Procedure
A. Each sample bottle should be labeled on its side in permanent marker with the

collection date, site ID, depth of the tow in meters, and preservation technique
(70% EtOH).

Refer to the Plankton Sampling Site ID Key (Attachment C/A2.01) for routine,
secondary, and random site names and codes.

The first sample taken at a site/in a random zone on a given day will be labeled by
the site ID followed by “1”. Subsequent samples from the same site/zone that day
will be labeled with the site ID and sequential numbers. (Ex: first site sampled at
APM on a given day is APM1, second is APM2. First random site sampled in Zone 12
on a given day is RZWW1, second is RZWW?2).

Replicate samples taken at the same location (one for microscopy, one for
molecular) are designated by adding a capital letter at the end of the site
ID/number; “A” samples are analyzed by microscopy/FlowCam, “B” samples by PCR
(Ex: APM1A and APM1B).

If a large sample is collected and split between two or more bottles for proper
preservation indicate in parentheses next to the SitelD by noting the bottle number
in relation to the total number of bottles the sample has been split into. (Ex: ifa
sample from APM1A is split into two bottles “(1 of 2)” should follow the SitelD on
the first bottle, “(2 of 2)” on the second bottle.)

The date-site ID combination is used to form a unique identification code for each

sample received in the laboratory. It serves as an identifier for all subsequent
activities associated with each sample.

Page 1of1



SOP D2.04 Issue 3

Effective Date 5 Aus 20l¢ s

J
Approved By / ;/;c«p[ /@/é\

SOP D2.04 Random Plankton Sampling Site Selection Using ArcMap

1.

Summary

Random sampling sites are generated based on current lake elevation using ArcMap
software. Map sheets showing random sample locations are created and printed for field
documentation.

Equipment

Computer with network access

ESRI ArcMap 10 Color printer

Procedure

A

Start ArcMap software and open the random map template file

PIankton_Randdm_yyyy.mxd , where yyyy is the current year.

1.

The ArcMap — Getting Started window will appear after starting up ArcMap. On the left
side of the window under “Existing Maps”, choose “Browse for more” to open the map
template file in the Map Library for the current year:

u:\ Aquatic\WaterLab\SpatiaI_Data\Plankton_Sampling_yyyy\Map_Library\
Plankton_Random_yyyy.mxd

Save the map as a new document so the template is not modified.

1.

2.

Click File > Save As.

Browse to the Map Library for the current year:
U:\ Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\Map_Library

Change the map name to: RZ_yyyymmdd_Zxx_elev, where yyyymmdd is the
current date, xx is the random zone number, and elev is the current lake elevation
rounded to nearest 10 feet (for example: RZ_20110630_z01_3640). Click Save.

Generate random sampling points.

1.

Click on “Random Plankton Points” located on the Random Sampling toolbar:
“gy Randomn Plankton Points [ &, e [ 8 =

2. The “Random Plankton Points” window will appear.
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a. If an error message appears instead try going to Customize>Extension and
checking Spatial Analyst; the Spatial Analyst package sometimes gets
unchecked, especially after updates.

:w liéndnm'Plankton uihts‘

Point Output Locatlon : i : : L :
;U \AquaticiwaterLabiSpatial Data'\PIankton Samphng ZDIEW.GIS'I,SeIected Sltes\,RZ 20150520 212 3

- Lake Elevation (ft)

3620

Winimurri Water Depth (FE) e
] 98 -
Mumber of Samples ‘ .

d
: Zone Raster ; : B e i B
: !U ‘I,Aquatlc'chterLab\Spatlal Data';PIankton Samphng ZDISXGIS\Random Sample Selectlon'l,Basehne\,F I,:ji :

Zone Polygon {optional) : :
au \Aquatlc\,WaterLab'l,Spatlcl Data\,Plankton Samphng_ZUlS'i.GIS'l,Random Sample Selechon\Basehn_ﬁi !

-

SO Cahcel’ 3 1 Ehviroﬁmiehts.k.‘. Show Help >>] 4

Verify the proper “Point Output Location” is listed for saving the shapefile:

U:\ Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\Selected_Sites
where yyyy is the current year. Click the folder icon to browse to the appropriate
folder. Rename the shapefile in the format: RZ_yyyymmdd_2Zxx_elev.shp as
previously saved for the map file.

In the “Lake Elevation” box, type in the current lake elevation rounded to the
nearest 10 feet.

In the “Minimum Water Depth” box set the desired minimum tow depth. The
minimum water depth defaults to 98 feet or 30 meters. Note: For most zones the
minimum depth of 30 meters is sufficient. For inflow zones (Zones 8, 9, 13) the
minimum depth will need to be decreased.

In the “Number of Samples” box set the number of points to be generated. Note:
Not all points generated have to be sampled. Generally 3-6 samples are collected
on a given trip so the number of samples to be generated should be at least 6.

Select the “Zone Raster” for the appropriate random zone to be sampled. Click the
folder icon to locate the desired file. The zone raster files are located at:

U:\ Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\
Random__SampIe_Selection\BaseIine\Random_PIankton__Sampling_Baseline_yyyy.gdb
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Select the “Zone Polygon” for the appropriate random zone to be sampled. Click

the folder icon to locate the desired file. The polygon files are located at:

U:\ Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\
Random_Sample_Selection\Baseline\Random_Plankton_Sampling_Baseline_yyyy.gdb

Click OK. Random points are generated by the tool and the RZ_yyyymmdd_Zxx_elev
shapefile is added to the Table of Contents under the Map data frame as a new
layer.

Right click on the newly created RZ_yyyymmdd_Zxx_elev shapefile and select
“Zoom To Layer” and the random points should be displayed.

Display the bathymetry layer for lake contours.

1.

In the Table of Contents, check the “bathy08_xxxx" layer where xxxx is the current
lake elevation rounded to the nearest 10 feet. Lake contour lines will be displayed.

Set symbology for the random sampling points.

1.

2.

In the Table of Contents, double-click the newly created symbol. The symbol
selector window will open.

Choose a symbol that is visible with the bathymetry layer. The suggested symbol is a
red “Circle 16” or red “Circle 17”.

Update the map sheets text block in Layout View.

1.

2.

4,

Click View > Layout View (if not already in layout view).

Double-click the text block in the lower left-hand corner of the map to open the
Properties dialog box. Note: The black arrow will need to be selected from the Tools
toolbar in order to change text.

Enter the Random Zone number, Lake Elevation (actual current lake elevation), and
the Shapefile and GPS Jobfile names. The shapefile is named as before:
RZ_yyyymmdd_2Zxx_elev.shp. The GPS jobfiles are named using the anticipated
sampling date, not the creation date in the following format: RZyymmdd.

Click OK.

Prepare the document for printing.

1.

2.

Go to File > Page and Print Setup. Select the designated printer. Select “landscape”
for the orientation. (Note: The boxes for “Use Printer Paper Settings” and “Scale
Map Elements proportionally to changes in Page Size” may need to be checked to
ensure that the entire map is displayed on the printed page.)

Print the mapsheet. Go to File > Print.
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3. Save the ArcMap document.

H. Export the set of map sheets (optional).
1. Click File > Export Map.
2. Change “Save as type” to PDF.

3. Save PDF to the appropriate Map_Library using the current map name:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling__yyyy\Map_Librafy\

I. Close ArcMap when finished.
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SOP D2.05 Uploading Random Sample Points to GPS

Summary

Random sample site shapefiles created in ArcMap are converted to GPS job files. Job
files are then uploaded to a Thales MobileMapper GPS unit to assist with field
navigation.

Equipment
Thales MobileMapper Handheld GPS Unit Computer with network access
MobileMapper Office software SD memory card from GPS

SD card reader

Procedure for Uploading Random Sample Point to GPS

Start MobileMapper Office.
Click File > Import.

Navigate to the selected shapefile to be uploaded and click Open. Random sample
shapefiles are stored at:

U:\Aquatic\WaterLab\SpatiaI__Data\PIankton_SampIing_yyyy\G|s\s(=_-|ected_55teS where
yyyy is the current year.

Click Import in the Import GIS Data window to add the point features.

Save the point features in a GPS job file. Go to File > Save As.

Navigate to the Uploads folder for the Wahweap or Bullfrog GPS Unit. The Uploads folder
is located at:

U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_Unit for
Wahweap or \BF_Unit for Bullfrog.

Name the GPS job file in the format: RZyymmdd where yy is the 2-digit year, mm is the 2-
digit month, and dd is the 2-digit day. Then click Save.

Proceed to Section IV if uploading using a thin client computer and a SD memory card

reader. Proceed to Section V if uploading using a computer with a serial port and
MobileMapper Office.
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Upload Using a Thin Client and SD Card Reader

Remove the SD memory card from the GPS battery compartment.

Connect the SD card reader to the computer USB port and insert the SD memory card from
the GPS into the reader.

In Windows Explorer navigate to the Uploads folder and right-click on the desired GPS job
file and choose Copy.

in Windows Explorer open the drive associated with the GPS memory card. Right-click
within the GPS memory card window and choose Paste to transfer the desired GPS job file

to the GPS memory card.

Upload Using a CompUter Serial Port Cable and MobileMapper Office

Connect the GPS unit to the computer with the serial port communication cable.
Press “PWR” to turn the GPS unit on.

In MobileMapper Office, click File > Upload to GPS > Job.

D. The “Uploading to GPS” window will open while MobileMapper Office connects to
the GPS and uploads the file. The window will close automatically once the upload
is complete.

E. Press “PWR” to turn the GPS unit off.

F. Disconnect the GPS unit from the computer.
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SOP D2.06 Electronic Recording of Sample Sites using GPS

i

Summary

The location of all plankton samples collected will be recorded using the Thales
MobileMapper handheld GPS unit. GPS files and point locations will be labeled in a
standardized manner.

Equipment
Thales MobileMapper GPS unit 4 AA batteries

General Procedures for GPS Units

Each day of sampling will be given its own GPS job file. All GPS files should contain only
periods of time that are less that 24 hours. All points taken that day will be recorded in
the GPS and stored under that file, unless some samples are taken for special
circumstances and a separate file is justified.

GPS job files with selected random sample locations should be created and loaded on
the GPS prior to sampling to assist in navigation to random sites (refer to SOPs 2.04 and
2.05). Alternatively, map sheets or a laptop with a GPS can be used as a navigational aid
for random sites.

Prior to field use, ensure that a secure digital (SD) memory card and batteries are
properly installed in the unit and that extra batteries are put in the GPS case.

To turn on the unit press the red “PWR” button once quickly and press the “ENTER”
button three times in a row to cycle past the initial startup, copyright, and warning
screens.

To turn off the unit, press red “PWR” button once, and the unit will shut off at the end
of a 5-second countdown. Note: if the GPS unit is turned off, the active job file is closed
and will need to be reopened to save new points. Pressing and holding the “PWR”
button will adjust the backlight settings.

The “NAV” button cycles the GPS display between the map, compass, position, and
satellite status screens.
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a. The map screen shows current position and heading with a triangle. The center
scrolling button can be used to move a cursor around the screen for selecting
features. Press “ESC” to hide the cursor and return to the current position
marker. Pressing the “IN” and “OUT” buttons will adjust the level of zoom
displayed on the map screen. Note: the position cursor will display as an
hourglass if the unit has not established adequate satellite connections.

b. The compass screen shows speed, distance, and direction to a waypoint.

c. The position screen can be used to manually record the current GPS position in
NADS83 UTM format (xxxxxxxxE xxxxxxxN), and also displays the current time
and date.

d. The satellite status screen shows how many satellites the GPS unit has
established connections with, and the strength of the satellite signals (shown as
black bars). An accurate position fix cannot be determined unless the unit has
connected to at least 3 satellites. This screen also shows remaining battery
power.

The “MENU” button is used to create or open GPS job files that sample point locations
are saved into.

The “LOG” button is used to create a new point location in the open job file.
Pressing “ENTER” will accept the highlighted selection.
The “ESC” button will take you back to the previous screen without making any changes.
The GPS background map display can be changed. To select a background map, press
the “Menu” button, then highlight and select “Setup”. On the setup menu screen,
highlight “Select Map” and press “ENTER”.

a. On the change map screen, highlight the desired detail map or select “Empty” to

use only the default background map. Detail map names reflect the lake
elevation contours used to create their symbology. (e.g. WQ3640.IMG shows
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the shoreline at 3640 feet and should be selected for lake elevations close to
3640 feet).

b. After selecting a detail map, highlight “Save” and press “ENTER”. The detail map
will now display on the map screen.

c. Additional detail maps can be created in MobileMapper Office and uploaded to
the GPS as Disc Image files.

GPS Job File Naming Conventions

Plankton Sampling job files created in the field for routine sample collection are given a
“7” prefix (for zebra mussel) followed by the current date in yymmdd format
(zyymmdd). Example: locations of plankton samples collected on 21AUG10 would be
saved in a job file named “Z100821".

Selected site job files created prior to random sampling and uploaded to the GPS unit
for navigation are given a “RZ” prefix (for random zebra) followed by the anticipated
sampling date in yymmdd format (RZyymmdd). Example: A random sampling map is
prepared on 07AUG10 for sampling on 14AUG10. The selected points will be uploaded
to the GPS in a job file named “RZ100814”.

If the job file in use becomes corrupted and new points cannot be recorded in it, a new
job file is created with the “Z” prefix, the current date in yymmdd format, and an
additional 1-letter suffix starting with “A”. Example: job file “RZ100814” becomes
corrupted while sampling. A new file named “Z100814A” is created and used for
subsequent points.

Creating and Opening GPS Job Files

Turn on GPS unit and wait for the GPS to establish a satellite connection.

To create a new GPS job file, press the “MENU” button, then highlight and select “New
Job”. Enter the job name by using the scrolling center button to move around the
alphanumeric display, and the “ENTER” button to register each character. When the
entire name has been entered, highlight “Ok” and press “ENTER”.

On the feature library screen, highlight “ZM_SAMPL.MMF” and press “ENTER”. The
“ZM_SAMPL” template contains the attribute fields necessary for recording plankton
sample data associated with each location (SitelD and CollDate).

On the job mode screen, highlight “Post-processing” and press “ENTER”. Selecting
“Post-processing” allows the points collected in the field to be differentially corrected
on a computer to improve their accuracy.

Press “NAV” to return to the map screen.
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To open an existing or uploaded GPS job file, press the “Menu” button, then highlight
and select “Open Job”. Highlight the desired job file on the job list screen and press
“ENTER”.

Recording Point Features at Sample Sites

If the GPS unit is not on, power it up and wait for the GPS to establish a satellite
connection.

If the correct job file is not active, create or open an existing GPS job file, as
appropriate.

To record the sample site location, press the “LOG” button to bring up the new feature
screen. The feature type will be “ZM_Sample” for jobs created on the GPS, and
“RZ_yyyymmdd_Zxx_elev” for uploaded random sampling jobs.

Press “ENTER” on the new feature screen to log the sample site location. The GPS
display will show the logging screen and the unit will start recording positional data.
Log points for around 5 seconds. To stop collecting point data, highlight the “Close”
icon on the logging screen and press “ENTER”.

Editing Feature Attributes

After recording a sample location, press “ESC” or “NAV” as necessary to return to the
map screen.

Move the cursor on the map screen directly over the new point feature with the
scrolling center button. When the feature has been highlighted, the feature name
(“ZM_Sample” or “RZ_yyyymmdd_Zxx_elev”) will be displayed at the bottom of the
screen. Press “Enter” to open the selected feature screen for that point.

The selected feature screen will show the feature attributes (SitelD and CollDate) and
their values. If you are entering data for new point, these attributes should be blank. If
they are not blank, press “ESC” to return to the map screen and select the correct
point. The “IN” and “OUT” buttons can be used to adjust the zoom to an appropriate
level for selecting the correct feature.

To enter or edit feature attribute values for the selected feature, highlight the “Edit”
icon and press “ENTER”. Highlight the SitelD attribute and press “Enter” to bring up the
alphanumeric display. Type in the SitelD (should not include tow identifier A/B) then
highlight the “OK” icon and press “ENTER” when finished to return to the selected
feature screen. Standard SitelD naming conventions can be found in the field notebook
on a printed sheet near the front of the binder. Next, highlight the CollDate attribute
and repeat the process to enter the current date in the appropriate format (e.g.
14AUG10).

After editing both the SitelD and the CollDate fields, highlight the “Close” icon on the
selected feature screen and press “ENTER”.
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F. If a point feature is accidentally created at a location where no sample is taken, the
SitelD should be set to “NOSAMPLE” or “NONE”.
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SOP D2.07 Downloading and Differential Correction of GPS Points

Summary

Raw sample site data recorded in the field are downloaded from the GPS using
MobileMapper Office. GPS points are then differentially corrected to improve accuracy.
Copies of the raw and corrected GPS data are stored in folders specific to the GPS unit,
and a shapefile is exported for GIS analysis.

Equipment
Thales MobileMapper GPS Unit Computer with network access
Secure digital (SD) card reader MobileMapper Office

ArcCatalog 10

Downloading Raw GPS Data to the Network

Remove the secure digital (SD) memory card from the Thales MobileMapper handheld
unit. The card is located in the battery compartment.

Connect card reader to the computer and insert the GPS card into the card reader.

In Windows Explorer, transfer all the files associated with a given date from the GPS
card to the appropriate raw GPS data folder location on the network. Raw data from the
Wahweap GPS unit is stored at:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_U nit\Raw
where yyyy is the current year.

Raw data from the Bullfrog GPS unit is stored at:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Unit\Raw
Highlight the MobileMapper job file ((MMJ) and all associated files (.R00, .M0O, .GOO,
etc.) then right-click and choose "Copy". Go to the folder location for the Bullfrog or
Wahweap GPS unit, then right-click and choose "Paste". Some files may not transfer
(usually .ROO files); click OK, it may mean post-processing will not be possible.

Transferring Raw GPS Data to Corrected Data Folder

MobileMapper Office must be used to transfer the raw data to the corrected data
folder. Raw data copied from the SD card using Windows explorer will not be properly
formatted for differential correction.

Start MobileMapper Office.
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C. Select “File” from the menu bar and select “Download from GPS." The MobileMapper

Transfer window will appear.

Set the left (source) and right (destination) MobileMapper Transfer windows to the
appropriate directories.

Source directories for Wahweap and Bullfrog units (respectively) are:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_Unit\Raw
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Unit\Raw

Destination directories for Wahweap and Bullfrog units (respectively) are:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_Unit\Correct
ed
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Unit\Corrected

Choose “File” from the menu bar and click on “Connect” then “PC Drive.” Navigate to
the appropriate directories if they are not displayed in the left and right windows.

Click and drag the selected MobileMapper job file from the left window to the right
window. The “Copying File” window will appear. In order to transfer more than one file
at a time, hold down the “Ctrl” key on the keyboard while selecting files.

8 MobileMapper Transfer -3 PC as MobileMapper

Fle Edit View Help

| [SU: -] [0\ \Beach_Monitoring_2010\GPS\BF_Unit\Correc
Name / | Ext | Size | Modified Name / et | Size [ Modified

SN <> (Jp-DIR* 12/7/2010 04: 1. -»UP-DIR* 12/7/2010 14
f0Ljunio mmj 680,497 6/1/201010:2 | CIRINEX *5UB-DIR* 12/7/2010 10

i 6m100531 mmj 2,790,374 6/1/2010 14:4 |49 01jun10 mmj 1,022,760 6/1/2010 17:2
§P01JUNI0_COR mmj 2,213 12/7/2010 104

& bm100531 mmj 4,140,957 5/31/2010 18

§DBIIL00531_COR  mmj 17,457 12/7/2010 102
L] download log a 12/7/2010 14

source (“Raw” folder) ____y destination (“Corrected” folder)

F.  When the transfer is finished, close the MobileMapper Transfer window. The file(s)

transferred will be displayed in the MobileMapper Office window.

Differentially Correcting GPS Data

file.

Wait at least 24 hours after completion of sampling before differentially correcting a

B. Start MobileMapper Office and open the GPS job file to be differentially corrected.
Select “File” from the menu, then “Open” from the drop down list. Navigate to and
select the job file from the appropriate “Corrected” data folder. The file will now be

displayed in the MobileMapper Office window.
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Before differentially correcting the job file, resave it as “filename_COR.mmj” in the
“Corrected” folder. Select “File” from the menu, then “Save As” from the drop down list.

Note: If when you attempt to correct the file it has a corruption issue that prevents
some or all of the points from being differentially corrected, then after correcting
rename the file to “filename_ParCOR” or “filename_NoCOR,” respectively.

Download reference station data for the open job file. Click on the "Download
Reference Station” button found on the lower toolbar.

] : i

Eaar- vé\ﬁ%i%

File Name Start Time | End Time |_Time Bar
= “O1UN10 6/172010 10:10:50 AM 6172010 10:26:32 AM
= " 01JUN1D 62172010 11:16:32 AM 5/1/2010 12:04:55 PM

The “RINEX Download” window will appear. Set Provider, Station, and Time Zone as
shown below. The start time and end time should be adjusted to completely encompass
the time when points were logged (if necessary). Use the FRED station if possible, the
FERN station will also work.

Provider : 1f

Station : }FRED ;rj Load Avadabds Bage Station Lis 1
Time Zone : |(UTC-07:00) Arizona . ~] |
Start Date: | 6/ 1/2010 ~]  StatTime: {10:05:304M -

Duration : 302:05 =t
EndDate: | 5/ 1/2010 ~]  EndTime: {12:10:00 PM -

Target Path : jU ‘\Resources\iquatichw aterLab\S patial_Data\Beach_Monitoring_20 .....J

Provider Infos :  hitp:/feversy nas noaa.gov ACORS/ ' Download i Close {

Target Paths for Wahweap and Bullfrog units (respectively) are:
U:\Aquatic\WaterLab\SpatiaI_Data\PIankton_Sampling__yyyy\GPS\WW__U nit\Correct
ed
U:\Aquatic\WaterLab\Spatial_Data\PIankton_Sampling_yyyy\GPS\BF_Unit\Corrected
Click “Download” and then click “Close” when the download is complete.

In the box on the bottom of the MobileMapper Office window, a yellow bar will appear
beneath the green bars of the GPS file. Make sure this yellow bar extends beyond both
ends of the all the green bars. If not, download additional RINEX files to cover the
missing time periods.

FleName ' StatTime ... EndTime . ....T;eBal
" OLUNTD 6/1/2010 10:10:50AM  6/1/2010 10:26:32AM 2 . '
T OUUNTO 6/1/2010 11:16:32AM 6172010 12:04:55 PM : |

T

4 BFREDA10.152 6/1/2010 10:05:30 AM 67172010 1210:30 PM
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If needed, set the coordinate system for the job; MobileMapper should default to this
coordinate system when started. Select “Options” from the Menu bar. Click “Select
Coordinate System.” The “Select Coordinate System” window will appear. Select
"NAD1983_UTM_Zonel12N" from the drop-down list. The coordinate system will then
be displayed in the lower right hand corner of the screen.

Note: If this coordinate system does not appear in the drop-down list, it can be
added by importing any shapefile that uses the NAD1983_UTM_Zone12N projection
into MobileMapper Office. Click File>Import to open the shapefile and the
projection will become available. Once the projection has been added, reopen the
“filename_COR.mm)j” to finish differential correction.

Differentially correct the data. Click on the “Process data” icon, and then click "Okay"
when processing is complete.

|

AA e B &

1

FleMNeme . StetTime . ;EndTime
=T OUNTO 6/1/2010 10:1060AM  B/1/2010 10:26:
2 "O1UN10 §/1/2010 11:16:32AM  6/1/2010 12:04:55 PM

2 BFREDA10.152 64172010 10:05:30 AM 6/1/2010 12:10:30 PM !:.:

The “Correction” field in the Job Properties box should change from “Real-time” to
“post-processed” to indicate that the correction has been applied.

Job Propetties <1 Job Properties
Property | Value Propesty [ Value |

Job Name O1JUN1D | Job Name 01JUNTB_COR
Receiver IiobileMapper 6.56 Receiver MobileMapper £.56
s/n (000172556588 s/n {00D17295655

Start Time 6172010 10:11:31 Al Start Time /172010 16:11:31 AW
End Time 6/1/2010 11:51:35 AM End Time 6/1/2010 11:51.35 &AM
Duration hh:mm:ss} 014004 Duration {hhmm:es) 01:40:04

Correction Realtime et »-Post-processed
Number of Features 4 Number of Features 4

Features per Feature Type | Features per Feature Type

4 WQ_Sample 4 4 WQ_Sample 4

Note: One or more points may not be post-processed (data not good enough,
generally not enough satellites connected). If this happens Mobile Mapper will
notify you. When select un-corrected point with arrow, Correction will read
Uncorrected. See file naming conventions in Part C.

Save the job file.

Exporting Corrected GPS Data

Export the corrected points to a shapefile for GIS analysis. In MobileMapper Office,
choose "File" from the menu bar and click "Export...".
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Export directories for Wahweap and Bullfrog units (respectively) are:
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\WW_Unit\Export
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GPS\BF_Unit\Export
Click “Export”.

Rename the exported shapefile to match the job file it originated from in RZyymmdd or
Zyymmdd format. Start ArcCatalog and locate the exported shapefile. Job files created
on the GPS unit will default to “ZM_Sample” and random sample jobs uploaded to the
GPS will default to “RZ_yyyymmdd_2Zxx_elev”. Select the file and press F2 to rename it.
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Effective Date ] 5 /44/1«4 20/l &)

Approved By W/@/g

SOP D2.08: GIS Data Management

Summary

Plankton sample shapefiles exported from MobileMapper Office are copied into the GIS
directory and organized by sampling date. Shapefiles are projected and edited to ensure
attribute data is correct and all points are accounted for. Edited shapefiles are appended
to a geodatabase, and the locations of missing points are estimated. GIS data is then
loaded into the GLCA Plankton Samples geodatabase and is joined with tabular laboratory
data stored in an Access database.

Equipment

Computer with network access
ESRI ArcGIS 10.x

Microsoft Access

Plankton sampling datasheets

Procedure for Editing GIS Points

Copy the shapefile from the GPS\WW_Unit\Export or GPS\BF_Unit\Export folder to
GlIS\Sampled_Sites\WW or \BF and organize by sample date.

1. Start ArcCatalog and browse to the WaterLab\Spatial_Data directory.

2. Inthe Plankton_Sampling _yyyy\GIS\Sampled_Sites\WW or
\GIS\Sampled_Sites\BF folder create a subfolder named yyyymmdd for the day
samples were collected by staff from that lab.

a.If Bullfrog is not staffed all data will go in the WW folders. If Bullfrog is
staffed each lab should use their appropriate directories.

3. Create an edited subfolder in the yyyymmdd folder.

4. Go to GPS\WW_Unit\Export or GPS\BF_Unit\Export and locate the shapefile
(named in RZyymmdd or Zyymmdd format) exported from the sampling day’s
jobfile. Copy and paste the shapefile from GPS\WW(or BF)_Unit\Export into
GIS\Sampled_Sites\WW or \BF\yyyymmdd.
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B. Project the shapefile in the yyyymmdd folder and copy to the edited subfolder.

1.

. |
L Rl h
In the menu bar go to Wmdoyvs, then Yo | B | 8 Lo sench cle
Search to open the Search Window. S REE
ALL  Maps  Daty  Toals DN
project] |
Search for Project; choose Project (Data T =5
R . Search returned 10 items., Helg e
Management) to open the prOJectlon o o )
t00|. #,, Define Projection (Date Management)
This tonl overwrites the coordinate system...
tooltoxesisystern toolboxesiidats manage...
Drag the shapefile from yyyymmdd to e e et
the |nput Dataset f|e|d An Output toolboxesksystemn toalboxestdata manage...
. : . . Project {Data M ) g
Dataset name is automatically assigned e e atasetor foature c;ss)‘/"
(ﬁlename PrOjeCt.Shp) in the same toolboxeshsystemn toolboxes\data ndefage... | |

yyyymmdd folder.

Set the OQutput
Coordinate

Input Dataset or Feature Class
System to “UfiResourcestAquaticiWaterLabiSpatial_DataiBeach_Monitoring_2010\GIS\Sampled_Skes\BF|2010060 [;3]
Input Coordinate System (optional) -

Oujtpuf Dataset or Feature Class .
UrlResourcesihquatic\WaterLab\Spatial_Data\Beach_Monitoring_2010\GIS\Sampled_Sites\BF 2010060 f@

ouput Coordinate System o
'}dﬁb_‘igawé:ﬁ‘r!v‘l'_“zbﬁ’e:fzﬂM' e e et e . AN o e

Geographic Transformation {optional). .. .

NAD_1983_UTM_Zone_12N. Click the icon with a hand to the right of the field,
select Projected Coordinate System\UTM\NAD1983, and select Zone_12N. Click
OK to select, then OK to run the projection tool.

Copy and paste the projected file (filename_Project.shp) from the yyyymmdd to
the edited subfolder.

a.Repeat A-B if necessary for additional shapefiles for the same sample
date.

C. Merge shapefiles (if the sample date had multiple files) in the edited subfolder.

1.

Skip to D if there was only one shapefile for the sample date.

Open the Search Window; search for Merge and choose Merge (Data
Management) to open the merge tool.

Drag all files in the edited subfolder to the Input Datasets textbox. The filenames
will appear in the Datasets list. An Output Dataset name is automatically assigned
(filename_Merge.shp) in the same edited folder. Click OKto run the tool.

Delete all files from the edited subfolder except for filename_Merge.shp.
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D. Edit features to remove extra points, correct attributes, and add missing points.

1. Start ArcMap and press Cancel to work in an empty map.

2. Inthe menu bar go to Customize, then Toolbars and verify that the Editing toolbar
is checked.

3. Drag and drop the shapefile to be edited from the edited subfolder in ArcCatalog
into the ArcMap window.

4. Click Editor then Start Editing on the Editing toolbar.

a.If there is more than one layer in the map, right-click the file name in the
Table of Contents, select Edit Features and Start Editing.

5. In the Table of Contents right-click the shapefile and click Open Attribute Table.
Edit the features.

a.lf there are extra features (don’t represent a sample location) click the
gray box to the left of that entry’s FID column to highlight the feature and
press Delete on the keyboard.

b.If a SITEID or COLLDATE entry is incorrect or incomplete click on the field
and correct it. All characters should be uppercase with no spaces. SITEID
should have a site identifier and a number (GCD1, RZWW1, etc.).
COLLDATE should be in ddMMMyy format (17MAR15).

c.If a feature is missing add it. Use UTM or lat/long coordinates if available;
otherwise estimate its location based on the site description. See SOP
72.09: Creating Shapefiles and Adding Points for directions. Record in
the Excel file “yyyy Plankton point data source and correction” (in
Plankton_Sampling_yyyy) that the feature was created and its source.

6. Save edits by clicking Editor, Stop Editing, and responding Yes to save your edits.

7. In ArcCatalog rename the edited shapefile ZM_yyyymmdd_WW.shp or
ZM_yyyymmdd_BF.shp

Procedure for Appending Edited GIS Points to Geodatabase

A. At the end of the calendar year append edited GIS shapefiles to the year’s geodatabase

using the Append to DB model builder tool.

1. In Plankton_Sampling_yyyy\GIS\Sampled_Sites\All_Sites rename the
geodatabase; sub in the appropriate year in the name ZM_AIl_Sites_yyyy.gdb.
Expand the geodatabase and rename the feature class to which data will be
appended, replacing “yyyymmdd” with the date.
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a.If data is appended during the calendar year, not just at the end, make a
copy of the ZM_AIl_Sites_yyyymmdd_WW (or BF) feature class and
rename it, leaving an unaltered feature class that can be used as a
template for later manipulation.

In ArcCatalog, locate the Append to DB tool in the
PlanktonSamplingDBToolbox.tbx at
U:\Aquatic\WaterLab\Spatial_Data\Plankton_Sampling_yyyy\GIS\
Random_Sample_Selection\Tools.

Right-click Append to DB, select Edit to open the Model Builder interface.

Double-click Append and set the Target Dataset (feature class) that files will be
appended to as ZM_All_Sites_yyyymmdd_BF or ZM_AII_Sites_yyyymmdd_WW
as appropriate in that year’s
Plankton_Sampling_yyyy\GIS\Sampled_Sites\All_Sites\ZM_All_Sites_yyyy.gdb
geodatabse. Click OK.

Double-click Iterate Feature Classes and set the Workspace or Feature Dataset to
the folder that you want to append files from (Plankton_Sampling
_yyyy\GIS\Sampled_Sites\WW or BF. The Recursive option should be checked,
to process shapefiles in all subfolders of the designated Workspace. Set the
Wildcard to ZM* to ensure that only shapefiles that have been edited and
renamed (to format ZM_yyyymmdd_WW or BF.shp) will be appended to the
database. Click OK.

On the ModelBuilder toolbar, click Model>Run Entire Model. Once the Run is
complete click Close.

In ArcCatalog’s Catalog Tree click the feature class that was altered. Choose the
Preview tab in the work window and choose Table from the Preview drop-down
at the bottom of the screen. Review the points to ensure all dates were added.

Note that if the model is run again to add new data it will re-add all data points,
duplicating data that was already appended to the feature class. It's easier to
make a new feature class and append all data to it.

If there is a need to combine data from subsets of sampling time (not from all of the
calendar year) then the ArcCatalog tools Merge or Append can be used. Merge combines
inputted shapefiles into a new shapefile. Append adds shapefiles to an existing shapefile.

Procedure for Updating the GLCA Plankton Sampling Geodatabase

Load a new year’s data into the GLCA_Plankton_Samples geodatabase after all recorded
and estimated points have been edited and appended to the ZM_All_Sites_yyyy
geodatabase for a given year.

In ArcCatalog navigate to the GLCA_Plankton_Samples.gdb geodatabase located
at U:\Aquatic\WaterLab\Spatial_Data.
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2. Right-click the GLCA_Plankton_Samples_2008_present feature class and select
Load>Load Data.

3. Inthe Input Data box navigate to and select the ZM_AII_Sites_yyyy_WW feature
class. Press Open and then Add to add the file to the list of source data. Repeat
for ZM_AII_Sites_yyyy_BF (and ZM_All_Sites_yyyy_estimated, if applicable) if it
contains data.

4. Click Next to advance to the summary page, then click Finish to load the data.
B. Calculate the GPS_ID field for joining tabular data.

1. Dragand drop the GLCA_Plankton_Samples_2008_present feature class into
ArcMap. Start editing. Open the Attribute Table.

2. Highlight all points added for the current year. Right-click the GPS_ID field and
select “Field Calculator.” In the “GPS_ID=" window add the equation string
[CollDate]&”-“&[SitelD] and click OK.
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Effective Date |15 /“}u-j 2006,

Approved By \77/,,\/

SOP D2.09: Creating Shapefiles and Adding points based on Lat/Long

Summary

I Summary

Il.  Create a Shapefile (for a day’s sampling)
a. In ArcCatalog create a folder for the sampling day (ex: 20130323)
b. Right-click the folder where you want to put the shapefile; select New>Shapefile

c.  Name the shapefile as appropriate (ex: Z130323), leave Feature Type as “Point”. For
Spatial Reference:

i. ArcCat 10.0: select Edit>Select>Projected Coordinate Systems>UTM>NAD
1983>NAD 1983 UTM Zone 12N ‘

ii. ArcCat 10.1: right-click shapefile, choose Properties, click XY Coordinate
System tab, and navigate through folders to NAD 1983 UTM Zone 12N

I Bring the shapefile into ArcMap; Start Editing
V. Add points

a. Select the shapefile in the Create Features box. The Construction Tools box appears
below the Create Features box; select the Point tool.

b. Click on the map to add the correct number of points for the shapefile.

c. Select the Edit tool (arrow head). Double-click on a point, then right-click the point
and select Move to...

d. Select Decimal Degrees (or other appropriate coordinate notation system) from the
drop-down menu. Enter longitude in X, latitude in Y.

i. Note that Longitude is negative in the Western hemisphere, Latitude is
positive in the Northern hemisphere (ex: X= -110.7 Y=37.5)

ii. If entering UTM, what we record as 12522560E 4151632N would be entered
as 12S 522560 4151632 (the “S” doesn’t mean south; 125 is the grid where
the point is located, 12 is similar to longitude and S to latitude in describing
the UTM grid system)
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V. Gather UTM data on point if needed

a. If the point’s data was entered as lat/long and you want to get the UTM, then after

you've moved the point to the correct position using “Move to...” and lat/long zoom
in to a 1:1 ratio, select the Identify tool, click on the point, and record the UTM.

i. The Location gives the UTM, not including the grid (12S). Ex: if the Location =

522,559.914 4,151,700.830 Meters then the UTM as entered on our data
sheet = 12522560E 4151701N

ii. If you're zoomed out, then the accuracy of the UTM will be negatively
affected.

VI.  Add and populate SITEID and COLLDATE fields

a. Right-click the shape file name in the Table of Contents and open the attribute table.

From Table Options, select Add Field... Add a SITEID field (text, length=20) and a
COLLDATE field (text, length=20).
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Effective Date 1 & A\Aj 04,

Approved By "%70\/(

SOP: D3.01a Plankton Sample Concentration - Filtering

"I

Summary

All samples brought into the Glen Canyon NRA Molecular Laboratory need to be
processed to ensure the most accurate and reliable results. Samples are filtered to
remove organisms larger than 250 um and concentrated through filtration and later by
centrifugation (SOP 3.01b).

Equipment

Plankton sample(s) 63 and 250 pum sieves
RO water bottle50 ml conical centrifuge tubes
Tube holder Permanent marker

Small beaker or cup Vinegar spray or wash bottle

Procedure

NOTE — Steps that are adjusted when creating positive control samples are marked
with % as described in SOP 3.03

Plankton samples must be filtered to remove larger organisms and initially concentrate
the sample. This is done in the inner lab at the sink by the autoclave. Before you begin
processing dry the sink and clean it, the nearby countertop, the faucet and handles, and
the sieves with 10% bleach solution. Rinse the sieves immediately to reduce corrosion.

t Label one 50ml tube for each plankton sample. Write the sample date and site ID on
the side of the tube.

# Stack the 250 pum sieve on top of the 63 um sieve and put in the sink. Pour the plankton
sample onto the 250 um sieve and gently splash water over it to allow any smaller
organisms to pass through to the 63 um sieve. Set the 250 pum sieve to the side and
gently rinse the plankton in the 63 um sieve to one end.

Open the appropriate 50ml tube and put it in a beaker to keep it upright. Use RO water
to wash the plankton from the 63 um sieve into the 50ml tube; use at least 30-45ml of
water to wash the sieve to ensure you get all the plankton. Screw the lid onto the tube
and put it in the Styrofoam tube holder on the counter.

After each sample rinse plankton from the 250 pum sieve down the drain, spray the sieves
with vinegar and rinse, then wash down with 10% bleach and rinse.

Add RO water as needed to samples so that when the tubes are put in the LW Scientific
centrifuge they will be balanced.
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G. Rinse the sink with tap water, dry it, and then clean it and the counter with bleach
solution.
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Effective Date )(9 40:7 Zd} &

Approved By W

SOP: D3.01b Plankton Sample Concentration - Centrifugation

Summary
All samples brought into the Glen Canyon NRA Molecular Laboratory need to be

processed to ensure the most accurate and reliable results. After sample volume is
reduced to <50ml by filtration (SOP 3.01a), it is reduced further using centrifugation.

Equipment

Plankton sample(s) in 50 ml conical centrifuge tube(s)

LW Scientific Straight 8-3K Horizontal Centrifuge

1x PBS (phosphate buffered saline) solution

10ml disposable pipettes Pipette bulb Inner lab-General coat

Procedure

After plankton samples are filtered to remove larger organisms > 250 pm and reduce
volume they are brought into the inner lab to be pelleted in the LW Scientific centrifuge.
Wear the Inner Lab-General coat while processing samples.

Clean the area around the centrifuge, the countertop between the autoclave and the sink,
and the workbench with a 10% bleach solution.

Making sure the samples are balanced, spin down the samples in the LW Scientific
centrifuge at maximum speed for 20 minutes.

1. The timer must be turned within 5 seconds or the centrifuge will not start and you
will have to reopen and close the lid .

2. If there are an odd number of samples, fill another 50m! tube with enough water to
balance the centrifuge.

3. If the centrifuge is balanced, it makes a loud humming sound; if it is not balanced it
makes a rumbling sound as it vibrates (you can set something on the lid to quiet this);
and if it's very off balance the entire centrifuge vibrates so much it will move across
the bench top. Needless to say, if the centrifuge we’ve borrowed from BOR falls off
the bench top, that would be bad; there’s tape on the bench top around the legs of
the centrifuge to guard against this.

While the centrifuge runs set paper towels on the counter between the autoclave and the
sink. Place four 10ml pipettes on them and get out the pipette bulb.
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After centrifugation, draw off the supernatant with a pipette; use a different pipette for
each sample, make sure they aren’t touching on the paper towel, and note on the paper
towel which sample each pipette belongs to. Add 5-15 ml 1x PBS solution, mix, and run in
the centrifuge at max speed for another 20 minutes.

Draw off approximately supernatant with the pipettes used in the previous step, leaving
enough to resuspend the plankton pellet. Throw away the pipettes. Take the
concentrated plankton samples to the workbench; if there are more samples to
concentrate put them in the centrifuge and let them pellet while you begin DNA
extraction following SOP 3.02.
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Effective Date AL, 2ol

Approved By \MM[

Attached Documentation:

Qiagen DNeasy Extraction Kit Log (A3.00)
DNA Extraction (A3.03)

DNA Extraction Storage Log (A3.04)

SOP:D3.02b Adult Mussel DNA Extractions-Qjiagen

i

Summary

DNA extraction is a crucial step in PCR amplification. The exact protocol must be followed
by each technician working in the Molecular Laboratory.

Equipment

DNeasy’ Blood & Tissue Kit Molecular grade ethanol (96-100%)

Pipettes and filtered tips Denatured ethanol

Ohaus AP250D Electronic balance Lighter

Scalpel Sterile petri dishes

Scissors 1.5/2.0 ml microcentrifuge tubes

Spatula Eppendorf 5424 microcentrifuge

Fine tip tweezers Thermomixer-set at 56°C

Procedure

A. Gloves and inner workbench laboratory coats must be worn at all times.

B. Note: when using the DNeasy’ Blood & Tissue kit for the first time the following
must be done. Add the appropriate volume of Molecular grade ethanol (96-100%),
as indicated on the bottles, to AW1 and AW2 buffers. Buffers AW1 and AW2 are
stable for at least 1 year after the addition of ethanol when stored closed at room
temperature (15-20°C).

C. Preheat thermomixer to 56°C.

D. Cut up the adult tissue into very tiny pieces inside a sterile petri dish using the
sterilized scalpel. Place an empty 1.5 ml microcentrifuge tube to the Ohaus
Electronic Balance and push the Tare button to zero out the scale.

E. For the Ohaus Electronic Balance to read in mg ‘unit 3’ must be displayed at the

bottom of the screen. If it is not there press the mode button until ‘unit 3’ is seen.
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Using a spatula or tweezers place small pieces of cut up tissue into the 1.5 ml
microcentrifuge tube. Close lid immediately and reweigh until approximately 25 mg
of tissue has been added to the microcentrifuge tube.

Label the top and side of tubes with their temporary ID found on Attachment A2.01: .
DNA Extraction and Quantification form.

Add any unused tissue to a 1.5 ml microcentrifuge tube, label with the date and
‘quagga/zebra tissue’. Place in the tray marked ‘Corbicula, ZM and QM Tissue’.

Once all samples have been measured, add 180 pl Buffer ATL to the 1.5 mi
microcentrifuge tubes containing the cut up tissue.

Add 20 pl Proteinase K. Mix thoroughly by vortexing, and incubate in the
Thermomixer at 56°C with 1300 rpm of mixing until the tissue is completely lysed.

Lysis time varies depending on the type of tissue processed. Lysis is usually
complete in 1-3 hours. If it is more convenient, samples can be lysed overnight; this
will not adversely affect them.

Vortex for 15 seconds. Add 200 p! Buffer AL to the sample, and mix thoroughly by
vortexing.

. Add 200 upl molecular grade ethanol (96-100%), found in the flammables cabinet,
and mix again thoroughly by vortexing.

It is essential that the sample, Buffer AL, and ethanol are mixed immediately after
being added to the sample tube by vortexing or pipetting to yield a homogenenous
solution.

Pipette the mixture from Step M (including any precipitate) into the DNeasy Mini
spin column placed in a 2 ml tube (provided in kit).

Centrifuge at 26000 x g (8000 rpm) for 1 minute. Discard flow-through and
collection tube.

Note: Flow-through containing Buffers AL and AW1 are NOT
compatible with bleach.

Place the DNeasy Mini spin column in a new 2 ml collection tube (provided in kit),
add 500 pl Buffer AW1, and centrifuge for 1 minute at > 6000 x g (8000 rpm).

Discard flow-through and collection tube.

Place the DNeasy Mini spin column in a new 2 ml collection tube (provided by kit),
add 500 pl Buffer AW2, and centrifuge for 3 minutes at 20,000 x g (14,000 rpm) to
dry the DNeasy membrane.

Discard flow-through and collection tube.

Page 2 of 3



SOP D3.02b Issue 1

Note: following the centrifugation step, if carryover of ethanol
occurs, empty the collection tube, and then reuse it in another
centrifugation for 1 minute at 20,000 x g (14,000 rpm).

Place the DNeasy Mini spin column in a clean 1.5 microcentrifuge tube (not
provided), and pipette 200 pl Buffer AE directly onto the DNeasy membrane.

Label the tops and sides of the microcentrifuge tube with the extraction date,
quagga/zebra tissue, and pos control.

. Incubate at room temperature for 1 minute, and then centrifuge for 1 minute at
>6000 x g (8000 rpm) to elute. Place samples in the freezer (-20°C) in the box
labeled CON or for easier access in the tray labeled ‘Positive controls’.

Fill out the Attachments (A3.00 Qiagen DNeasy Extraction Kit Log; A3.03 DNA
Extraction form; A3.04 DNA Extraction Storage Log)
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Effective Date A /(—Mé 20(¢

Approved By W./Q,é =

Attached Documentation:
DNA Extraction and Quantification (A3.03)
MoBio UltraClean Extraction Kit Log (A3.02)

SOP: D3.03 Generation of Positive Controls — Veligers and Spiked Plankton Samples

Summary

)

Quagga and zebral mussel veligers’ DNA is used for positive controls and as QC to judge
how well PCR conditions are working; Lake Powell plankton samples spiked with quagga
and/or zebra mussel veligers are used as positive controls (matrix positive) and QC
measures to judge how well all or part of the DNA extraction process is working. This SOP is
an addendum to the process described in SOPs 3.013, 3.01b, and 3.02a.

Equipment

A. Veliger Isolation
Plankton sample from quagga or zebra mussel infested water body
Microscope with cross-polarized light
Microscope slide with raised edges
Disposable transfer pipette (eye dropper)
Microscopy lab micropipettor with filtered tips
1.5 ml tubes
Fine-tipped permanent marker
Wash bottle with RO water
B. DNA Extraction
Equipment as listed in SOPs 3.01a, 3.01b, and 3.02a

Procedure

A. Veligers and spiked plankton samples should be made and their DNA extracted
separately from unspiked Lake Powell plankton samples to prevent cross
contamination. Positive controls may be made on the same day after DNA from
unspiked samples has been extracted, or made on a different day.

B. Veliger Isolation
1. Clean the workbench around the microscope with a 10% bleach solution.

2. In a tube rack, set out one 1.5 ml tube for each positive control sample (or
aliquot) you will make.

3. Setout an extra 1.5 ml tube; fill with RO water.
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Use a disposable transfer pipette to transfer 2-5 drops of plankton to the
microscope slide; draw from the bottom of the plankton sample where the
plankton has settled and is more concentrated. Throw away the pipette.

Add water to the slide until it is covered to the raised edges. Let it sit until the
sample is stable (the ethanol plus the water makes the plankton move, but
without the water it’s very difficult to isolate veligers)

Use CPLM to find veligers on the slide.
Set the micropipette to a high volume and put on a tip.

Carefully move the tip under the field of view and press it lightly against the
slide. Move the tip until it’s next to the veliger and gently draw it in.

Lift the tip off the slide and draw in a small amount of air to prevent any liquid
from dripping from the tip. Open a 1.5 ml tube and expel the veliger(s) into it.
Repeat steps 8 and 9 until you have the desired number of veligers in that
tube.

Draw water from the extra 1.5 ml tube and expel into the veliger sample tube
to rinse the pipette tip (don’t have to rinse entire tip if never drew entire
possible volume of sample). Do this 2-3 times, then close the sample tube and
throw away the pipette tip.

Label the top of the tube with the sample date and name and number of
veligers in the tube (ex: 02MAR11 QV1 3 vel). Label the side of the tube with
the sample date and name (ex: 02MAR11 QV1), the date the veligers were
isolated and technician’s initials (ex: iso 21JAN12 SR}, and the number of
veligers.

Repeat steps 7-11 until have all as many veliger samples as needed. Then
carefully pour any sample still on the slide back into the plankton sample
bottle, rinse the slide thoroughly with water, and soak it with vinegar. Rinse
away the vinegar before drying and putting it away. Put away all tools and
preserved plankton samples.

Wipe down the workbench around the microscope with 10% bleach solution;
move the isolated veligers to the appropriate freezer box in the -20°C freezer

C. Veliger DNA Extraction — Do not use SOPs 3.01a or 3.01b. Follow SOP 3.02a with the
following exceptions (marked with T in SOP 3.02a):

1.

2.

Adjust Step C: Only get out 1 DBT for each veliger sample tube.

Replace Step D: Put all of the veliger aliquot into the DBT if possible. If you
can’t put the entire aliquot in one DBT, then use one pipette tip to fill the DBT;
close the DBT, eject the tip into the veliger sample tube, and centrifuge the
DBT at 10,000xg for 1 minute. Use a new tip to draw off at least 700 pl
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supernatant, then use the original tip to add more sample. Repeat until all of
the sample has been added to the DBT.

Replace Step E: When no sample remains in the veliger sample, eject the tip
into the empty veliger sample tube. Using a new tip, pipette 700 pl of 1x PBS
into the empty sample tube; throw away that tip. Carefully put the original tip
back on your pipette, pipette the PBS wash up-and-down to suspend any
plankton sticking to the tip, and transfer the rinse to the DBT. Eject the tip into
the veliger sample tube. Spin the DBT at 10,000 x g for 1 minute and use a
new tip to draw off 700l of supernatant. Repeat this rinse once more with
another 700 pl PBS, then throw away the sample tip and tube. Make sure the
DBT has 700 ! of liquid (add PBS/draw off supernatant as needed).

D. Spiked Plankton DNA Extraction — Whole Sample Spike - Follow SOPs 3.01a, 3.01b,
and 3.02a with the following exceptions (marked with ¥ in SOPs 3.01a and 3.02a):

1. SOP 3.01a-Replace Step B: Label one 50 ml tube for each spiked plankton

sample. Write the plankton sample date and name on the side of the tube;
also write the veliger sample date and name and the number of veligers on
the side of the tube (ex: 1% line reads 07JUL11 APM1B, 2" line reads
02MAR11 QV1 3vel.)

SOP 3.01a — Replace Step C: Pour the veliger sample into the plankton
sample. Rinse the veliger sample tube a few times with water, emptying the
wash into the plankton sample. Put the 63 pm sieve in the sink and pour the
spiked plankton sample onto the sieve. Use tap water to gently wash the
plankton to one end.

SOP 3.02a — Replace Step F: Close all DBT tubes from that sample and enter
the aliquots on A3.03 as aliquots of the veliger plankton sample, not the Lake
Powell plankton sample (ex: veligers spiked into an APM plankton sample
that was split into 3 aliquots would read as 02MAR11 QVP1-F13, F14, and
F15). Also label the tops of those tubes with the sample abbreviations.

SOP 3.02a — Replace Step G: Repeat steps D-F for all plankton samples. After
all information has been transferred to A3.03 and the DBTSs, note in the
Comments section which plankton samples were spiked with how many
veligers to generate the samples (ex: 07JUL11 APM1B was spiked with 3
veligers to generate QVP1-F13, F14, and F15). Throw away the empty 50 ml
tubes.

E. Spiked Plankton DNA Extraction — Plankton Aliquot Spikes — Follow SOPs 3.01a, 3.01b,
and 3.02a with the following exceptions (marked with * in SOP 3.02a):

1.

SOP 3.02a — Add to the end of Step E: Next, spike veligers into the aliquots by
adding a veliger sample to a DBT. If you can’t put the entire aliquot in the
DBT, then use one pipette tip to fill the DBT; close the DBT, eject the tip into
the veliger sample tube, and centrifuge at 10,000xg for 1 minute. Use a new
tip to draw off at least 700 pl supernatant, then use the original tip to add
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more sample. Repeat until all of the veliger sample has been added to the
DBT.

a. When no veliger sample remains, eject the tip into the empty veliger
sample tube and rinse by using a new tip to pipette 700 ul of 1x PBS
into the empty sample tube; throw away that tip. Put the original tip
back on your pipette, pipette the PBS wash up-and-down to suspend
any plankton sticking to the tip, and transfer the rinse to the DBT.
Eject the tip into the veliger sample tube. Spin the DBT at 10,000 x g
for 1 minute and use a new tip to draw off 700ul of supernatant.
Repeat this rinse once more with another 700 pl PBS, then throw
away the sample tip and tube. Make sure the DBT has 700 pl of liquid
(add PBS/draw off supernatant as needed).

SOP 3.02a — Replace Step F: Close all DBT tubes from that sample and enter
the aliquots on A3.03 as aliquots of the veliger plankton sample, not the Lake
Powell plankton sample (ex: veligers spiked into an aliquot of an APM sample
would read as 02MAR11 QVP1-F13). Also label the tops of those tubes with
the sample abbreviations.

SOP 3.02a — Replace Step G: Repeat steps D-F for all plankton aliquots. After
all information has been transferred to A3.03 and the DBTSs, note in the
Comments section which plankton aliquots were spiked with how many
veligers to generate the samples (ex: 07JUL11 APM1B-F2 was spiked with 3
veligers to generate QVP1-F13). Throw away the empty 50 ml tubes.

Page 4 of 4



SOP D3.04 Issue 2

Effective Date 16 /4'uq 20| £

Approved By %M/Z/

Attached Documentation:
DNA Extraction and Quantification (A3.03)
Freezer Box Storage Log (A3.04)

SOP: D3.04 Storage of DNA Template Samples

Summary

Extracted DNA template samples should be stored properly to ensure they can be used for
multiple PCR runs without degradation or cross-contamination.

Equipment

81 cell freezer box Fine-tipped permanent marker
Pipette with filtered tips Small centrifuge

Procedure

A.

DNA template extracted from Lake Powell plankton samples should be stored for a
minimum of six months after all PCR runs have been finished and the sample has
tested as having no veligers so that they can be referred to should any questions
about them or the location from which were they were taken arise.

DNA template extracted from plankton samples taken from other bodies of water
should be stored for a minimum of 5 years. Storing samples for a longer period of
time may be necessary and should be decided on a case-by-case basis.

DNA should be stored in the -20°C freezer. The freezer temperature should be
recorded once each day when it is being used. If the freezer is not being used daily, a
thermometer capable of recording minimum and maximum temperature should be
used to ensure the temperature stays in an appropriate range and checked weekly.

When not in use, the freezer door should be locked to ensure it is and stays closed
(use the lock as a door latch). You may want to check that the freezer is locked at the
end of each day.

Samples should be kept in 81-cell freezer boxes in the freezer. There are four kinds of
template samples: plankton sample DNA, extraction negatives, positive controls, and
cleaned-up PCR product. Each should be stored in its own box to prevent cross
contamination. DNA extracted from locations other than Lake Powell/Lee’s Ferry
should be stored in its own box to make it easier to find and to prevent cross
contamination.
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The lid of each box should be labeled with the box name, number, and information on
which samples are stored within. Box names are CON (positive controls), EX
(extracted plankton sample DNA), EX NEG (extraction negatives), and “Cleaned-up
PCR”. Boxes are numbered sequentially in the order they're filled {by age, oldest box
being “1”).

1. CON box labels should tell which aliquots are in the box (ex: 02MAR11 QVP1-
F1-34, 01SEP11 ZVP1 F1-19)

2. EX box labels should tell what sample dates are in the box (ex: 25JAN11-
28N0OV11)

3. EX NEG box labels should tell what extraction dates are in the box (ex:
02FEB10-19JUL12)

4. “Cleaned up PCR” box labels should include the year the PCR reactions were
run and the range of reactions contained (ex: 2011 Rx#0134-1025). Because
PCR numbering starts over at 0001 each year, different years’ reactions should
not be mixed.

If samples sit in the freezer for an extended period, the liquid can migrate up towards
the top of the tube; it is essential that tubes be spun down before they are opened,
especially if they have been stored for an extended time. The DNA should remain at
the bottom of the tube even if the liquid does not, and can be resuspended.

If all liquid sample has been used, there may still be DNA in the tube; do not throw
the tube away, but do note on the Freezer Storage Log that all liquid has been used
and the date. If that template needs to be run again, add 2.5 pl of water, shake the
tube, then spin it down to re-suspend DNA. This should work at least a few times;
note each time you do this in the Freezer Storage Log.

When all aliquots from a sample have been processed completely (two negative PCR
runs or two PCR runs with sequencing on at least one positive) the aliquots should be
combined into one tube to save space.

1. Completely thaw all aliquots then spin down. Measure the DNA concentration
and record on appropriate Attachment A3.03 (by doing now instead of after
extraction, reduces risk of cross contamination affecting PCR).

2. Add aliquots 2-x to aliquot 1, record on the tube total number of aliquots (add
“_x” to the F1 on label), and make sure bot the top and side of the tube are
labelled. Throw away all of the now-empty aliquot tubes.

3. Put combined samples into their own box for long-term storage; record
sample names and aliquot information on A3.04.
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Attached Documentation:
DNA Extraction and Quantification (A3.03)
MoBio UltraClean Extraction Kit Log (A3.02)

SOP: D3.05 DNA Extractions-MoBio-Adult Mussels

l. Summary .

DNA extraction is a crucial step in PCR amplification in which DNA is isolated on a filter and
eluted for use as PCR template. The protocol must be followed by each technician working
in the Molecular Laboratory.

1. Equipment

Adult mussels Weigh boat

Dissecting tools — 2 sets forceps, 1 scalpel and/or razor blade

1.0 ml centrifuge tubes

2 - 100 ml graduated cylinder or 250 ml beaker (to bleach and rinse dissecting tools)
MoBio UltraClean® Tissue & Cells DNA Isolation Kit

Proteinase K (part of Kit, but kept in refrigerator for long-term storage)

Test tube blocks Fine-tipped permanent marker and a Pen
Pipettes and filtered tips 10% bleach solution
Vortex with adapter Eppendorf Thermomixer

Eppendorf 5424 microcentrifuge Inner lab-General coat

1. Procedure — Dissecting Adult Mussels

A. Prepare the work area — dissections can be performed on the island in “outer” inner
lab (island usually used for Beach Monitoring). Wear gloves. Clear everything off the
island and wipe surface down with 10% bleach.

1. Get out and put on the island one weigh boat and one 1.0 mi centrifuge tube
for each mussel you'll dissect, a test tube block, and the dissecting tools. Put
a stack of paper towels (~1 for each mussel) on the island.

2. Fill a container (100 ml graduated cylinder or 250 ml beaker) with 10% bleach
solution; fill another with water. Put them on the island to be used to bleach
tools between samples and rinse them before re-use.

3. Add a small amount of RO water in each 1.0 ml centrifuge tube (1/4-1/3 full).
Label the tops of the tubes with mussel identifier.
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4. Add a small amount of RO water to the bottom of each weigh boat, enough
to entirely cover the musse! you’ll dissect. Having the water in the weigh
boat makes it easier to separate out tissues during dissection as they cling
together otherwise.

B. Dissect the mussel(s).

1. Take a scalpel or flat razor and, carefully holding the mussel so as not to cut
yourself, slice along the shell opposite of the hinge to sever the posterior
adductor muscle. Refer to the images below (taken from
http://el.erdc.usace.army.mil/zebra/zmis/zmishelp4/anatomy and physiolog
y.htm ) for location of posterior adductor.

i. The shell is fragile and may break apart; if it does the posterior
adductor should remain attached to the shell fragments.

2. Use forceps to pull the posterior adductor muscle from the shell; put it in the
appropriate 1.0 ml centrifuge tube.

i. The tissue may be frozen overnight if needed.

3. DNA may be extracted from an adductor muscle or from gill tissue; adductor
muscle is preferred. If using gill tissue, cut through the fused mantle to
expose the organs. Be careful to take only gill tissue, not gonad or digestive
tissues.

4. After collecting tissue from one mussel remove any tissue from the dissection
tools then soak them in 10% bleach for at least 1 minute. Rinse with water
before starting the next dissection.
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V. Procedure — Extracting DNA from Adult Mussels or Tissue

A. Gloves and Inner Lab-General laboratory coat must be worn at all times during DNA
extractions.

B. Clean the workbench with a 10% bleach solution. Record all data requested at the
top of Attachment A3.03.
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Get out a clean tube block from the cabinets above the workbench. Get out one Dry
Bead Tube (provided in MoBio UltraClean® Tissue & Cells DNA Isolation Kit) for each
sample, plus one for the equipment negative and one for the extraction negative.

Add 700 pl TD1 to each Dry Bead Tube (DBT). Label the tubes with sample identifiers
(see SOP 3.00, section VI for naming conventions). Enter the sample information on
A3.03.

Use forceps to add 1-25 mg of tissue to each tube; bleach the forceps and rinse with
water between samples. Open only one tube at a time.

1. If extracting DNA from a small whole mussel (not recommended; extraction is
more likely to fail), add 20 pl Proteinase K.

Dip the forceps into the equipment negative’s TD1.
Open, then close, the extraction negative.

Make sure the lids are on tight, then secure the DBTs onto the Vortex Adaptor
horizontally with the caps facing inward; make sure the adaptor is balanced. Vortex at
maximum speed for 10 minutes.

Place tubes in the Thermomixer and set to 60°C with 1300 rpm shaking for 30
minutes. Make sure the Thermomixer is balanced.

While samples are in the Vortex and/or Thermomixer, change gloves and bleach the
workbench. Get out another clean tube block.

1. Get out enough 2 m! Collection Tubes from the MoBio Kit for all aliquots;
close the lids and put them in the new block.

2. Get out enough Spin Filters (with tubes) from the MoBio Kit for all aliquots
and put them in the block you used during aliquotting.

3. Label the tops of the Spin Filters with the same information as is on the DBTSs;
label the tops of the Collection Tubes with the sample date and sample name
(ex: O6APR10 Q3a-Al).

Remove tubes from Thermomixer and place in Eppendorf microcentrifuge. Balance
the tubes in the microcentrifuge and screw the lid onto the rotor before closing the
microcentrifuge’s lid. Centrifuge tubes at 10,000 x g (10,319 rpm) for 1 minute at
room temperature.

Avoiding the pellet, transfer 700 pl of liquid sample to the appropriate Spin Filter.
Change tips after each transfer; all tubes not involved in the current transfer should
be closed. Centrifuge at 10,000 x g for 30 seconds to bind DNA to the silica filter, then
discard the flow through.
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. Repeat the previous step to move the remaining liquid from the DBT to the Spin
Filter; avoid disturbing the pellet.

. Add 400 pl of Solution TD2 (located in the Flammables Cabinet) and centrifuge at
10,000 x g for 30 seconds at room temperature to wash the DNA, then discard the
flow through.

. Centrifuge again at 10,000 x g for 1 minute at room temperature to remove residual
Solution TD2.

Carefully place the Spin Filter in one of the matching 2 ml Collection Tubes and
discard the used tube. Add 50 pl of Solution TD3 to the center of the white filter
membrane, changing tips each time. Centrifuge at 10,000 x g for 30 seconds at room
temperature to elute DNA into the Collection Tube.

Discard the Spin Filter; DNA is in the 2 ml Collection Tube. Store in the -20 freezer.
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Attached Documentation:
Plankton Sampling Site ID Key (A2.01)
DNA Extraction and Quantification (A3.03)

SOP: D3.06 Naming Extracted DNA Template Samples

l. Summary

DNA template is extracted for PCR from plankton samples taken from Lake Powell and
from plankton from Lake Mead (AZ/NV, quagga veligers), Lake Metonga (W1, zebra
veligers), and spiked-Lake Powell samples for use as positive controls. DNA may also be
extracted from mussel-boat samples and from adult mussel tissues. Consistently
naming the templates aids in evaluation of test results. While the most current naming
conventions should be followed, this SOP includes explanations of past naming
conventions.

No spaces should be included in names when they’re entered in any Excel sheet or
Access database, as these hinder transfer of data to ArcGIS. Replace spaces (as in, those
between date and plankton sample information) with a “-“.

. Routine Lake Powell Plankton Sites

A. Example template names: 28NOV11 WWM1B-F1; 20JUL11 HITE1B-F3
B. 1% part of template name = plankton sample date (DDMMMYY format).

C. 2" part of name = plankton sample name (before the dash); a 3-5 letter symbol for the
site (see A2.01), the number of the location sampled (usually “1”), and the letter “B”
signifying the replicate plankton tow meant for the molecular lab.

D. 3" part of name = aliquot information (after the dash); a letter (F, R, U, or SN) indicating
plankton size and a number indicating from which 700 pl aliquot of plankton the
extracted DNA template came.

F = “filtrate,” plankton 63-249 um across
R = “retentate,” plankton 2250 um across
U = “unfiltered,” plankton 263 pm across
SN = “supernatant,” collected after centrifugation.

R Random Lake Powell Plankton Sites

A. Example template names: 17AUG11 RZWW1B-F1, 17AUG11 RZWW3B-F2

B. 1% part of template name = plankton sample date.

Page 1 0f3



SOP 3.06 Issue 4

2™ part of name = plankton sample name (before the dash): a 4 letter symbol for
uplake/downlake (see A2.01), the number of the location sampled, and the letter “B”
signifying the replicate plankton tow meant for the molecular lab.

Usually ~6 samples/zone/day are taken; the numbers indicate the sample
location. The zone sampled is NOT indicated in the name.

3" part of name = aliquot information as described in section II-D.

Reported Lake Powell Sites

Example template name: 27AUG12 RPZWW1B-F1

Naming conventions are the same as for Random Lake Powell Sites, except that the
plankton sample name starts with “RPZ” instead of “RZ.”

Veliger Samples (positive controls), including Spiked Lake Powell Samples

Plankton samples from Lake Mead, Metonga, or other infested waters:
1. Example template names: 02MAR11 QV1-F6, 01SEP10 ZV1-F2
2. 1% part of template name = plankton sample date from the infested water.

3. 2" part of name = plankton tow information; 2 letters (QV or ZV) to indicate if the
veligers (V) are quagga (Q) or zebra (Z), and a number to indicate which
vial/container they were taken from (1* vial from that day, 2™ vial, etc.).

4. 3" part of name = aliquot information as described in section II-D.

a. Aliquots are taken by hand — veligers are isolated with microscopy and a
pipette. “F” is used because veliger size is ~ 63-250 um. Many aliquots may
be taken from the same vial over a period of time; when a veliger is isolated
the date and technician should be noted on A3.03.

5. NOTE - before 15NOV10 the first part of the sample name was Q1V; after 15NOV10
it was changed to QV.

Plankton samples from Lake Powell spiked with quagga or zebra veligers:
1. Example template names: 02MAR11 QVP1-F13, 01SEP11 ZVP1-F3

2. 1% part of template name = plankton sample date from the infested water; NOT
when the Lake Powell plankton was collected.

3. 2" part of name = plankton tow information; 3 letters indicate if the veligers {V) are
quagga (Q) or zebra (Z) and that they were spiked into Lake Powell (P) plankton,
number indicates the vial from which the veligers were taken.

a. Note on A3.03 DNA Extraction and Quantification which Lake Powell
sample/aliquots are being used as a matrix.
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4. 3" part of name = aliquot information; the letter and number indicate the size and
aliquot of the Lake Mead or Metonga plankton spiked into Lake Powell plankton as
described in section IV-A. These aliquots are numbered contiguously with the non-
spiked Mead/Metonga aliquots.

5. NOTE — before 19SEP11the letter “P” was not included in spiked samples. It is now
included to distinguish spiked-Lake Powell samples from samples consisting only of
Mead/Metonga/other infested water’s plankton.

Mussel boats

Example template name: 02JUL12 MB1-F2
1% part of template name = date when the sample was collected from the boat.

2" part of name = MB, indicates the sample is from a mussel boat/suspected mussel
boat. The number indicates which sample the aliquot is taken from (usually only one).

Note on A3.03 any known relevant information about the vessel — registration,
where/how long ago it was in the water, etc.

3 part of name = aliquot information as described in section II-D.
NOTE —this naming convention was created 16JUL12

Adult mussel tissues

Example template names: 06APR10 Q1j, 13MAY10 Z1d, 06APR10 Q1b
1%t part of template name = sample date on which mussels were collected.

2" part of name = information on the mussel; a letter (Q or Z) indicates if the adult was
a quagga or zebra mussel; a number indicates the vial from which the adult was taken
(Q1 = adult quagga taken from 1% quagga sample vial); and a second letter indicates the
individual adult from which tissue was taken (Qla = 1** adult from quagga vial 1; Q1j =
10" adult).

Some template samples have additional information if more than one tissue sample was
taken from a large adult or if the DNA was diluted after extraction [ex: Z1d-1,
Q1j(1:100)].

a. ‘-# after the initial identifier indicates the tissue sample from which DNA was
extracted when >1 tissue sample was taken from an adult (Z1d-1 = 1** tissue
sample taken from adult Z1d for extraction, Z1d-4 = 4™ tissue sample taken from
adult Z1d)

b. (1:100) or (1:10) indicates the dilution of DNA in molecular-grade water

¢. Source of tissue (not always noted): —A1, -G1, -W1: A = adductor muscle, G =
gill tissue, W = whole organism
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Attached Documentation:
Primer Log (A4.02)

SOP: D4.01 Primer Re-suspension, Dilution, and Labeling

Summary

Primer re-suspension and dilution to the recommended concentration must be done
correctly for proper PCR amplification and identification.

Equipment

Primers Molecular grade water 1.5 ml microcentrifuge tubes
Pipettes Filtered tips Vortex

Tube rack Personal microcentrifuge

Original paperwork from company that made the primers

Procedure — Primer Re-suspension

A. Work in the inner lab-hood. Wear nitrile gloves and the appropriate lab coat. Wipe
down the hood surface with 10% bleach solution before starting.

B. Re-suspend the dry primer to a 100 pM stock solution. There are two ways to
calculate how much water to use for the re-suspension of primers:

1. Print out Attachment A4.02: Primer Log and fill out the necessary information.
Calculate the amount of molecular grade water to add to the dried primer with
the following equation: x nmol/y pM = z ml, where x = quantity of dry primer
(nmoles), y = desired stock concentration (uM), and z = water needed (ml)

a. The quantity of dry primer in nmoles is found on the paperwork sent with
the primers.

2. Visit the website:
http://www.idtdna.com/analyzer/Applications/resuspensioncalc/

and fill out the necessary information using the paperwork from the primer
manufacturer. Fill out Primer Log when finished.

C. Store 100 pM (100x) stock solutions in the original tubes in their own box in the -20°C

freezer.
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Procedure — Primer Dilutions

Work in the inner lab-hood. Wear nitrile gloves and the appropriate lab coat. Wipe
down the hood surface with 10% bleach solution before starting.

To make 10 uM (10x) working primers from the 100 pM stock solution, make a 1:10
dilution. It is recommended that at least 3 sets of working stocks be made at a time to
reduce the number of times that the stock solutions go through a freeze-thaw cycle.

1. The working amount generally used is 200 pl; this can be adjusted if needed.

2. Aliquot 180 ul molecular grade water into clean 1.5 ml tubes. Label the tops and
sides with the primer name and concentration (10x); on the sides also put the date
the dilution is being made, the number of the working stock (numbered sequentially
as you make them: 1%t working stock made from a given primer is “1”, 2™ is “2”,
etc), and the amount of 10x stock being made.

a. Ex: top labeled “Ram ZF 10x,” side labeled “Ram ZF 10x, 02MAR12 #5,
200ul”

3. Thaw the stock solution entirely, then mix with the vortex and briefly spin down.

4. Pipette 20 pl primer stock solution into the appropriate tube. Pipette up and down
several times to rinse the tip and mix.

Note the change in volume of the 100x original stock solution in A4.02.
Primer Labels

A. Hoy 28S universal reverse — Du774rc — labeled on tubes as ‘DU’

B. Hoy 28S universal forward — fbv28s — labeled on tubes as ‘fbv’

C. Hoy 28S species-specific reverse for Quagga mussels — fbvDb28s538rc — labeled as
lDbl

D. Hoy 28S species-specific reverse for Zebra mussels — fovDp28s538rc — labeled as
IDpI

E. Frischer 185 universal reverse — UnivR-1765 — labeled on tubes as ‘UnivR-1765’
E. Frischer 18S Universal forward - UnivF-15 — labeled on tubes as ‘UnivF-15’

G. Ram QCOI species-specific reverse for Quagga mussels — QCOI568R — labeled on
tubes as ‘Ram QR’

H. Ram QCO! species specific forward for Quagga mussels — QCOI151F — labeled on
tubes as ‘Ram QF :
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Ram Z16S species specific reverse for Zebra mussels —Z165383R — labeled on tubes
as ‘Ram ZR’

Ram Z16S species specific forward for Zebra mussels —ZQ165147F — labeled on
tubes as ‘Ram ZF
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Attached Documentation:
PCR Master Mix Set-Up (A4.05)
PCR Well Assignment (A4.06)

SOP: D4.02 Polymerase Chain Reaction Set-Up

.

Summary

Standardizing the procedure for polymerase chain reactions (PCRs) is a necessary step in
ensuring the most reliable results are obtained from different technicians.

Equipment

Promega Core System | or Il (includes GoTaq, MgCl,, Buffer w/dye, dNTPs)

Pipettes and filtered tips Primers Tube racks

Ice blocks 0.2 ml PCR tubes Nitrile gloves
Molecular grade water 1.5/2.0 ml microcentrifuge tubes
DNA template Thermocycler

inner laboratory-hood lab coat Inner laboratory-workbench lab coat
Procedure

A. Prepare forms for PCR set-up

1. Open Attachment A4.06: PCR Well Assignment, “Save as” and save to Waterlab —
ZM Molecular/Molecular Lab Data/old PCR well assignment sheets folder, with
the date appended. Include all templates being tested, a PCR negative after every
10 reaction tubes, and all needed quagga and zebra positive controls.

a.Include controls at 107, 10, 10°*, and 10" dilutions to test sensitivity of
each PCR run.

b.25ul (one tube) of positive control is enough for two gels, or 48 template
and PCR negative samples.

2. Calculate the volume of each solution needed for the master mix based on the
number of samples using Attachment A4.05: PCR Master Mix Set-Up.

a.22.5 pl of Master Mix are made for each sample
b.Make sure you are using the correct Master Mix Set-Up form (sheet in the

excel file) from A4.05; check the primer set, MgCl concentration, and
multiplex/no multiplex status is accurate.
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1. Use higher MgCl concentrations to increase sensitivity.

Once the calculations are complete, print and complete both A4.05 and A4.06.

B. Prepare Master Mix in inner Lab-Hood

1.

Gloves and inner laboratory-hood lab coats must be worn at all times when
working under the inner laboratory hood.

a. There are two different laboratory coats assigned to the inner laboratory.
One lab coat is to be worn ONLY when working in the inner hood, the other is
to be used when working in the inner laboratory other than the hood, such as
the workbench, to prevent cross contamination.

Spray 10% bleach onto the fume hood workbench in the inner laboratory and
wipe dry.

Take the PCR Promega Core System I (or ll) reagents, molecular grade water, and
the primers out of the freezer and place in an ice block. Place all reagents under
the inner laboratory fume hood.

Before you start making the Master Mix, take advantage of the recently-sterilized
hood surface to get out the needed number of 0.2 ml PCR reaction tubes; you can
pour them onto the sterilized surface, close the caps, and put them into the ice
block.

Add reagents in the order that they are listed on A4.05 to a sterile

microcentrifuge tube. Always add the molecular grade water to the Master Mix
first and the GoTaq last. When pipetting very small volumes (<15ul), pipette up
and down several times to ensure all of the reagent is added to the Master Mix.

a. Before adding the reagents make sure they have thawed entirely, then mix
thoroughly with the vortex and spin down briefly. For the GoTag, instead of
mixing with the vortex flick the tube with your finger or repeatedly invert the
tube to mix (less likely to form bubbles this way).

b. If you're preparing Master Mix for >55 reactions (1.3 ml of Master Mix), you
will need to use a 2.0 ml tube. If you're preparing Master Mix for >80
reactions (1.8 ml of Master Mix), you will need >1 tube.

Once the Master Mix is ready mix and spin down briefly.

Aliquot 22.4 ul Master Mix into each PCR tube for 25 pl reactions, closing the
tubes as aliquot is added. Do not change tips unless the tip touches something
other than the inside of the Master Mix or PCR tube.

a. Aliquot 22.4 pl into each tube instead of 22.5 pl due to pipette constraints.
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Throw away the tube used for the Master Mix and return the ice block with the
PCR Core Kit, water, and primers to the freezer.

C. Add Template at Inner Lab-Workbench

1.

Take off the inner laboratory-hood lab coat, return it to the closet, and put on an
inner laboratory-general lab coat. Gloves do not need to be changed.

Spray 10% bleach onto the inner lab workbench and wipe down, then bring the
ice block with the PCR tubes to the inner laboratory workbench. Label the top of
each PCR tube with the number designated for that reaction (refer to A4.06) with
a fine-tip permanent marker.

Bring out all DNA template to be tested and a tube of molecular grade water.
Begin loading the template into the tubes (pipette up and down several times to
mix). Change pipette tips after each use and close the lid immediately after the
DNA template has been added. Add molecular grade water to PCR negatives as
you come to them (after every 10 samples).

a. Before adding the template make sure it is entirely thawed, flick the tube
to mix, and spin down briefly to prevent aerosols.

After all DNA template has been added, put away the DNA templates and bring
out and add the positive control templates. Be sure to make a PCR negative after
the positive controls. It is especially important to spin down positive control
template tubes before opening.

Put positive control templates and water back in the freezer. Take off the lab
coat and put back in the closet; may leave gloves on.

D. Load and Start Thermocycler

1.

Making sure all tubes’ lids are closed, place PCR tubes in the thermocycler
according to the PCR Well Assignment form. Press the “Standby” button to wake
up the cycler.

Press the F1/Protocol library button and select the Ram multiplex protocol.

Check the number of cycles and annealing temperature before you start the
program to ensure the correct number is listed; they’re listed at the bottom of
A4.05. To check, press the ‘Edit’ button to bring up the PCR parameters. Scroll
over and down to change the number of cycles/temperature if needed. Select
‘done’ when finished and save the new protocol.

Select the ‘Run protocol’ option.
Select ‘Begin Run’ or F5.

Record all PCR procedures on the PCR Mastermix Set-Up form.
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Allow the ice block to thaw completely, then soak in 10% bleach for 1 hour, rinse,
allow to dry, and return to the freezer.

Once the Thermocycler run is complete put samples in a box in the freezer of the
Outer Lab’s fridge for storage. Press and hold the “Standby” button until the
cycler goes to sleep.

a.Label the storage boxes ‘PCR yyyy’ (with the current year). When a box is

filled with samples, the labels should be marked to also include which
samples are in the box (for example, ‘0001-0086’)
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Attached Documentation:
Gel Electrophoresis (A5.00)

SOP: D5.01 Sub-Cell GT Systems Gel Electrophoresis Operation and Maintenance

Summary

Agarose

gel electrophoresis is an application used to visualize PCR-amplified DNA. In order to

ensure accurate results between technicians it is imperative to follow the standard operating
procedures for gel set-up and running conditions.

Equipment

250 ml Erlenmeyer flask 100 ml graduated cylinder 1x TAE Buffer
Agarose Ethidium bromide Electronic balance
Weigh boat Spatula Microwave

Hot pad grip/autoclave gloves  Gel caster Gel tray and comb(s)
PCR products 100 bp molecular ladder Outer laboratory coat
Pipette and filtered tips Sub-Cell GT electrophoresis chamber

Procedure

A. Gloves and outer laboratory coats must be worn at all times when working with gel
electrophoresis. This laboratory coat can be found in the outer laboratory closet.

B. Wipe down all surfaces with 10% bleach solution before starting.

C. Set-

1.

up the Sub-Cell casting tray and combs.

Level the Gel Caster using the leveling feet in the gel caster and the leveling bubble
provided.

Disengage and slide the movable wall to the open end of the Gel Caster by turning
and lifting the peg upward.

Place the open edge of the tray against the fixed wall of the Gel Caster.

Slide the movable wall against the edge of the tray.

To seal the open tray ends, engage the peg by turning and pressing downward
simultaneously. When the peg has dropped into the appropriate slot, turn the peg

in either direction until resistance is felt. This action seals the edges of the tray for
casting.
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Place the comb(s) into the appropriate slot(s) of the tray.

Prepare the agarose solution.

1.

Measure out the necessary amount of agarose into the weigh boat and pour into
the 250 ml Erlenmeyer flask. Measure out the 1x TAE buffer into a 100 ml
graduated cylinder, pour into the Erlenmeyer flask, and mix.

a. Fora7x10cm 2% gel use 35 ml 1x TAE solution with 0.7 g agarose.

Microwave for one minute. Every 20 seconds or so, open the microwave and use
rubber gripper to swirl the solution to mix. If the agarose is still not dissolved place
back in the microwave and continue until all agarose is completely dissolved in
solution.

Take the flask out of the microwave and put it in the hood. Allow the agarose to
cool to 55-60°C (able to hold flask in hand) before adding the ethidium bromide to
prevent volatilization of the compound.

Pipette 10 or 15 ul of 1% ethidium bromide solution into the agarose mixture. Swirl
the flask to mix.

Pour solution into the casting tray. If any bubbles are present, use a clean pipette tip to
move them to the edge of the casting tray, as they can interfere with the movement of
DNA (be sure to look around the combs for bubbles). Allow the gel to solidify; generally
this will take between 10-20 minutes depending on the percentage and size of the gel.
The gel should turn from clear to cloudy once it is solidified.

Put gel in the electrophoresis chamber.

1. Once the gelis solidified, disengage the peg by turning and lifting upward. Slide the
movable wall away from the tray, then carefully remove the comb(s).

2. Place the tray onto the Sub-Cell base so that the sample wells in the gel are near
the cathode (black) end. DNA samples migrate toward the anode (red) during
electrophoresis.

3. The wells should be completely submerged and covered with 2-6mm of 1x TAE
buffer. Use greater depth overlay (more buffer) with increasing voltages to avoid
pH and heat effects. Do not fill the chamber beyond the max fill line marked on
the electrophoresis chamber.

Load the gel.

1. Get the samples you will be running from the freezer in the outer lab and put them
in the tube holder. Get out the 100 bp ladder molecular ladder (for Ram primers).

2. Load the gel in the following order: plankton samples and PCR negatives, then

positive controls, then the molecular ladder.
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a. Leave the first two wells empty for the quagga and zebra positive controls.
Load 5 pl of sample into wells 3-14, leaving well 15 empty for the molecular
ladder.

b. After the samples have been loaded into the top and bottom lanes load 5 pl of
positive controls into the first wells of each lane and 5 pl of molecular ladder
into the last well of each lane.

I.  Runthe gel.

1.

2.

3.

Place the lid on the Sub-Cell chamber carefully so as not to disturb the samples.
The lid attaches to the base in only one orientation; match the red and black jacks
on the lid with the red and black plugs of the base.

Run the gel at 86 volts, 400 mAmps for 20 minutes.

Replace PCR tubes in the outer freezer in the appropriate box(es).

J.  Once the gel is finished running, turn off the power supply, open lid, and remove the
tray and gel, tilting slightly to allow buffer to drain off. Set the tray down on a paper
towel to blot it. Keeping the gel in the tray, bring it to the PhotoDoc-IT gel imager; refer
to SOP: 5.02 PhotoDoc-IT Imager Operation and Maintenance for steps in visualizing
the gel.

K. Wipe down surfaces with 10% bleach.

V. Maintenance

A. Daily Maintenance

1.

3.

Clean up any spills immediately with bleach and paper towels, wear gloves, and
place old gels/gel parts in the Biohazard bags.

Before leaving each day make sure the lids are on the electrophoresis chambers
and all solutions.

Wipe down microwave.

B. Monthly Maintenance

1.

Remove buffer from electrophoresis chambers and wash all Sub-Cell GT system
parts with a mild detergent solution in warm water. Rinse thoroughly with warm
water and air dry, then add new 1x TAE buffer.

a. Chemically compatible cleaners (such as dishwashing liquid) must be used to
insure long life of parts.

b. Do not leave plastic parts to soak in detergents more than 30 minutes. A short
detergent rinse typically is all that is required. ‘

Page 3 of 4



SOP D5.01 Issue 4

2. Check all electrodes and make sure they are in working condition.
C. Prep for long-term storage

1. If there will be an extended period when the gel system is not used, perform the
Monthly Maintenance. Unplug the gel chamber and store in the drawer with the
combs and ethidium bromide. Unplug the power unit and put on the (bleached)
bench by the microwave
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Attached Documentation:
Gel Electrophoresis (A5.00)

SOP: D5.02 PhotoDoc-It Imaging System Operation and Maintenance

M.

Summary

The PhotoDoc-It Imaging System is used for the documentation of agarose gels post-
electrophoresis so DNA band lengths can be observed. The System is made up of a UV
transilluminator (purple equipment - consists of a base with a UV light and a hood where the
camera and viewing screen are mounted), a camera (mounted to top of transilluminator’s
hood), and a viewing screen (mounted to front of transilluminator’s hood). The camera is
hooked up to the PhotoDoc-It printer.

Equipment

PhotoDoc-It Imaging System with LCD screen PhotoDoc-It printer
Agarose gel

Procedure

A. With the UV transilluminator turned off, move the hood off the base of the
transilluminator, place the gel (still in the casting tray) in the center of the base, and
replace the hood.

B. Turn on the transilluminator, camera, and viewing screen.

1. The transilluminator switch is on the front of its base; the camera switch is on the
top of the camera (that side of the camera faces the wall since the camera’s
mounted on the transilluminator hood) to the left of the shutter switch; and the
viewing screen’s power button is labeled as such.

C. Make sure that the settings are correct before taking a picture:
1. The Controller Button switch should be pressed to O (off).

2. The flash should be deactivated. Press the flash indicator on the right of the
Selector Button. Use the Selector Button to advance the options left or right until
the screen indicator shows a symbol with the flash, crossbar and circle.

3. Select the P option by pressing the Mode Button then using the Selector Button to

advance to the left or right until the P option is selected. Press the Function Set
Button to set the P option.
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D. Use the Zoom Button to zoom in and out to obtain the appropriate image size.

E. Pressthe Shutter Button halfway to focus; when the camera focuses it will beep twice
and one or more Green AF frames will appear where the subject is in focus. You may
have to move the camera around, zoom out, or shift the gel up in the casting tray so it
sticks out a bit at the top to get it to focus.

F. Capture the image by pressing the Shutter Button fully, then turn off the
transilluminator.

1. If the image is too dark use the Selector Button to set the ISO value to a higher
number; press the Function Set Button to set the higher value.

G. Print the image
1. Turn on the printer and push the Controller Button switch to | (on).

2. Press the Selector Button on the camera to advance the images to the left or right
and find the image to print. Press the Function Set Button to advance to the Print
option; press the Function Set Button again to print.

3. Change the Controller Button switch off before taking the next picture.
M. Tape the picture to the Attachment A5.00 Gel Electrophoreis.
Maintenance
A. Wipe down the transilluminator after each use.
B. Throw gels away in the biohazard bins; toss in the dumpster when full, do not autoclave.

C. Once a month unscrew the camera from the top of the imager, remove the memory
card, and download all images to WaterLab/Water Lab—ZM Molecular/Molecular Lab
Data/PhotoDoclt images. Delete images from the card after you've downloaded them
and return to the imager. Wear gloves and outer lab coat when removing the camera;
take them off before you take the card to the computer to download; put them back on
to put the card back in the camera and the camera back on the imager.
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Attached Documentation:
Gel Electrophoresis (A5.00)
Gel Interpretation Notes (A5.01)

SOP: D5.03 Analysis of Gel Image

l. Summary

Agarose gel electrophoresis is an application used to visualize amplified DNA. In order to
ensure accurate results between technicians it is imperative to follow the standard
operating procedures for analyzing the gel images.

1. Equipment

Picture of agarose gel Digital image of agarose gel
ML Procedure

A. Note the size and position of fragments in the molecular ladder lane; you may note
some sizes on the picture with a permanent marker if you feel that would be
helpful. Refer to the images in Attachment A5.01 Gel Interpretation Notes as
needed for the sizes of the fragments in the molecular ladder used.

B. Using the molecular ladder and positive controls for reference, estimate the size of
all fragments in each lane — these are the realized bands. Note the sizes and any
relevant notes on intensity in the table on Attachment 5.00 Gel Electrophoresis.
Where appropriate, note ‘NB’ (no bands) or ‘NB,S’ (no bands, DNA smear).

1. Examples of intensity levels: faint, v. faint, bright, etc.

2. You may also use the dye bands as a reference, in conjunction with the
molecular ladder, as DNA/dye may move at slightly different rates across the gel
(at lane 1 vs. lane 15).

3. Try not to let your expectations of what size the bands SHOULD be affect your
interpretation of what size the bands ARE. Eyeballing the size of the bands isn’t
ever going to let you get the size of the bands exactly right, and some difference
between the size you estimate the band to be (based on the gel) and the size
you know the band should be (based on relevant publications) is to be expected.

C. To ease interpretation across samples split into multiple aliquots, make notes on the

relevant Attachment A4.06 PCR well assignment (using highlighters, for example) of
what the realized band sizes were.
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D. Open the latest ‘PCR run records’ Excel file and ‘Save As’ to make a new file saved
under the current date. Enter data into the appropriate sheet.

E. Atthe end of each month after the digital images of the gels have been loaded onto
the U: drive, go through the digital images and (re-)score them; the digital images
are better quality than the printed photographs and you may discover bands you
didn’t see or that bands you thought were there are not. Note any changes on the
relevant A5.00 (put in comments with the reason changed, the date, and initial) and
record the date the digital image was reviewed in the appropriate space. Then
review the Excel file and make sure that all data were entered correctly and make
any necessary changes.

1. Example of correction comment: ‘changed from “v. faint 100” to “NB, S” after
reviewing digital image 01MAR12 SR’.
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SOP: D5.04 Potential Positives — Flow Chart

. Summary

SOP D5.04 Issue 2

Effective Date }é A’(/Lj 20( &

Approved By %,VZ

Attached Documentation:

MoBio UltraClean PCR Clean-up (A4.07a)
QlAquick Gel Extraction (A4.07b)
Sample Dilution for LVS and HVS (A4.08)

B

When a positive result occurs, the amplified DNA must be cleaned-up (all dyes, buffers,
excess nucleotides, etc. removed) and then sequenced to determine correct identification.
The PCR samples will be cleaned-up in the Molecular Laboratory then sent to the
University of Arizona Genetic Core (UAGC) Laboratory Facility for the actual sequencing.
The following flow-chart is meant to clarify when to use different clean-up techniques and
when to use high- vs. low-volume sequencing services from the UAGC.

Band(s) on gel

Single amplified
band /

UltraClean PCR Clean-Up
Kit (SOP 5.052)

>1 amplified
\ band

QIAquick Gel Extraction
(SOP5.05b)

Sequencing 1 — 13
bands

Cleaned-up
amplified DNA

Sequencing 14 or
more bands

Low-volume sequencing (SOP 5.06)
e [DNA] depends on amplicon
length
e 16ul template in 1.5ml tubes
One-1.5ml tube for each primer
Each reaction needs 5ul of 3-
5uM primer

High-volume sequencing (SOP5.06)
e [DNA] = 10ng/ul
e Template in 96-well plates; each
template gets 2 wells, Sul/well
Primers in own 96-well plate
Each reaction needs 4pl of 3uM
primer
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Approved By W

Attached Documentation:
MoBio UltraCiean PCR Clean-up (A4.07a)

SOP: D5.05a PCR Clean Up — UltraClean Kit

.

Summary

When a positive result occurs, sequencing is necessary to determine correct identification.
For samples that have one unknown amplicon, the UltraClean PCR Clean Up Kit is used to
clean amplified samples before sequencing.

Equipment

PCR products/DNA template Pipettes Filtered tips
UltraClean® PCR Clean Up Kit Vortex Microcentrifuge
Molecular grade water Test tube block

Procedure

A. Before you start dealing with amplified samples, retrieve everything you'll need
from the inner lab — a test tube block (if there’s not one in the outer lab) and
molecular grade water, and pipette tips if needed. If you have to ship samples for
sequencing immediately, make up enough primer solutions for all samples to be
sequenced before cleaning PCR product.

B. Wear laboratory coat designated for the outer hood and gloves at all times unless
instructed otherwise. Wipe up any spills/drips with 10% bleach as you go through
the procedure.

C. Clean up the PCR products using MoBio’s UltraClean® PCR Clean-Up Kit and the
following directions

1. Wipe down outer hood with a 10% bleach solution. Get out a clean
(bleached) test tube block.

2. Begin filling out Attachment A4.07a: MoBio UltraClean PCR Clean-up.
3. Shake to mix the SpinBind before use.

4. Add 5 volumes of SpinBind to the PCR reaction. Example: if ran a 25 pl
reaction and used 5 pl for electrophoresis then add 100 pl to the remaining
20 pl PCR reaction tube. Mix well by pipetting.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

SOP D5.05a Issue 3

Transfer PCR/SpinBind mixture to a Spin Filter unit.

Remove laboratory coat and gloves and wash your hands. Bring samples
into the inner laboratory workbench to spin samples down.

Centrifuge 30 seconds at a minimum 10,000 x g (approximately 13,000 rpm)
in a tabletop microcentrifuge. Avoid putting test tube block on work bench

if possible. Do not touch anything in inner lab except as necessary.

Bring samples back to the outer hood and place laboratory coat and gloves
back on.

Remove the Spin Filter basket and discard the liquid flow-through from the

tube by decanting.

Replace the Spin Filter basket in the same tube.
Add 300 pl SpinClean Buffer to the Spin Filter.

Remove laboratory coat and gloves and wash hands. Bring samples into the
inner laboratory workbench to spin samples down.

Centrifuge 30 seconds at a minimum 10,000 x g (13,000 rpm). Avoid putting
test tube block on workbench if possible. Do not touch anything in inner lab
except as necessary.

Bring samples back to the outer hood and place laboratory coat and gloves
back on.

Remove Spin Filter basket and discard liquid flow through by decanting then
replace basket back into the same tube.

Remove laboratory coat and gloves and wash hands. Bring samples into the
inner laboratory workbench to spin samples down.

Centrifuge 60 seconds at minimum 10,000 x g (13,000 rpm). Avoid putting
test tube block on workbench. Do not touch anything except as necessary.

Bring samples back to the outer hood and place laboratory coat and gloves
back on.

Transfer Spin Filter to a clean 2 mi Collection Tube (provided by kit).

Add 50 ul of molecular grade water directly onto the center of the white
Spin Filter membrane. (Note: it is recommended by UAGC to use sterile
water over Elution Buffer for sequencing purposes).

Remove laboratory coat and gloves and wash hands. Bring samples into the
inner laboratory workbench to spin samples down.
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23.

24.

25.
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Centrifuge 60 seconds at a minimum 10,000 x g {13,000 rpm). Avoid putting
test tube block on workbench. Do not touch anything except as necessary.

Bring samples back to the outer hood and place laboratory coat and gloves
back on.

Remove the Spin Filter basket from the 2 ml Collection Tube.

Label tubes with the PCR clean-up date, PCR ID and the phrase ‘cleaned-up’
on both the top and side of the tubes. Place samples in the freezer (-20°C) in
a box labeled with the year the PCR reaction was run and ‘Cleaned-up PCR
for sequencing.’
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Attached Documentation:
QlAquick Gel Extraction (A4.07b)

SOP: D5.05b PCR Clean Up — QlAquick Gel Extraction

I Summary

When a sample displays multiple bands on a gel the bands should be sequenced
separately, as sequencing two or more different DNA fragments at the same time may
yield unusable sequence data. The bands must be cut from the gel and the amplified DNA
extracted from each band before the DNA can be sent in for sequencing with the
appropriate primer set.

1. Equipment
PCR products/DNA template Pipettes Filtered tips
QlAquick® Gel Extraction Kit Clean scalpel or razor Vortex
UV light and goggles 1.5 mL microcentrifuge tubes  Balance
Thermomixer Isopropanol Microcentrifuge
Molecular grade water 3M sodium acetate (may not be needed)

. Procedure

A. Wear laboratory coat designated for the outer hood and gloves at all times unless
instructed otherwise. Wipe up any spills/drips with 10% bleach as you go through
the procedure.

B. Extract the PCR products using QlAquick * Gel Extraction Kit and the following
directions

1. Wipe down outer hood with a 10% bleach solution. Get out a clean
{(bleached) test tube block.

2. Begin filling out Attachment A4.07b: QlAquick Gel Extraction.

3. While wearing UV safety goggles, put the gel on the UV light and turn it on.
Use a clean scalpel or razor to cut out the area with the band. Check the gel
pieces with the UV light to ensure the fragment is present in the final gel
piece. Bleach the scalpel/razor between uses.

a. Limit the time the gel spends exposed to UV light, as it may degrade
the DNA. Using the gel photo as reference may help.
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11.

12.

13.

14.

SOP D5.05b Issue 2

Put the gel piece in a tared 1.5 mL microcentrifuge tube and weigh the gel
slice. For a <2% agarose gel add 3 volumes Buffer QG to 1 volume gel (100
mg ~100 pL).

a. |If the gelis >2% agarose, add 6 volumes Buffer QG to 1 gel.

Remove outer lab coat and gloves, wash hands, and take samples to inner
lab. Incubate in Thermomixer with ~600 rpm shaking at 50°C for 10 minutes
or until gel slice is completely dissolved.

Once the gel slice is dissolved completely bring it back to the outer lab and
put gloves and coat back on. Check that the mixture is yellow (like Buffer
QG without dissolved agarose). If the color of the mixture is orange or
violet the pH is too high; add 10 uL 3M sodium acetate (pH 5.0) and mix.
The color of the mixture will turn yellow.

Add 1 gel volume of isopropanol to the sample and mix
a. Note: 100 mg =100 ul
Place a QlAquick spin column in a provided 2 mL collection tube.

To bind DNA, apply up to 800 pL of the sample to the QlAquick column.
Remove outer coat and gloves, wash hands, and take sample to inner lab;
centrifuge at 17,900xg for 1 min.

Bring centrifuged sample back to outer lab, put coat and gloves on, and
discard flow-through and place the QlAquick column back into the same
tube.

a. Forsample volumes of >800 pL, load and spin again.

Add 0.5 mL Buffer QG to the QlAquick column, remove coat and gloves,
wash hands, and take to inner lab; centrifuge at 17,900xg for 1 min. Bring
sample back to outer lab, put on coat and gloves, discard flow-through and
place the column back into the same tube.

To wash, add 0.75 mL Buffer PE to the column and let it stand for 2-5
minutes. Take off coat and gloves, wash hands, then centrifuge at 17,900xg
for 1 min. Bring back to outer lab, put on coat and gloves, then discard
flow-through and place column back into the same tube.

Take off coat and gloves, wash hands, then centrifuge the column at
17,900xg for 1 min to remove residual Buffer PE.

Bring sample back to outer lab, put on coat and gloves, and place the
column into a clean 1.5 mL tube labeled with the extraction date, “gel
extraction” abbreviation, PCR sample number, and approximate fragment
size (ex: 10AUG11 Gel Ext 0132 250bp).
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To efute DNA, add 50 pL molecular grade water to the center of the
QlAquick membrane, let stand for 1-4 min, then remove coat and gloves,
wash hands, and centrifuge in inner lab at 17,900xg for 1 min. (Note: it is
recommended by UAGC to use sterile water over Elution Buffer for
sequencing purposes).

If the purified DNA is to be analyzed on a gel, add 1 volume Loading Dye to 5
volumes of purified DNA. Mix before loading on gel.

a. |If the purified DNA is to be sequenced, measure the DNA
concentration and prepare the sample according to UAGC’s
instructions.

Put extracted samples in the box in the freezer with other cleaned-up PCR

products. Wipe down inner lab bench by centrifuge and by Nanodrop (if
used) with 10% bleach solution.
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Attached Documentation:

MoBio UltraClean PCR Clean-up (A4.07a)
QIAquick Gel Extraction (A4.07hb)
Sample Dilution for LVS and HVS (A4.08)

SOP: D5.06 Preparing Cleaned-Up DNA Samples for Sequencing

i Summary

When a positive result occurs sequencing is necessary to determine correct
identification. After PCR samples have been cleaned-up they are diluted to the
appropriate concentration(s) and sent to the University of Arizona Genetic Core (UAGC)
Laboratory Facility for sequencing. All sequencing preparations are done according to
UAGC'’s protocols. http://uagc.arl.arizona.edu/fags/sequencing

fl. Equipment
Cleaned-up PCR products Pipettes Filtered tips
Molecular grade water Primers (forward and reverse)
Freezer box Dry ice

1.5 ml microcentrifuge tubes (low-volume sequencing)
96-well plate with 8-lid strips (high-volume sequencing)
Cooler — Styrofoam (no return service) or cloth (include return shipping label)

" Procedure — Dilution for Low-Volume Sequencing

A. Low-volume sequencing costs $5.50/reaction, or $11 for 1 sample sequenced
forward and reverse (F and R). In fall 2012, UAGC notified us that as a non-profit
institution we’d be charged as an academic institution. Use LVS when 13 or fewer
samples are being sequenced F and R.

B. Create a new folder in Water Lab — ZM Molecular>Molecular Lab Data>DNA
Sequencing; give it a descriptive name that tells when the work order is being
submitted and what type of samples they are (ex: “20111114 Ram amplified spiked
and false pos samples” holds data for spiked and false-positive samples amplified by
Ram primers; SLM work order submitted on 14NOV11).

a. Save a copy of Attachment A4.08: Sample Dilution for LVS and HVS in this
folder; append the date to the file name.

C. Make a work order for low-volume sequences on UAGC’s SLM website
(https://services.arl.arizona.edu/user/login/?next=/).
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a. Username: alexandra_rohde@nps.gov, password: Aquatics

b. After logging in, click “Create Submission;” select “Low Vol (Tube)
Sequencing,” then “GLCAlabs account 111111”.

c. Enter the requested information; “Template Type” is “PCR Product.”
d. Click “Submit Tubes” after you have added all tubes to the work order.

D. Condition the pedestal on the Nanodrop. Measure the concentration and purity of
cleaned-up samples, record on Attachment A4.07a (or Attachment A4.07b), then
enter in the appropriate columns of Attachment A4.08, sheet “LVS concentration
wksht.”

E. Record the fragment size in A4.08 and calculate the desired DNA concentration for
each sample: Fragment Length*0.02 = [DNA] (in ng/uL)

F. Write the volumes of stock and water needed to make 16 pl of template of the
appropriate concentration (8 for forward and 8 for reverse reaction)from A4.08 onto
A4.07a (or A4.07b). Combine the water and stock in a single 1.5ml tube.

a. Where pipette volume constraints don’t allow you to dilute to 10ng/ul, it’s
better to dilute to <10ng/ul (preferably >7ng/pl) than to leave samples at
>10ng/ul (see Molecular lab study notes 15AUG12).

b. To check math on dilutions you can use the website at
http://www.idtdna.com/analyzer/Applications/DilutionCalc/

G. Label each tube with the name of the template on top and with your name and the
tracking (work order) name on the side. Put the tubes in an 81-space freezer box and
store in the -20°C freezer until shipping.

H. Prepare the primers. Each reaction requires 5 pl of 3-5 uM primer. Each primer
should be put in its own tube labeled “primer xyz” (ex: primer Q-F) on top, with your
name and the work order on the side. Put the primers in the 81-space freezer box
and store in the -20°C freezer until shipping.

Procedure — Dilution for High-Volume Sequencing (HVS)

A. High-volume sequencing has a flat rate of $150/plate (96 wells/plate, up to 48
samples F and R). Use HVS when >13 samples are being sequenced.

B. Create a new folder in Water Lab — ZM Molecular>Molecular Lab Data>DNA
Sequencing; give it a descriptive name that tells when the samples are being sent off
and what type of samples they are (see explanation in l1I-B above).

a. Save a copy of A4.08 in this folder; append the date to the file name.
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Create a template and primer map in A4.08, “HVS plate map” sheet. Because cap-
strips are 8 caps long it’s best to organize samples vertically, not horizontally, so each
column can be sealed as it’s filled.

Make a work order for high-volume sequences on UAGC’s SLM website
(https://services.arl.arizona.edu/user/login/?next=/).

a. Username: alexandra_rohde@nps.gov, password: Aquatics

b. Click “Create Submission;” select “High Vol (Plate) Sequencing,” then
“GLCAlabs account 111111”

c. Enter the requested information.

d. Click “Submit Sequence Plate” when done.
Condition the pedestal on the Nanodrop. Measure the concentration and purity of
cleaned-up samples, record on A4.07a (or A4.07b), then enter in the appropriate
columns of A4.08, sheet “HVS concentration wksht.”

For HVS all samples’ DNA concentration should be 10 ng/pl.

Print A4.08, “HVS concentration wksht,” and use the calculated volumes to make 8 ul
of template by combining the water and stock in the designated wells in the 96-well
plate. Keep columns capped when they are not being filled, unsealing only to fill the
wells and sealing the column after you're done.

a. Where pipette volume constraints don’t allow you to dilute to 10ng/pl, dilute
to <10ng/ul (preferably >7ng/pl) (see Molecular lab study notes 15AUG12).

b. To check math on dilutions you can use the website at
http://www.idtdna.com/analyzer/Applications/DilutionCalc/

Label the plate with the work order name when you're done, put it in an empty 81-
space freezer box, and store in the -20°C freezer.

Prepare the primers. Each reaction requires 5 pl of 3 uM primer.

a. Ifyou’re using 1 primer for the plate, put the appropriate amount of 3 uM
primer in a 1.5 ml tube labeled “primer xyz” on top, with the work order on
the side. Put the tube in the freezer box with the template and store in the -
20°C freezer until shipping.

b. If you're using >1 primer on the plate, make a 2" plate with primers in the
wells corresponding to their template locations. Make

5(x+2) pl of 3 uM primer, where x = # reactions. Aliquot 5 pl of 3 uM primer
into the appropriate wells, seal with 8-cap strips, and label the plate
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“primers” and the work order name. Put the plate in the freezer box with
the template and store in the -20°C freezer until shipping.

V. Shipping Samples to UAGC

A. Fill out a DI-1 for purchasing dry ice (approximately $8.50) and another for the
samples to be sequenced (price depends on if using LVS vs. HVS), give DI-1s to the
person with purchasing authority (currently Lisa Napoli). Be sure to check current
UAGC pricing: http://uagc.arl.arizona.edu/index.php/pricing.html

B. To keep the samples cold until they get to UAGC’s laboratory ship them on dry ice.
Purchase ~1 pound and place in the cooler with the samples. You may use a
Styrofoam cooler or a soft-sided cooler. Styrofoam coolers may be purchased from
Safeway or Walmart or saved for this purpose from a received shipment of PCR Core
Kits; UAGC will recycle the cooler after receipt of the shipment. The lab has 2 soft-
sided coolers that can be used for shipping samples in the closet with the outer-lab
coats; if you use one ask for a return FedEx label to include in the package so UAGC
can send it back. FedEX comes to the front desk at Headquarters by 11:00 am, so
take the samples up there by 10:00 am.

C. Ship samples FedEX next day if possible. The shipping address is:

University of Arizona Genetics Core
1657 E Helen Street

Keating Building, Rm 124

Tucson, AZ 85721

D. An email will be sent when the sequences are ready for viewing.
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Attached Documentation:
BLAST of Samples Submitted ddMMMyy (A4.09)

SOP: D5.07 Analysis of DNA sequence from UAGC with FinchTV

l. Summary

When a positive result occurs, sequencing is necessary to determine correct identification.
UAGC will post sequence data to the SLM server generally within 3-5 days of sample
submission. Sequences must be edited, then compared to known sequences to identify
the amplified sequence.

Il. Equipment

Computer with internet connection
.ab1, .fasta, and .qual files for each sequence submitted
Computer with FinchTV software installed (optional)

HI. Explanation of File Types

A. .abl-a DNA electropherogram file. It can be viewed with Java. It shows the
fluorescent peaks read by the sequencer, from which it derives DNA sequence

B. .seq— a text file with the nucleotide sequence. Each file has a header with the file
name (ends in .ab1).

1. Exof header: >57_1370_QF 639621.ab1
V. Procedure
A. Logonto UAGC's SLM website (https://services.arl.arizona.edu/user/login/?next=/).
1. Username: alexandra_rohde@nps.gov, password: Aquatics.
2. Select the appropriate submission, then select the ‘Files” tab.
3. Check all files, then “Download Selected”. Save the files as a zipped folder in
the appropriate folder (made in SOP 5.06, IlI-D or IV-D) in Molecular Lab

Data>DNA Sequencing.

4. Rename the zipped folder “all raw data yyyymmdd” (date work order
submitted).
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B. Edit sequences and create a Word document with all edited sequences

1. Without FinchTV:

i. Copy and paste the individual sequences into a master Word file with
all sequence data.

1.

2.

Open each .seq file with Microsoft Word.

Copy and paste all sequence data into a Word file titled
“ddmmmyy sequences of samples submitted

yyyymmdd” {ex — ‘18 NOV11 sequences of samples submitted
20111114’ is a master file created 18NOV11 containing un-
edited sequences of samples submitted to SLM on
14NOV11).

a. Youdon't have to copy/paste lines of data at the end
of the sequence if all letters in the line are “N”. You
still need to copy and paste all lines at the beginning
of the sequence, even if all letters are “N”.

ii. Edit the sequence data

1.

Save the master file with a new name before changing the
sequence data: “ddmmmyy edited sequences of samples
submitted yyyymmdd” (ex — ‘21NOV11 edited sequences of
samples submitted 20111114’ is file created 21NOV11 with
sequences edited for data quality, for samples submitted
14NOV11).

Delete the initial and final nucleotides with O-value for
quality, leaving only sequence for which signal strength was
>0. Use the chromatogram as a guide.

Based on the chromatogram, replace bad nucleotide calls as
needed.

iii. Run a BLAST for each edited sequence —it’s easiest to do this for all
sequences after they are edited. Follow the instructions in steps C-E

below.

2. With FinchTV:

i. FinchTV can’t open files from a zipped folder, so create a new folder
named “all raw data yyyymmdd Unzipped”. Right-click the zipped
folder and “Extract All...” then navigate to the unzipped folder and
click OK.
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ii. In FinchTV go to File>Open and navigate to the unzipped folder; open
the desired file.

ili. FinchTV allows for easier editing:

1. You can search for the primer base sequences in the “Find
Sequence” window.

2. Adjust the vertical or horizontal scales to zoom in on
sequences of interest.

3. To delete sequence, highlight the sequence and go to
edit>Delete.

4. To change the nucleotide that was called or to designate a
nucleotide for an “N’ call click on the nucleotide and type the
nucleotide abbreviation to change it.
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iv. Once you've finished editing, Save As and add “edited” to the end of
the file name. Go to Edit>BLAST Sequence>Nucleotide, BLASTn to
submit the sequence.

Open Attachment A4.09. Save as “ddmmmyy BLAST of Samples Submitted
yyyymmdd” (“21NOV11 BLAST of Samples Submitted 20111114” = file contains
sequence data from 14NOV11 work order; a BLAST was performed on the sequences
on 21NOV11) in the work order’s folder.
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D. Run a BLASTn for each sample at the NCBI website
http://blast.nchi.nlm.nih.gov/Blast.cgi

1. Select “nucleotide blast;” under “Choose Search Set” change Database to
“Nucleotide collection {nr/nt).”

2. Copy and paste one sequence, with header (make sure header starts with >),
into the “Enter Query Sequence” box.

3. Click “BLAST” and wait for processing.
E. Record data in file ‘ddmmmyy BLAST of Samples Submitted yyyymmdd’
1. Record top alignment match data — only record one.

2. In Comments, note what other top matches were (ex —top 14 matches were
D. bugensis or rostriformis; top 25 matches were arthropods; etc), as well as
any relevant notes on relative ID or coverage among the top matches (ex —
arthropod matches had 100% ID while D. bugensis/rostriforms had only 85%
ID).

3. For samples with no significant similarity to sequences in the NCBI database,
compare to Unknown consensus sequences using BLAST.

i. Consensus sequences have been generated from some unidentified
sequences using ClustalW. Two consensus sequences explain many
false-positives: Unknown consensus seqA and B. These were
generated from 14NOV11 data. They are in the folder “Consensus
sequences from ClustalW.”

1. Each Word file has the consensus sequence followed by the
sequences used to generate it (highlighted in gray) and other
sequences which match that consensus sequence.

ii. Choose nucleotide BLAST, then click “Align two or more sequences.”

iii. Paste the longer sequence in the “Enter Query Sequence” box and
the shorter sequence in the “Enter Subject Sequence” box. Click
BLAST.

iv. If there is significant similarity between the sequences, note in the
Comments of the BLAST results file.

v. If there is no significant similarity between the sequences, click “Edit
and Resubmit” and change Program Selection to “More dissimilar
sequences (discontiguous megablast)” and re-run. Record results in
Comments.
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1. BLAST breaks the nucleotide sequences into “words” and
looks for the same words in different sequences; the words
in a megablast are longer than in a blastn (28 vs. 11 nt), and
neighboring words have to be more similar in a megablast
than in a discontiguous megablast.

Using Clustal Omega and MultAlin to generate consensus sequences

A.

If a number of unidentified sequences have great similarity, it is useful to generate a
consensus DNA sequence from them to use as a standard against which to compare
other unidentified sequences. Consensus sequences can be generated with Clustal
Omega or MultAlin; MultAlin will give you a consensus sequence (which you must
edit), while you have to make one by hand with ClustalW. It’s useful to use both
programs to explore your data as they present information in different ways;
MultAlin makes it easier to actually make the consensus sequence because it’s
easier to get the data into Word and edit it.

Note that these programs assume your sequence is all either 3’5’ or vice
versa. You can’t enter the forward- and reverse-sequence for a single
reaction and get a consensus sequence unless you first generate the reverse
complement for either forward or reverse. FinchTV allows you to readily

o |
generate the reverse complement by clicking the J‘% I button in the toolbar,
or you can enter text at
http://www.bioinformatics.org/sms/rev_comp.html. Some software
packages can be programmed to compare forward and reverse sequences
(ex: Python, Geneious); that’s not necessary at this time.

B. Clustal Omega

Go to EBI's Clustal Omega — Multiple Sequence Alignment website
http://www.ebi.ac.uk/Tools/msa/clustalo/

in Step 1, change the drop-down menu from Protein to DNA. Paste
sequences you want to compare in the window, in FASTA format.

Leave Step 2 and Step 3 as default options. Submit.

The sequence alignment is presented in a basic fashion, with stars below
nucleotides in complete agreement. Click Result Summary to further
explore the data; use JalView, which presents a consensus sequence and
color-coded data, to explore your data.

C. MultAlin

Go to INRA’s MultAlin website
http://multalin.toulouse.inra.fr/multalin/multalin.html
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Paste sequences you want to compare in the window, in FASTA format. You
can leave Sequence input format on Auto.

Under Optional Parameters, change Symbol comparison Table from the
default (Blosum 62-12-2) to DNA-5-0.

Leave other parameters as default. Click Start MultAlin!

The sequence alignment is presented color-coded; where all submitted
sequences agree the nucleotides are upper-case and red, where >50%
nucleotides are in agreement they’re blue and the consensus is lower-case,
and where <50% nucleotides are in agreement they’re black and “.” in the
consensus sequence.

Click “Results as a text page (msf).” You can copy and paste the sequence
data into a Word file and edit as needed. Pay special attention to areas
where not all sequences had data.

i. Ex: when the 5 sequences used to make consensus seqB are run,
there’s a region at the start where only 3/5 submissions had data.
Where those 3 sequences are not in complete agreement (ex: 2/3
have C, 1/3 have G) MultAlin gives no consensus data. It makes it
look like there are gaps in the sequence that don’t really exist.
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SOP: D5.08 TAE Buffer, 50x Dilutions

I Summary

1x TAE buffer is used during gel electrophoresis due to its basic pH, which gives the
phosphate group on the DNA a negative charge. This allows migration of the DNA toward
the positive anode in the electrophoresis chamber.

1. Equipment

TAE Buffer, 50x
Deionized water
Graduated cyclinder
1 liter bottle

Il Procedure

A. For 500 ml 1x TAE Buffer: measure out 490 m! of DI water and add to collection
bottle.

B. In agraduated cylinder measure out 10 ml of 50x TAE Buffer and add to DI water,
mix well.
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SOP: D6.01 UV Equipment Sterilization

. Summary

UV sterilization is an important step in reducing the risk of cross-contamination and
ensuring that the laboratory equipment and benches are sterilized properly.

1. Equipment

Sterilaire lamp, 254 nm
Previously used equipment
Lamp timer

UV goggles

M. Procedure

A. Equipment sterilization using the Sterilaire UV lamp should be done after the
following; extractions have been performed, work has been done with reagents
under the laboratory hoods, and/or it is the end of the work day.

B. Before turning on the UV Sterilaire lamp, make sure no one else is in the inner
laboratory. Clean up the workstation bench and reagent area so that only
equipment needing sterilization is left out.

C. Setthe lamp timer for the number of minutes necessary for the sterilization

 process. Make sure the proper PPE equipment is worn by anyone present in the

inner laboratory, including but not limited to UV goggles and laboratory coats.

D. Turn on the UV Sterilaire lamp and leave the inner laboratory immediately.
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Attached Documentation:

Molecular Laboratory Equipment Documentation (A6.00)
Molecular Laboratory Thermometer Log (A6.14)
Molecular Laboratory Cleaning Log (A6.01)
Thermometer Calibration Log (A6.12)

Wahweap Laboratory Map (A1.03)

SOP: D6.02 Molecular Laboratory Equipment Documentation

Summary

The Molecular Laboratory is furnished with all the items needed to achieve accurate test
results and to perform quality control activities. All equipment is maintained in good
working order. Each piece of equipment is documented and uniquely identified by a
serial number and/or National Park Service property number. Documentation is
maintained in the Equipment Maintenance and Cleaning Log. If a piece of equipment
performs unsatisfactorily, the instrument is removed from service, tagged, and repaired
with proper documentation, and all test results and quality controls are scrutinized.
Equipment that has been repaired must be tested and/or calibrated prior to being
returned to service. Preventative maintenance is also scheduled for each piece of
equipment. When applicable, NIST traceable references are used for equipment
calibrations. Each piece of equipment marked to indicate its calibration status.
Equipment that is not within acceptable calibration is either calibrated, removed from
service until it has been repaired, or a correction factor is established.

Equipment

All laboratory equipment
Thermometers
Electronic balances

Procedure
A. Laboratory Equipment

1. An Equipment Documentation form must be maintained for each piece of
equipment. Information on this form includes: the date, preparer’s name, name
of item, manufacturer name, model number, serial number, NPS property
number, electrical information, location of the manufacturer’s instructions
(must be within the laboratory building), date received, condition when
received, date placed in service, current physical location, date and description
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of each maintenance activity, and date and description of each repair. The
current physical location must be indicated on the Wahweap Laboratory Map
(Attachment A1.03).

2. The equipment documentation must be current. Any changes to the status of
the equipment must be documented on the Equipment Documentation form.

3. Whenever equipment performs unsatisfactorily, a corrective action report must
be completed. Refer to SOP 7.04: Corrective Action.

4. All equipment must be marked identifying the calibration status. All new
equipment must be calibrated before use.

5. All equipment must be cleaned regularly. Cleaning dates must be recorded in
the Molecular Laboratory Cleaning Log (Attachment A6.01).

B. Thermometers

1. Calibration status of all laboratory thermometers is summarized on the
Thermometer Calibration form (Attachment A6.12). This log records the
following information: the thermometer identification, company, catalog
number, contents, serial number, calibration expiration date, and location.

2. Individual thermometers must also be documented with a Molecular Laboratory
Thermometer Log (Attachment A6.14). It documents additional information
including when the thermometer was received, placed in use, and the range and
accuracy of the thermometer.

3. Annually, all laboratory thermometers are calibrated using a NIST traceable
calibration thermometer. Documentation of the calibration status of individual
thermometers is maintained in the Thermometer Logbook

C.Electronic Balances

1. An Molecular Laboratory Equipment Document form (Attachment A6.00) is
maintained for each weight used for balance calibrations.

2. Annually, if the weights are to be used, they are calibrated with NIST traceable

standards. Documentation of the calibrations must be maintained with the
Equipment Documentation form.
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Attached Documentation:
Finnpipette Calibration Record {A6.17)
Finnpipette Calibration Template (A6.18)

SOP: D6.03 Finnpipette Calibration and Maintenance

1.

Summary

Every technician in the Molecular Laboratory is required to read the Good Laboratory
Pipetting Guide. Proper care must be taken when handling pipettes, calibrating pipettes
and performing daily, weekly and monthly maintenance procedures.

Equipment
Calibration: Finnpipettes F2 series
Pipette tips
DI water
1.5 ml test tubes
OHAUS analytical balance
Cleaning: Finpipettes F2 series
70% ethanol
Pipette service tool (there is one for each lab location)
Pipette grease
Finnpipette Instructions for Use booklet
Calibration

Note: All Finnpipettes are factory calibrated and adjusted to give the volumes within ISO
8655 limits with distilled or DI water using the forward pipetting technique. The use of
other pipetting techniques may affect the calibration results. The pipettes are
constructed to permit re-adjustment for other pipetting techniques or liquids of
different temperature or viscosity.

1. The OHAUS analytical balance in the inner fab should be used when
calibrating the Finnpipettes; it is the most sensitive balance we have, with a

readable graduation of 0.01 mg.

Pipette Volume Range Recommended Readable Graduation

under 10 ul 0.001 mg
10-100 pli 0.01 mg
above 100 pl 0.1 mg
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Test liquid should be either distilled or deionized water. Tests should ideally
be done in a draft-free room at a constant (+0.5°C) temperature of water,
pipette, and air between 15°C to 30°C.

Use of forward pipetting technique is recommended. The maximum
permissible errors for ISO 8655 limits are designed for forward method.

To avoid cross-contamination, bleach the area around the balance and wear
gloves while checking calibration. If checking the calibration of pipettes
from different areas of the lab on the same day, follow order of entry. Do
not set the pipettes down; it is best to pipette with one hand and to handle
the tubes, push buttons on the balance, and record data with the other.

Procedure

a. Print Finnpipette Calibration Record (Attachment A6.17) for the
pipettes being checked.

b. Adjust pipette for delivery of the selected volume.

i. Pipettes are checked with the maximum (nominal) and the
minimum volume. The OHAUS balance is not sensitive
enough to measure <1 pl, so 1 pl and the nominal volumes
are measured for the 0.2-2 pl and 0.5-5 ul Finnpipettes.

c. A new tipis first pre-wetted 3-5 times by drawing liquid back-and-
forth; then a sample is drawn for measurement.

d. To avoid evaporative loss, pipette water into a 1.5 ml
microcentrifuge tube and close the lid immediately.

i. If not using a closed tube, relative humidity must be above
50% to reduce the effect of evaporation loss. Special
accessories such as an evaporation trap are recommended.

e. Do 10 pipettings with the minimum volume and 10 with the
maximum volume. Record mass in mg to two decimal places.

f. Calculate the accuracy and precision with the Finnpipette
Calibration Template (Attachment A6.18) for each pipette; save the
excel file and record relevant measurements on A6.17. Place A6.17
in the Equipment Maintenance Log.

Troubleshooting accuracy — average volume is too high or low
a. Use pipette tool to adjust pipette; place tool in the openings of the

calibration nut at top of the handle (see Instructions for Use, p. 8).
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Turn clockwise to increase volume expelled, counter-clockwise to
decrease. Generally, 1/8-1/4 turns are adequate. Check calibration
after adjustment.

7. Troubleshooting precision — standard deviation is too high

a. Indry locations, humidity within the pipette itself may increase
when pipetting; measure the nominal volume first to equalize
humidity more quickly.

b. Make sure you're using the correct pipette tip (ex: the 1-200 ul tip
has a crease at =100 pl, so trying to measure 100 pl with this tip
gives high standard deviation).

¢. Make sure you are pre-wetting the pipette tip; if first measurement
with a new tip is an obvious outlier, discard that measurement.

d. Change pipette tips frequently (after every 3-4 measurements).

e. Small drops of water may cling to the pipette tip. Do not pipette
into an empty tube; put some water in the tube you will use to help
pull water off the tip. When expelling water, leave the tip close to
the water as you expel to the second stop; this helps prevent static
from pulling expelled droplets onto the tip.

f. Check the pipette tip after expelling water; if you see a water
droplet(s} on any part of the tip you may not get an accurate
measurement.

g. The OHAUS balance rarely stops at a definitive final weight, instead
giving a range of numbers (range may cover 0.05-0.10 mg).
Additionally, checking the calibration may take at least %2 hr per
pipette and can tire your wrists. To speed the process, you may
take 11 readings and discard one outlier, replacing it with your
spare; it’s not an ideal situation, but it greatly simplifies the process.

h. If none of these tips are working, you may need to disassemble and
clean the pipette; make sure the O-rings are greased.

Iv. Disassembly and Cleaning

1. When disassembling and cleaning the pipette, work at the island in the inner lab or
the side work bench (with thermocycler, etc.) in the outer lab.

2. Refer to pages 9-10 in the Instructions for Use guide for how to dis- and reassemble

pipettes. Refer to the pipette diagrams starting on page 49 of the guide for part
descriptions and how they are organized in the pipette.
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Clean the work surface with 10% bleach solution. Wear gloves to prevent cross-
contamination and to help keep the inner pipette parts clean. Make sure you have
paper towels as well as all equipment listed in section !l above.

Take off the tip ejector: depress the tip ejector button and while holding it down,
turn the tip ejector (tube part) clockwise.

Put down a paper towel on which to put the pipette parts as you remove them.

Use the pipette service tool to loosen the tip tube by turning it clockwise. Carefully
unscrew the tip tube while holding the pipette upright. Remove the handle and put
aside.

Holding the piston in place, turn the tip tube upside down. Pull the piston and
associated parts out, gently dragging the piston against the inside of the tube as you
do to remove as many of the parts as possible. Put the parts on the paper towel,
keeping them in the same order in which they came out of the pipette. |

a. Some parts (usually O-rings and small springs) may be left inside the tip
tube; try to push/drag them out with the piston. Swirling the tip tube in the
ethanol may help to loosen things up. ’

Once all parts are out of the tip tube, look inside it to check for particles and/or
debris. Wash it with ethanol if there are any; use a cotton swab or twisted-up paper
towel if needed. After you have cleaned it, remove as much ethanol as you can by
tapping the tube against a paper towel/wicking with swab or towel, then leave it to
finish air-drying.

Use a sponge or paper towel dipped in 70% ethanol to wash the pipette parts. Let
the parts dry completely.

Use a small paint brush or folded-up paper towel to smear grease onto the piston,
piston spring, and O-rings. Do not grease the other parts.

Check the tip tube. Once it is completely dry, reassemble the pipette according to
the instructions on pages 9-10 (generally, you'll put the various pieces onto the
piston in order; put the piston assemblage in the tip tube; put the short, fat spring
and it support over the piston assemblage; then screw on the handle).

Check calibration after cleaning.

Maintenance

1.

Daily

a. When pipette is not in use it should be stored in an upright position on the
pipette stand.
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b. Pipettes should be checked at the beginning of each day for dust and dirt on
the outside of the pipette surfaces.

¢. To clean a dirty pipette, wipe the surface with a paper towel moistened with
disinfectant (70% ethanol). Do not immerse the handle in any disinfectant.
Pay particular attention to the tip cone. No other solvents except 70%
ethanol should be used to clean the pipette.

2. Every 4-6 months

a. If the pipette is used every day its calibration should be checked every three
months. Our pipettes are not used daily; calibration should be checked
every 4-6 months.

3. Annually

a. If the pipette is used every day it should be disassembled and cleaned twice
a year, and the calibration checked after cleaning. Our pipettes are not
used daily; they should be cleaned once each year.

4. Sterilization — as needed
a. Using bleach — preferred method

i. According to the Finnpipette Good Laboratory Pipetting Guide,
pipettes can be cleaned of DNA with bleach: parts should be
immersed in 10% bleach for at least 15 minutes, then rinsed
thoroughly with distilled water and allowed to air dry.

b. Autoclaving — less preferred

. i.  Note that heat does not readily break DNA’s phosphate backbone;
that’s why PCR works. Autoclaving is less reliable than bleach and
other products/methods for destroying DNA, and can become a
source of cross-contamination if amplified DNA gets into the
autoclave.

ii. The entire pipette can be sterilized by autoclaving it at 121°C
(252°F) for a minimum of 20 minutes. No special preparations are
needed for autoclaving. You can use steam sterilization bags if
needed. After autoclaving the pipette must be cooled to room
temperature for at least two hours. Before pipetting, make sure
that the pipette is dry.

iii. Do a wipe test of the autoclave after sterilizing and run it through
PCR to check for the presence of amplifiable DNA.
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SOP: D6.04 Vortex Genie 2 and Lab Dancer Operation and Maintenance

I Summary

Mixing is essential in DNA extraction and PCR set-up procedures. In order to reduce the
possibility of cross-contamination, separate areas in the laboratory are in place, each with
its own set of necessary equipment.

1. Equipment

Vortex Genie 2
Vortex adapter
Lab Dancer

1. Procedure

A

Remove the 3 inch platform head (or any other adapter) attached to the Vortex-
Genie 2.

Note: the 3 inch platform head with the knobs and the Vortex Adapter do NOT take
any special tools to remove them, although initially the fit is very snug.

To remove, simply place all 4 fingers from one hand under one side of the platform.
Do the same with the other hand. Then place thumbs on top and press upwards
with fingers. Press first from the back and then from the front rocking back and
forth. it should pop right off.

All adapters have a specific orientation. On the bottom of the MoBio Vortex Adapter
is a black plastic part which contains a flat surface. To install the adapter, align this
flat surface with the flat side of the black plastic nub on the Vortex.

Failure to attach in the correct orientation will damage the Vortex Adapter and may
cause the adapter to fall off the vortex at high speeds resulting in possible loss of

samples or injury.

Once aligned properly, press firmly straight down until the Vortex Adapter snaps in
place.

When using the Adapter, always insert tubes into the clips with the tube cap facing
the center of the adapter.
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H. For the 1.5-2.0 ml tube Adapters always slide tube in with cap toward center of
adapter until it “clicks” in.

I. Tubes should always be balanced and placed in opposing positions (minimum of 2)
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SOP: D6.05 LW Straight 8-3K Centrifuge Operation and Maintenance

.

Summary

Plankton samples may need to be concentrated first by spinning down the tubes before
removing any excess ethanol, if they are not being processed immediately.

Equipment

LW Straight 8-3K Centrifuge
50 ml conical centrifuge tubes

A.

1.

Procedure

Always balance the load, be certain tubes of equal weight are across from each
other. If you only have one tube to spin, you must use another tube filled with water
to balance the rotor. Proper balancing will improve sample separation and will
extend the life of the centrifuge.

Always make sure tubes are supported from the bottom. Never allow a tube to
hang by its cap on the rim of the tube shield.

Know the G-Force limits of your tubes. The Straight 8 at full speed will produce
enough g-force to break many types of tubes. Be certain that you are not exceeding
the recommended g-forces for the brand of tubes that you use.

Never force a tube into the shields. Tubes should fit easily into and out of the tube
shield. Make sure the tubes do not exceed the length limit (130 mm long and 17 mm
diameter-15 ml size).

Select the desired speed and time and start the centrifuge. The Straight 8 cannot be
opened while the rotor is turning.

Once the unit has completed the spin and come to a complete stop, the bell will
ring. The lid will remained unlocked for 7-10 seconds, then relock again for safety.
To unlock later, simply push the OPEN or OFF button.

Maintenance

Keep the tube shields clean. If a tube breaks inside a shield, clean all the debris from
the shield and bowl and disinfect.
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Motor and electrical maintenance: The Straight 8 uses a maintenance-free brushless
motor and its bearings are permanently lubricated. It should not need servicing for
the life of the unit. Likewise, the electrical components were designed for high
reliability and should not need regular service. If services are needed contact LW
Scientific at 770-270-1394 or www.lwscientific.com

Make sure to document any maintenance done on the centrifuge on the LW Straight
8 3K Centrifuge Equipment Documentation form.
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Attached Documentation:
Ohaus AP250D Electronic Balance Calibration Record (A6.16)

SOP: D6.06 Qhaus AP250D Electronic Balance Operation and Maintenance

I Summary
Precise measurements are needed when calibrating Finnpipettes and measuring out

samples or reagents.

. Equipment

Ohaus AP250D Electronic Balance 1.5 ml microcentrifuge tubes
Pipette tips Weigh boats
Spatulas

Il Procedure

A. Turn on the balance, set a weigh boat/tube on the scale and press ON/TARE.

B. Once the display shows all zeros, add the sample to the boat/tube and close the
door to weigh.

C. Do not leave anything (weigh boats, centrifuge tubes, etc.) on the balance when not
in use.

V. User Calibration

A. User Calibration: Use to calibrate the balance using a mass of 200 grams.
1. Make sure there is no load on the pan and close the chamber doors.

2. Level the balance using the knobs on the rear feet and the bubble level built
into the balance in the rear-left corner

3. Press and hold the ON/TARE button until MENU is displayed, press ON/TARE
once more to display CAL

4. Press ON/TARE to display AUTO
5. Press MODE to display USER

6. Press ON/TARE to display 200.0000 g-the value of the last calibration mass is
displayed
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11.

12.

13.
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Press MODE to change value of the flashing digit
Press ON/TARE to accept value

Repeat steps 6 and 7 and set the numbers to match the value of the selected
calibration mass

Press ON/TARE to display CALO g

Press ON/TARE to display - C -, press ON/TARE again to display CAL 200 g =
required mass

Add 200 g calibration weight, being sure not to touch it with your skin; display
should show CAL200 g

Press ON/TARE to display - C -, press ON/TARE again to display 200.000 g

B. Auto Calibration

1.

2.

Auto calibration: Use when desired to calibrate the balance automatically

Level the balance using the knobs on the rear feet and the bubble level built
into the balance in the rear-left corner

Make sure there is no load on the pan and close the chamber doors
Press ON/TARE to display MENU, press again to display CAL
Press ON/TARE to display AUTO

Press ON/TARE to display - C -, do not disturb the balance when - C—is
displayed

The calibration is finished when 0.00000 g is displayed

Record results in the Ohaus AP250D Electronic Balance Calibration Record
(Attachment A6.16)

Maintenance

1.

2.

Wipe platform and pan after each use.

To work properly the housing and platform should be kept clean and free from
foreign particles

Before use, use a cloth dampened with mild detergent and wipe down the
entire balance

Keep calibration weights in a safe dry place
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SQOP: D6.07 Eppendorf Microcentrifuge 5424 Operation and Maintenance

1.

Summary

The Eppendorf Microcentrifuge 5424 is intended for sample preparation during DNA
extractions and for DNA cleanup after PCR. The fixed-angle rotor allows for 24 tubes to be
spun at any given time.

Equipment

Eppendorf Microcentrifuge Model 5424
Instruction Manual
Extraction samples

Procedure

A.

For a short run: the short button must be held throughout the entire short run. Time
is counted upwards in seconds. Centrifugation is stopped by releasing the short
button during the braking process; centrifugation can be restarted twice by pressing
the short button again.

For continuous operation: the continuous function is set using the time selection
knob to above 09:59h or below 30 seconds. The timer shows “00” to indicate
continuous running. Time is counted upwards in 30-second increments.

The speed is adjusted in increments of 50 rpm or the g-force (rcf) in increments of
50 x g. Further calculations can be found in the Instruction Manual.

Further applications such as standby mode, permanent parameter settings, etc. can
also be found in the Instruction Manual

Maintenance

The outer surfaces of the centrifuge and the rotor chamber should be cleaned
regularly with a neutral agent such as 2% Extran solution. This is for hygiene
purposes and to prevent adhering impurities causing corrosion.

Before cleaning, unplug the power plug with the lid open, unscrew the rotor using

the rotor key supplied (on top shelf of second cabinet from left above centrifuge)
and clean it separately. Use only neutral agents.
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Do not allow any liquid to get into the gap at the motor shaft outlet. Therefore, only
clean the rotor chamber with a damp cloth.

The rubber seal in the rotor chamber should be rinsed off thoroughly with water
and lubricated with glycerin or talc after every cleaning to prevent them from
becoming brittle.

Rotors need cleaning regularly to prevent residues of the material being centrifuged
from changing their properties.

Check the rotors for residues and corrosion at least once a month. This applies to
the rotor bores in particular.

For thorough cleaning, the rotor is unscrewed using the rotor key supplied and
cleaned using a neutral agent.

Rinse the rotor and bores thoroughly and place on a cloth with the bores facing
downwards to dry.

Once dry the rotor can be put back in and the rotor nut tightened.

. All rotors, rotor lids and adapters can be autoclaved (121°C, 20 min.), though this is
not recommended for DNA clean-up as DNA fragrments may contaminate the
autoclave.

in case of glass breakage, carefully remove all splinters and all ground glass from the
rotor, the adapters and the rotor chamber. You may need to replace adapters in
order to prevent further damage.

Fine glass splinters can scratch the surface of the rotors, reducing their resistance to
chemicals
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Attached Documentation:
DNA Quantification (A3.05)
PCR Mastermix Setup (A4.05)

SOP: D6.08 Nanodrop 2000 Operation and Maintenance

.

Summary

The Nanodrop 2000 provides accurate and precise nucleic acid concentration
measurements to be used in preparation for PCR sequencing (Refer to Attachment A5.06:
Preparing Cleaned-up DNA Samples for Sequencing). It is also used for QA/QC in DNA
extraction by providing information on the nucleic acid concentration of extracted DNA
samples and extraction negatives.

Equipment

Nanodrop 2000

DNA sample

DI water

TD3 buffer (if measuring DNA samples extracted with MoBio kit)
Kimwipes

Pipette

Pipette filtered tips

Procedure

1. Bleach the countertop around the Nanodrop and computer. Then bring the samples
to be measured over; allow them to thaw completely if they have been frozen.

2. Open the Nanodrop software and select the nucleic acids module.

3. |Initialize the Nanodrop by lowering the lever arm, wait (approximately 10 seconds)
until told to load the blank.

4. Perform a blank measurement by loading 1 ul DI water (for cleaned-up PCR product)
or TD3 buffer (for DNA extracted using MoBio kit) onto the pedestal; lower the arm
and select “blank.”

a. OPTIONAL: Measure the concentration of the water or buffer to ensure that
the instrument has been zeroed properly. (All measurements are
automatically normalized to 340 nm). The result should be a spectrum that
varies no more than 0.04 A.
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5. To measure the DNA concentration and purity, gently flick the tube to mix. Pipette
1 ul of sample onto the pedestal and lower the arm. Enter the sample ID in the
appropriate window, then click “Measure”.

a. Clean the upper and lower pedestals off with a Kimwipe after each sample.
b. Run a blank every 30 minutes during sampling.

c. Clean the measurement surfaces with 2 pl water after particularly high-
concentration samples.

6. After a large number of samples, the areas around the pedestals should be cleaned
thoroughly to prevent previous samples from being wiped back onto the pedestals,
affecting low-level measurements.

7. After the last measurement, do a final cleaning of all surfaces with DI water.
a. Pipette 1 pl of clean deionized water onto the sample pedestal.

b. Close the lever arm and tap it a few times to bathe the upper optical surface.
Lift the lever arm and wipe off both optical surfaces with a Kimwipe.

8. Record the DNA concentration and 260/280 ratio for all measured samples on the
DNA Quantification form (Attachment A3.05) and add the form to the PCR binder.

a. The 260/280 ratio is used to assess the purity of the sample. It should ideally
be between 1.80 and 2.00.

9. Put away all samples and blanks (water and TD3 buffer), then bleach the countertop
around the Nanodrop and computer.

Maintenance

1. The pedestals need to be reconditioned periodically to ensure accurate sample
measurement. Look at the sample after you pipette it onto the pedestal —if it
doesn’t look like a round bead of water and is instead flat at the edges, the pedestal
should be reconditioned.

a. Use the PR-1 Reconditioning Kit (in drawer below countertop with
Nanodrop). Follow the instructions provided with the kit.

b. Itis especially important to check the condition of the pedestals before
checking the machine’s calibration and before measuring the DNA
concentration of samples being sent for sequencing. If the pedestal is not
conditioned it can cause inaccurate measurements, which has a negative
impact on both the calibration check and [DNA] measurement.
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Calibration
1. The NanoDrop should be calibrated and the light intensity checked every 6-12
months. Because we don’t use the NanoDrop daily, every 12 months is likely

sufficient.

2. To calibrate, you must use calibration fluid CF-1; may purchase from Thermo
Scientific or Fisher Scientific.

a. Pedestals should be clean and conditioned.

b. Click on Diagnostics in the left panel. Open Calibration Check.

c. Enter the target absorbance {on the CF-1 vial) in the appropriate field.
d. Blank with 1 pL dH,0 and wipe dry.

e. Shake CF-1 vigorously to mix. Open, and measure 10 replicates of 1 pL
each.

f. The CF-1 sample must be used within 1 hour of opening

g. After the 10" replicate, the program will notify you if it passed calibration.
If it did not then repeat the process with 2 pL of CF-1 per replicate. ifit
passes with 2 pL but not 1 pL CF-1, that indicates the pedestals need to be
reconditioned. If it does not pass with either 1 or 2 uL CF-1, contact
Technical Support.

3. To check light intensity, make sure the pedestals are clean and dry.

a. Click on Diagnostics in the left panel. Open Intensity Check.

b. With the sampling arm down, click “Measure”.

c. |Ifgreen circles with checks are displayed in the top left of the spectral
display, then it passed. If yellow triangles are displayed in the top left of the
spectral display for either Visible or UV indicators, clean the pedestals by
putting 3-5 pL dH,0 on the pedestal, lower the arm, and let sit 2-3 minutes

before wiping off. If there is a yellow triangle for the Bias indicator, make
sure the instrument is not cold (warm it to room temperature).
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SOP: D6.09 Thermomixer Operation and Maintenance

Summary

The Eppendorf Thermomixer maintains constant temperature and shaking speed which is
essential during DNA extractions.

Equipment

Eppendorf thermomixer
DNA extractions

Procedure

A.

The time counting function enables temperature control and/or mixing for a limited
period of time. The temperature will be held constant by the device even after the
set time has elapsed.

There are two ways to measure the time of the temperature control processes:

1. Time control: time counting begins immediately when “Start/Stop” is pressed.
The indicator lamp in the key lights up.

2. Temp control: time counting only starts when the nominal temperature value
has been reached. During the time in which the device controls the temperature
to reach the nominal temperature, the colon of the time display flashes. This
signals that the device is active. When the nominal temperature has been
reached and time counting starts, the indicator lamp of the “Start/Stop” key
lights up. To terminate the process early, press the “Start/Stop” again.

Hold the “Progr.” key while switching the device on. Hold the key until the display
either shows time control or temp control.

Using the “Time” arrow keys, set time counting.

Set the temperature with the “Temp.” arrow keys or press “Start/Stop”, if you do
not want to change the nominal temperature.

Operation without temperature control: press the “Temp.” arrow key until off

appears on the display. The device remains at room temperature and does not heat.
You can use the device as a mixer without temperature control.
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Mixing: set the mixing frequency (rpm) with the “Mix” arrow keys. Pressing the key
once will adjust the frequency by 50 rpm.

Press the “Start/Stop” key to start the mixing process. During the run the green
indicator lamp in the “Start/Stop” key lights up. To finish the mixing process, press
“Start/Stop” again.

Short mix: keep the “Short Mix” key pressed. The device mixes with the set
frequency until the “Short Mix” key is released. During the first minute, time
counting starts in second intervals and then changes to minute intervals.

Interrupting operation: keep the “Start/Stop” key pressed for more than two
seconds. Mixing and time counting are interrupted. You can now carry out manual
operations (e.g. adding reagents, replacing tubes). To continue the run, press the
“Start/Stop” key again.

Interval mixing: the “Interval Mix” function enables a continuous alternation of
mixing activity and mixing pause. The device carries out the mixing procedure,
interrupted by pauses, until the set total time has elapsed. The times for mixing and
the mixing pause can be set independently.

1. Press the “Interval Mix” key for two seconds or more. The green indicator lamp
of the key lights up in green. On the display appears the sign
The interval function is now activated.

2. Using the “Time” arrow keys, set the total time for the interval function.

3. Briefly press the “Interval Mix” key. The sign flames on the display.

4. Using the “Time” arrow keys, set the mixing phase. Briefly press the “Interval
Mix” key. The sign  flashes onlgje display.

5. Using the “Time” arrow keys, set the pause phase.

6. Pressthe “Start/Stop” key to start the interval function. The device begins to
alternate between mixing and mixing pause until the total time has elapsed.

7. To terminate the function before the time is up, hold the “Interval Mix” key for
more than 2 seconds.

Programmable temperature control: enables a program run which consists of up to
two steps. The second step will be started automatically after the first step has been
completed.

1. Hold the “Progr.” Key for more than two seconds. The green indicator lamp in

the key lights u p. One the display appears the sign , to the left@f the
temperature display.
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2. Using the arrow keys, set the parameters. The interval mixing function can be
used in addition.

3. Briefly press the “Progr.” key. On the display appears the sign , to We left of
the temperature display. You are now in the second stage of the program.

4. Using the arrow keys, set the parameters. The interval mixing function can be
used in addition.

5. Press the “Start/Stop” key to start the program. The program step which is
currently visible on the display is now startled. If it is the first step, the second

step is started automatically after the first step has been completed.

L. Save the values: the set values will be saved even after the device has been switched
off.

V. Cleaning and Maintenance

1. Switch off the device and disconnect it from the power supply before starting
cleaning or disinfecting.

2. Do not allow any liquids to enter the inside of the housing.

3. Clean all the outer parts of the Thermomixer with a mild, soap-based solution
and a lint-free cloth.

4. Wipe off the soap solution with distilled water.

5. Dry all cleaned parts.

6. Only reconnect the device to the power supply once it is completely dry.
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SOP: D6.10 Thermocycler Operation and Maintenance

1.

Summary

The Bio-Rad Mycycler Personal Thermal Cycler has the capacity to run 96 reactions at one
time while utilizing temperature gradient technology. There are a variety of different
programming options to choose from with the Mycycler. By becoming familiar with the

User Manual Guide the technician will start to fully understand this instrument’s
capabilities as well as troubleshoot various problems which may come along.

Equipment

Bio-Rad Mycycler Personal Thermal Cycler
Mycycler User Manual

Samples

Procedure

A. To run a stored protocol the following must be done:

1. From the Home screen, press F1-Protocol Library to display the menu of
available protocols.

2. Use the arrow keys to highlight the desired protocol and press Enter.

3. Select Run Protocol from the selection box.

4. Confirm the selections in the Run Setup screen. The temperature
measurement mode and whether to include a hot start prior to running the
protocol may be specified at this time.

B. To create a new protocol the following must be done:

1. From the Home screen, press F2-Create to display the menu of available
protocol templates

2. Choose a pre-programmed template protocol to edit, or select the Custom
option from the selection menu; press Enter

3. Editable fields for the protocol may be changed using the arrow keys and
alphanumeric keys
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To add or delete a step or cycle, press F4-Add/Del

To choose increment or decrement time or temperature, put the cursor on
the time or temperature field to be adjusted and press F3-Option

When finished editing the protocol, press F5-Done
To run the edited protocol without saving the edits, choose Run Protocol
from the selection box or to save the edits prior to running the protocol,

choose Save Protocol or Save Protocol As...from the selection box

Once edits are saved, the protocol can be run from the Protocol Library

C. To edit a stored protocol the following must be done

1.

From the Home screen, press F1-Protocol Library to display the menu of
available protocols

Use the arrow keys to highlight the desired protocol, and press Enter
Select Edit Protocol from the selection box

Editable fields for the protocol may be changed using the arrow keys and
alphanumeric keys

To add or delete a step or cycle, press F4-Add/Del

To choose increment or decrement time or temperature, put the cursor on
the time or temperature field to be adjusted and press F3-Option

When finished editing the protocol, press F5-Done

To run the edited protocol without saving the edits, choose Run Protocol
from the selection box

To save the edits prior to running the protocol, choose Save Protocol or
Save Protocol As... from the selection box

10. Once edits are saved, the protocol can be run from the Protocol Library

D. To put the thermocycler into standby mode the following must be done:

1.

2.

When the instrument is on, hold down the Standby key on the front panel
of the instrument for 3 seconds

If the instrument is in an idle state, Standby mode will be started
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3. If a protocol is either running or has been edited without saving, the
selection must be verified prior to initiating Standby mode

4. *Note: Standby mode is a feature to reduce power consumption of an idle
instrument. Just enough power is supplied to maintain microprocessor
operation

Maintenance

1. Make sure no liquid is spilled onto or into the MyCycler. If liquid does spill
immediately clean up the spill.

2. In addition, periodically wipe it clean of dust and other residue that comes
with normal operation of the instrument. Use a soft, lint-free cloth and de-
ionized water.

3. For replacing fuses and troubleshooting procedures refer to the Mycycler™
Thermal Cycler Instruction Manual.
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SOP: D6.11 USA Personal Microcentrifuge Operation and Maintenance

.

Summary

The Personal Microcentrifuge comes with 2 sets of rotors for the option to spin 1.5 ml
tubes used during extractions or PCR set-up using 0.2 ml tubes.

Equipment

USA Scientific Personal Microcentrifuge
Microcentrifuge tubes

Procedure

A. To open, press firmly down on the release tab while lifting the dome lid.

B. Insert tubes into rotor completely. Be sure that each tube is securely closed and of
equal volume. If necessary, add additional tubes filled with water for balance.

C. Properly balanced loads are essential for safe and quiet operation.

D. Close lid securely and activate side switch. Device will not operate with lid open.

E. To stop microcentrifuge, deactivate side switch. Wait until device has completely

stopped to release lid. Remove samples.

Exchanging rotors

A.

The centrifuge is supplied with two interchangeable rotors that can be exchanged
using the provided allen wrench.

Locate the screw set in the brass attachment at the base of the rotor. Using the
wrench, loosen the set screw and pull up on the rotor to remove.

Place the other rotor onto the shaft making sure that the rotor is straight.

Tighten the set screw using the allen wrench just until tight. Do not over-tighten as
this can cause damage to both the centrifuge and the rotor.

Page1of1l



SOP D6.12 Issue 2

Effective Date /4 Aues 2016

</
Approved By \VIW/M/Q&”\

Attached Documentation:
Core™ Balance Calibration Record (A6.15)

SOP: D6.12 Core™ Balance Operation and Maintenance

HI.

Summary

The Core™ Balance is necessary for performing gel electrophoresis to measure the correct
amount of agarose needed. It also allows for the complete separation of equipment from
the inner laboratory and the outer laboratory, which is necessary for reducing the risk of
cross contamination.

Equipment

Weigh boats Spatula(s)

Procedure

A. Pressthe [Tare] key to set a new zero point. Zero will be set if the reading on the

scale is less than 3% of the balance’s capacity. This may be necessary if the weight is
not reading zero with nothing on the pan. The zero indicator will show up in the top
left corner of the LCD.

B. Place the weigh boat on the platform and press [Tare], the display will show zero
and NET will light up on the display. Measure out the necessary amount onto the
weigh boat.

C. To change the weighing units, press [Unit] to cycle through the available units. Refer
to the Parameter section in the Core Series Instruction Manual to enable or disable
the weighing units. Once the unit has been selected, the weight will be displayed in
the selected unit and a symbol for the weight will be shown.

Calibration

A. To enter into the calibration parameter turn the power off press [Unit] and [Tare]
key together at once during the self check sequence.

B. The display will show UnLOAD remove any weight from the pan.

C. Pressthe [Tare] key to enter a zero value.
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The value last used for calibration will be displayed. To select a different calibration
weigh, press the [Unit] key. (For the CQT 202 model 100 or 200g may be used — the
100g weight is in the back of the drawer with the pipette tips in the outer lab)

Once you have selected the weight to use press the [Tare] key.

LOAD will be displayed, place the weight on the pan. DO NOT touch the weight with
bare hands, use the tissue in the weight container.

Once the stable sign is shown press the [Tare] key
If the weight is within 5% of the last calibration the display will show PASS and exit
the calibration routine. If the calibration is not successful the display will show FAIL

and exit the routine, if the calibration fails try again.

Fill out results in the Core™ Balance Calibration Record (A6.15)

Maintenance

Always wipe up spills immediately

Avoid extremes of temperature. Do not place in direct sunlight of near air
conditioning vents.

Make sure the scale is located on a strong table and free from vibration.

Do not let the balance battery go flat — if not using it for a long time you should
charge the battery up periodically to make sure the battery does not lose its charge.

Keep free from vibration. Do not place near heavy or vibrating machinery.

Avoid high humidity that might cause condensation, and keep away from direct
contact with water.

Do not place near open windows, air-conditioning vents, or fans that may cause a
draught and unstable readings.
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Attached Documentation:
Freezer Temperature Log (A6.08)
Molecular Laboratory Equipment Maintenance and Cleaning Log (A6.01)

SOP: D6.17 Fisher Scientific Isotemp® Laboratory Freezer (Model 13-986-223FR) Operation and
Maintenance

l. Summary

The Fisher Scientific Isotemp® Laboratory Freezer is located in the Glen Canyon -
Wahweap laboratory. The freezer temperature must be kept between -15.0 and -25.0°C.

1. Equipment

Fisher Scientific Isotemp Laboratory Freezer (Model 13-986-223FR)
Temperature recording charts

. Procedure

A. During periods of sample processing, temperatures must be taken once daily; during the
summer season when the freezer is also used for beach monitoring, temperatures must
be taken twice daily separated by at least four hours. Temperatures are recorded on the
Freezer Temperature Log (Attachment A6.08), located in the Temperature Logbook.
Record the date, time, temperature, and technician initials for each reading.

B. Freezer temperature must be kept within 5°C of 20.0°C. The adjustable temperature
range of the freezer is 0 to -30°C. The freezer should always be set at -20°C or lower to
minimize potential for freezer to be out of range. If the freezer temperature is out of
range, contact the Laboratory Director.

C. To setthe target temperature for the freezer, press and release the menu key once
while in temperature display mode (default mode) to display the set-point menu. The
display will flash “SP”, followed by the last set temperature. Press the up/down arrow
keys to adjust the set-temperature value. Press the menu key again to save the set-
temperature value and to activate the unit select menu.

D. The freezer should always be set to display the temperature in °C. This is indicated by
the LED’s to the right of the LCD display. If the temperature is not in the correct units, it
must be changed in the select menu, accessed by pressing the menu key twice from the
temperature display menu. The setting can be changed by pressing the up/down arrow
keys. Press the menu key to return to temperature display mode.
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Maintenance and Calibration

The internal digital thermometer calibration must be verified annually using a NIST
traceable calibration thermometer. Procedures are described in SOP 6.27:
Thermometer Calibration. If the temperature indicated by the display is different from
the temperature indicated by the calibration thermometer, the refrigerator’s
temperature offset should be changed.

1. Temperature offset mode is reached by pressing and holding the Menu key for 5
seconds from the temperature display mode. The display should flash “0S” followed
by the last temperature offset value.

2. Adjust the offset temperature using the up/down arrow keys. The offset
temperature should be the difference between the reference temperature and the
display temperature. For example, if the reference temperature is -11.0 °C and the
display reads -10.0 °C, the offset temperature should be set to -1.0 °C. Allow the
refrigerator 30 to 40 minutes to stabilize after adjusting the offset temperature. If
the display is still inaccurate, repeat the procedure.

The hold-off time is the delay in minutes between compressor activations. The hold-off
menu is accessed by pressing the menu key while in the offset menu. “Ho” will flash.
Do not adjust the hold-off time without consulting Laboratory Director.

Every 4 to 6 months, the condenser coil and fan should be inspected and, if necessary,
cleaned to ensure efficient operation. The coil is located behind the vented part of the
header panel (the left side). Disconnect the unit from electrical power and then remove
the header panel and clean the front surface of the coil thoroughly with a vacuum or -
force air through the condenser from the rear. Loosen dirt with a stiff brush if
necessary. Record maintenance in Refrigerator/Freezer Maintenance Log (Attachment
A6.01).

Annually, the condensate evaporator pan should be inspected and, if necessary, cleaned
to prevent odors and ensure efficient operation. Disconnect the unit from electrical
power and then access the evaporator pan, which is located behind the compressor fan.
Clean with a vacuum if dry or sponge clean with soap and water. Record maintenance in
Refrigerator/Freezer Maintenance Log.

The charts used in the recorder on the freezer will record one week’s worth of data.
The use of the recorder is optional and should only be used as an indicator of power
outages in the laboratory. It should not be used to obtain routine temperature
readings.

1. To change the chart, open the recorder. Hold down the “3” button until the pen
arm begins to move. After it has moved completely off of the chart paper, remove
the screw holding the old chart paper. Record the date and time removed on the
back of the old chart paper.

2. Record the date and time on the back of a new chart and write “freezer”. Place the
new chart on the paper and adjust it so that the correct day and time is lined up
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with where the pen will mark on the chart. Replace the screw and hold down the
“3” button until the pen begins to move again. Close the recorder.

Examine the green LED underneath the chart paper. It should be steadily lit. If it is

blinking, then either the main power is disconnected or the 9V backup battery
needs to be replaced. Replace the backup battery if needed.
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Attached Documentation:
Refrigerator Temperature Log (A6.09)
Molecular Laboratory Equipment Maintenance and Cleaning Log (A6.01)

SOP: D6.18 Fisher Scientific Isotemp” Plus Refrigerator (Model 13-986-122R)

.

Operation and Maintenance

Summary

The Fisher Scientific Isotemp® Plus refrigerator is used to store various supplies used in day
to day operations of the laboratory. The refrigerator must be maintained at 1.0 — 4.4°C.

Equipment

Fisher Scientific Isotemp” Plus Refrigerator (Model 13-986-122R)
Temperature recording charts

Procedure

During periods of sample processing, temperatures must be taken once daily; during the
summer season when the refrigerator is also used for Beach Monitoring, temperatures
must be taken twice daily separated by at least four hours. Temperatures are recorded on
the Refrigerator Temperature Log (Attachment A6.09), located in the Temperature log
book. Record the date, time, temperature, and technician initials for each reading.

The refrigerator temperature must be 1.0 —4.4°C. The temperature can be setto a
target operating temperature between 1.0 — 12.0 °C. The set-point should be in the
range of 2.0-3.0 °C.

To set the temperature of the refrigerator, press and release the menu key once while
in temperature display mode (default mode) to display the set-point menu. The display
will flash “SP”, followed by the last set temperature. Press the up/down arrow keys to
adjust the set-temperature value. Press the menu key again to save the set-
temperature value and to activate the unit select menu.

The refrigerator should always be set to display the temperature in °C. This is indicated
by the LED’s to the right of the LCD display. If the temperature is not in the correct
units, it must be changed in the select menu, accessed by pressing the menu key twice
from the temperature display menu. The setting can be changed by pressing the
up/down arrow keys. Press the menu key to return to temperature display mode.
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Maintenance and Calibration

The refrigerator must be cleaned monthly. Wipe the inside surfaces down with soapy
water and a sponge and then rinse with water and dry. Record maintenance in the
Molecular Laboratory Equipment Maintenance and Cleaning Log (Attachment A6.01).

The internal thermometer calibration must be checked during annual preventative
maintenance using a NIST traceable reference thermometer. If the temperature
indicated by the display is different from the temperature indicated by the reference
thermometer, the refrigerator’s temperature offset should be changed.

1. Temperature offset mode is reached by pressing and holding the Menu key for 5
seconds from the temperature display mode. The display should flash “0S” followed
by the last temperature offset value.

2. Adjust the offset temperature using the up/down arrow keys. The offset
temperature should be adjusted by the difference between the reference
temperature and the display temperature. For example, if the reference
temperature was 1.0 °C higher than the display temperature, the offset
temperature should be increased by 1.0 °C. Allow the refrigerator 30 to 40 minutes
to stabilize after adjusting the offset temperature. If the display is still inaccurate,
repeat the procedure.

The hold-off time is the delay in minutes between compressor activations. The hold-off
menu is accessed by pressing the menu key while in the offset menu. “Ho” will flash.
Do not adjust the hold-off time without consulting Laboratory Director.

To ensure efficient operation, inspect the condenser coil and fan every 6 months to
determine if they need cleaned. The coil is located behind the vented part of the
header panel (the left side). Disconnect the unit from electrical power and then remove
the header panel and clean the front surface of the coil thoroughly with a vacuum or
force air through the condenser from the rear. Loosen dirt with a stiff brush if
necessary. Record maintenance in Molecular Laboratory Equipment Maintenance and
Cleaning Log.

Annually, the condensate evaporator pan should be inspected and, if necessary, cleaned
to prevent odors and ensure efficient operation. Disconnect the unit from electrical
power and then access the evaporator pan, which is located behind the compressor fan.
Clean with a vacuum if dry or sponge clean with soap and water. Record maintenance
in the Molecular Laboratory Equipment Maintenance and Cleaning Log.

The charts used for the refrigerator’s temperature recorder will record one week’s
worth of data. The use of the recorder is optional and should only be used as an
indicator of power outages in the laboratory. It should not be used to obtain routine
temperature readings.

a. To change the chart, open the recorder. Hold down the “3” button until the pen
arm begins to move. After it has moved completely off of the chart paper, remove
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the screw holding the old chart paper. Record the date and time removed on the
back of the old chart paper.

Record the date and time on the back of a new chart and write “freezer”. Place the
new chart on the paper and adjust it so that the correct day and time is lined up
with where the pen will mark on the chart. Replace the screw and hold down the
“3” button until the pen begins to move again. Close the recorder.

Examine the green LED underneath the chart paper. It should be steadily lit. If it is

blinking, then either the main power is disconnected or the 9V backup battery
needs to be replaced. Replace the backup battery if needed.
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SOP: D6.19 UV Lamp, 254 nm Operation and Maintenance

l. Summary

UV sterilization is an important step in reducing the risk of cross-contamination and
ensuring that the laboratory equipment and benches are sterilized properly.

1. Equipment

Sterilaire UV lamp, 254 nm
UV lamp timer

. Procedure
A. To turn the lamp on, push the ON/OFF switch on the end of the lamp fixture.
B. Ultraviolet lightbulbs are fluorescent and require relatively little power while in
operation. However, turning the fixture on and off frequently will reduce the life
span of the fluorescent tubes.

Safety Precautions

1. When using shortwave ultraviolet, UV protective eyewear and skin covering is
required to protect all persons exposed to the shortwave UV radiation.

2. Unprotected eyes and skin can be seriously damaged by exposure to shortwave UV.
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Attached Documentation:

Molecular Laboratory Thermometer Calibration Form (A6.13)
Molecular Laboratory Thermometer Log (A6.14)
Thermometer Calibration log (A6.12)

SOP: D6.20 Thermometer Calibration-(Equivalent to Beach Monitoring SOP: 4.15)

.

Summary

Annually, laboratory thermometers must be verified for accuracy using a point check-
method, with a National Institute of Science and Technology (NIST) traceable calibration
thermometer. Calibration thermometers should be reserved for calibration and should
not be used routinely as laboratory thermometers. A label displaying the verification
date and any correction factors must be placed around the top of each thermometer or
on any equipment that has a built in digital thermometer.

Equipment

NIST traceable thermometer
Laboratory thermometers
Beaker

Deionized water

Propylene glycol or ethanol

Procedures

A. Make sure the NIST traceable thermometer calibration has not expired by reviewing
the calibration report stored in the Temperature Logbook. If it has expired, it must
be replaced or recertified by a professional calibration service prior to being used to
verify the accuracy of any laboratory thermometers. Furthermore, check that the
battery is at full voltage.

B. Annually, all laboratory thermometers must be verified at normal operating
temperatures against an NIST traceable calibration thermometer. Normal operating
temperatures for laboratory thermometers:

1) Incubator: 34.5 to 36.0°C
2} Refrigerator: 1.0 to 4.4°C
3) Cooler: 0.0to 10°C

4) Freezer: 0.0to-30°C
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C. When compared to an NIST traceable calibration thermometer, laboratory
thermometers must be within the accuracy range indicated on the Molecular
Laboratory Thermometer Log (Attachment A6.14) and the thermometer. If the
laboratory thermometer is not within this range, it must either be removed from
service or have a correction factor applied.

D. The NIST traceable calibration thermometer and all liquid-in-glass thermometers
must be immersed in an appropriate liquid for all measurements. Use a beaker of
deionized water for temperatures above 02C and below 1002C. Use a beaker of
either propylene glycol or ethanol for temperatures between 02C and -502C.

E. To point-check the accuracy of the built in digital incubator, refrigerator, or freezer
thermometer:

a. Place a beaker of the appropriate liquid on the center shelf of the
equipment and provide enough time for the liquid to equilibrate to the
temperature of the equipment.

b. Immerse the NIST traceable calibration thermometer into the water so
that it is suspended in the liquid and not resting on the bottom.

c. Allow both the calibration thermometer and the digital equipment
thermometer to stabilize. Complete the required fields on the Molecular
Laboratory Thermometer Calibration Form (Attachment A6.13).

d. If a correction factor is needed, follow the manufacture’s instructions to
adjust the correction factor for digital thermometer and record this on the
Molecular Laboratory Thermometer Calibration Form.

e. Place alabel on the equipment displaying the expiration date of the
calibration.

F.  To point-check the accuracy of liquid-in-glass incubator, refrigerator, cooler, or
freezer thermometer:

a. Place a beaker of the appropriate liquid on the center shelf of the
incubator, refrigerator, or freezer, depending on the use range of the
thermometer, and provide enough time for the liquid to equilibrate to the
proper temperature.

b. Immerse the NIST traceable calibration thermometer into the water so
that it is suspended in the liquid and not resting on the bottom.

c. Immerse the thermometer being verified into the water in a similar
manner and to a depth that is consistent with its design, either partially or
completely.
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d. Allow enough time for both the calibration thermometer and the liquid-
in-glass thermometer temperatures to stabilize. Complete the required
fields on the Molecular Laboratory Thermometer Calibration Form.

e. Place a label displaying the expiration date of the calibration and any
correction factor, even if it is zero, around the top of the verified
thermometer.

G. Store the Thermometer Calibration Form with the Thermometer Log for each

thermometer in the laboratory Temperature Logbook. Additionally, update the
Thermometer Calibration log (Attachment A6.12).
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SOP: D7.01 Molecular Laboratory Demonstration of Capability and Internal Audit for Precision

Summary

At the beginning of every summer sampling season and/or when a new technician is
hired, the Quality Assurance (QA) Officer performs an internal audit to test the ability of
molecular lab technicians to extract DNA from plankton samples, run the samples
through PCR to amplify dreissenid DNA, and accurately identify positive and negative
results.

Equipment

Lake Powell plankton samples (4)
Vial(s) containing 10 quagga or zebra veligers

Procedure

A.

The QA Officer uses ethanol to remove the labeling marks from the four plankton
samples and re-labels them A-D.

The QA Officer selects at least four plankton samples previously analyzed by
microscopy, making note of which in the audit record. Zero to four of the plankton
samples may have tested positive for veligers. The QA Officer should select samples
strategically to assure a meaningful demonstration of capability.

Samples are given to the molecular technician, to be processed according to the
molecular lab SOPs.

After the molecular iab technician has processed the samples and identified which
ones they believe are spiked with veligers, their results are compared to the QA
Officer’s records and evaluated.

The Q.A. Officer then writes an Internal Audit for Precision Report. The Internal
Audit of Precision Report contains:

1. A copy of the technician’s DNA extraction (A2.01), PCR well assignment (A4.06)

and gel results (A5.00) sheets, and sequencing results if applicable.

2. A conclusion. The audit passes if all of the technicians’ results are correct as to
“presence/absence” of veligers and they included the correct positive and
negative controls in their PCR run and gel electrophoresis. If the audit fails a
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corrective action report must be written and the technician must be re-tested
until they pass.

F. The Internal Audit for Precision Report must be retained by the Q.A. Officer in the
DOC and Internal Audit Binder.
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SOP: D7.02 Molecular Laboratory Proactive Quality Assurance Program

.

Summary

The Lake Powell Molecular Laboratory’s Proactive Quality Assurance Program consists of
the Molecular Lead analyzing laboratory environmental samples every other month
while in operation to ensure the absence of contamination on the equipment and in the
rooms used for PCR preparation and processing. This proactive plan is for the
prevention and detection of DNA contamination.

Equipment

sterile reagent-grade water

nucleic acid-free g-tip (not contaminated by quagga or zebra DNA)
sterile 1.5 ml microcentrifuge tubes

PCR tubes with master mix

Finnpipettes with filtered tips

Procedure

A. Two types of laboratory environmental samples should be used to ensure DNA
contamination has not occurred.

B. Wipe test: performed by wiping an area, pipette, or other equipment with a sterile,
nucleic acid-free g-tip, then suspending the wipe in molecular-grade water and
processing it as a PCR negative control.

a. Put 300 pl molecular-grade water into a clean 1.5 ml microcentrifuge
tube; close and label the tube with the area and equipment to be tested
(ex: SINK-CT. See lists of abbreviations at end of this SOP).

b. Take a g-tip and wipe it over the equipment; swirl the g-tip end in the
300 pl of water then throw away the g-tip and cap the tube. Add 2.5 pl
of the resulting template to 22.5 pl Master Mix.
C. Room QC controls: prepared by adding sterile water in place of template to a
master mix, then placing the opened tube (on ice) in the room for 15 minutes

before closing and running as a PCR negative control.

D. Tubes should be run with appropriate program for primer set(s) being used.
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E. Test completion should be recorded in Molecular lab’s cleaning and maintenance
log.

F. If a positive test occurs, analysis of samples should cease until the source of the
problem is identified; an exception would be if the outer lab or outer lab-hood room
controls showed amplification, in which case extra care should be taken in cleaning
the outer lab areas and equipment, and controls run again until no amplification
occurs.

G. Write up the results of each test as Molecular Lab Study Notes.

Abbreviations for areas and equipment
Areas —those in bold should have Room Quality Controls run every other month.
ILHD — Inner Lab hood
SINK — IL sink where plankton samples are sieved
FRZR — IL freezer '
ILND = IL island
BNCH — 1L work bench, where DNA extractions are done
NANO — IL Nanodrop
OLHD — QOuter Lab hood
OLBN - Outer Lab bench

Equipment — those in bold should be run for each area every other month. Those not in bold
should be run at least once a year.

CTN — personal centrifuge interior

CTX — personal centrifuge exterior

CT — counter top

HDL - (door) handle

KEY — computer keyboard

MCN — microcentrifuge interior

MCW — microcentrifuge wells

MCX — microcentrifuge exterior

MS — computer mouse

NAN — Nanodrop exterior (base and arm)

PN — pens/markers

PP — pipette; where an area has >1 equipment is called PPA, PPB, etc. with A being the

pipette with smallest volume, B having 2" smallest volume, etc.

PPR — pipette rack

RM - room QC (tube left open in area for 15 minutes)

SIEV — sieves

SPG - spigot (for RO water carboy)

THW — Thermomixer wells

THX — Thermomixer exterior
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Attached Documentation:
Molecular Laboratory Quality Assurance Audit (A35)

SOP: D7.03 Molecular Laboratory Quality Assurance Audits, Managerial Review, and the Quality
Manual

Summary

The combination of Monthly Quality Assurance (QA) Audits, annual Managerial Reviews,
and the Quality Manual are the centerpiece to the Glen Canyon NRA Molecular
Laboratory System. The Monthly QA Audits ensure that laboratory management is
aware of the work being conducted in the laboratories. The annual managerial review
evaluates the continuing suitability and effectiveness of the Molecular Laboratory
Program along with any changes or improvements to the program. The Quality Manual
describes all policies and procedures to ensure and document the quality of the
analytical data. Guidelines for these activities are established in NELAC.

Procedure

A. Quality Assurance Audits

1.

4.

When the Glen Canyon NRA Molecular Laboratory is in operation, the QA
Officer must review the work conducted on a monthly basis.

All logbooks must be checked for proper documentation and usage errors. The
following logs must be reviewed: Corrective and Preventive Action Logs,
Refrigerator Temperature Log, Freezer Temperature Log, Analytical Balance and
Calibration Log, Autoclave Use Log, Supply Log, and Yearly Calibration and
Equipment Documentation Log. Field Data Forms, Sample Check-In/Lab
Tracking Sheets, and Colilert” Count Sheets are proofed in accordance with SOP
1.13: Analyzing Samples with Colilert” and SOP 5.04: Data Entry.

Errors discovered in the log books, with the exception of transcription errors,
must be corrected through the use of Corrective Action Reports. Refer to SOP
8.05: Corrective and Preventive Actions.

The QA Officer records “Proofed,” the date, and initials on every log that has
been reviewed. If the log sheet is only partially used, the QA Officer draws a line
and records the information above it or notes the area and records the
information at the bottom of the sheet.

B. Managerial Review
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1. Annually, the Laboratory Director or delegate must complete a Managerial
Review.

2. This document reviews the quality assurance and testing activities to ensure
their continuing suitability and effectiveness. Furthermore, it documents that
the Quality Manual was up to date and met any new work requirements
necessary for the volume and type of work undertaken.

3. The Managerial Review must include the following topics:

a. A summary of quality assurance activities and results including: Monthly
Quality Assurance Audits, Corrective and Preventive Actions, Demonstration
of Capabilities, Internal Audits for Precision, Proactive Quality Assurance
Program, and Equipment Calibration and Periodic Maintenance.

b. Asummary of laboratory certification activities, assessments, and any other
comments from external bodies.

c. A summary of Standard Operating Procedure alterations that have occurred
since the last Managerial Review.

d. A summary to indicate that the Quality Manual met the requirements found
in the appropriate versions of Utah Rule R444-14, NELAC, and Standard

Methods for the Examination of Water and Wastewater.

4. The Laboratory Director and QA Officer must sign and date the final version of
the Managerial Review.

C. Quality Manual
1. Itis the responsibility of the QA Officer to create and submit to the Laboratory
Director necessary changes to any areas of the Quality Manual in advance of

each sampling season.

2. All areas of the Quality Manual must be uniquely identified by including the date
of issue, page numbering, and the total number of pages.

3. The Laboratory Director and QA Officer must sign and date the final version of
the Quality Manual.
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Attached Documentation:

Molecular Laboratory Corrective Action Index (A30)
Molecular Laboratory Corrective Action Report (A31)
Molecular Laboratory Preventive Action Index (A32)
Molecular Laboratory Preventive Action Report (A33)

SOP: D7.04 Molecular Laboratory Corrective and Preventative Actions

Summary

All activities conducted by laboratory personnel with concern to the Molecular
Laboratory Program and laboratory certification are outlined in the Quality Manual. The
Quality Manual consists of an annual Quality Assurance Manual and all current SOPs.
Corrective Action is taken for nonconforming work, departures from the Quality
Manual, and equipment malfunctions. Preventive Action is a pro-active process to
identify opportunities for improvement. All staff members are responsible for
conducting corrective and preventive actions. When a corrective or preventive action is
identified, a Corrective or Preventive Action Report is completed and given to the
Quality Assurance Officer. After monitoring the results, the Quality Assurance Officer
determines if they are acceptable. If they are not acceptable, a new action report must
be completed. NELAC guidelines are met.

Procedure
A. Corrective Action:

1. Identify the nonconforming work, departure from the Quality Manual, or the
equipment malfunctions.

2. Create a log entry in the Corrective Action Index by filling in the discovery date,
corrective action number (CA#), and subject. The CA# must be the two digit
year followed by the next whole number (For example: 04-001).

3. Create a Corrective Action Report (CAR) using the same date, CA#, and subject
as in the Corrective Action Index. Also, record the problem, cause, records
affected (including previous records), and technician initials.

4. Record the CA# on any affected record.

5. If possible, record any potential solutions to the problem, the solution selected
for implementation and date of implementation, outcome, and technician
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initials. Refer to equipment manuals and Standard Methods for the
Examination of Water and Wastewater for possible solutions.

6. Inform the Laboratory Supervisor, Quality Assurance Officer, and the Laboratory
Director of the situation.

7. Deliver photocopies of the Corrective Action Report to the Laboratory Director
and the Quality Assurance Officer.

8. The Quality Assurance Officer must monitor the results and determine if they
are acceptable, as well as initial, and date all Corrective Action Reports and the
Corrective Action Index promptly. If the results are not acceptable, a new
Corrective Action must be taken, and the unsatisfactory report must refer to the
new CA#.

9. The Quality Assurance Officer must photocopy the reviewed report and deliver
it to the client (Aquatic Ecologist).

10. Procedure for equipment malfunction:
a. ldentify the equipment malfunction or calibration problem.

b. Place a note on the equipment identifying the malfunction. Until the
equipment is repaired, it may not be used.

¢. Follow steps 2 through 9 in Section A.

d. The effect of the equipment malfunction on previous calibrations and tests
must be examined. New Corrective Action Reports are necessary if previous
calibrations and tests may have been effected.

e. After the equipment has been repaired, return the equipment to service
and remove the malfunction note. Repairs must be noted in the Equipment
Maintenance logbook.

B. Preventive Action:
1. ldentify an area for improvement.
2. Create a log entry in the Preventive Action Index by filling in the discovery date,
preventive action number (PA#), and subject. The PA#
must be the two digit year followed by the next whole number (For example:
04-001).
3. Create a Preventive Action Report (PAR) using the same date, PA#, and subject

as in the Preventive Action Index. Also, record the area in need of
improvement, reason, the records affected, and technician initials.
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Record the PA# on any affected record.

If possible, identify potential improvements, the improvement selected for
implementation and date of implementation, outcome, and technician initials.
Refer to equipment manuals and Standard Methods for the Examination of
Water and Wastewater for possible solutions.

Inform the Laboratory Supervisor, Quality Assurance Officer, and the Laboratory
Director of the situation.

Deliver photocopies of the Preventive Action Report to the Laboratory Director
and the Quality Assurance Officer.

The Quality Assurance Officer must monitor the results and determine they are
acceptable, as well as initial, and date all Preventive Action Reports and the
Preventive Action Index promptly. If the results are not acceptable, a new
Preventive Action must be taken, and the unsatisfactory report must refer to
the new PA#.

The Quality Assurance Officer must photocopy the reviewed report and deliver
it to the Laboratory Director.
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Effective Date /6 /4—(49 2O L,

Approved By W//[%/\

Attached Documentation:
Molecular Laboratory Correspondence Index (A36)
Molecular Laboratory Corrective Action Report (A33)

SOP: D7:05 Complaint and Correspondence Policy

Summary

This policy has been created in order to better serve the Glen Canyon NRA Molecular
Laboratory’s clients and outside parties. It follows guidelines set forth in NELAC. The
correspondence loghook is stored in the Laboratory Director’s office.

Procedure

A. Inthe event staff should receive a comment (including complaints) about the
Molecular Laboratory, staff members should instruct the addresser to write a letter
with return address information and send it to:

Glen Canyon NRA

Molecular Laboratory, Laboratory Director
P.O. Box 1507

Page, AZ 86040

B. The Laboratory Director responds to all correspondence.

1. Upon receipt, the in-coming correspondence must be properly documented in
the correspondence log. The day of receipt, addresser’s name, address, and
subject of the correspondence must be entered into the Molecular Laboratory
Correspondence Index (Attachment A36) and the correspondence must be
stored in the logbook.

2. If the correspondence addresses a previously unknown laboratory probiem, a
Molecular Laboratory Corrective Action Report (Attachment A33) must
promptly be completed. Refer to SOP 8.05: Corrective Action.

3. Aresponse must be drafted and given to the Resource Management Secretary
to finalize so that National Park Service correspondence guidelines are met.

4. The response must be signed and sent to the addresser.
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5. The date of response, Laboratory Director’s initials, Glen Canyon Response
Number, and CA# must be recorded in the Correspondence Index. Draw a single
line through the CA# box, if corrective action was not necessary.

6. A copy of the response (along with the incoming correspondence) must be
retained in the Correspondence Logbook under the Glen Canyon Response
Number.

C. The Laboratory Director must also retain a copy of all unsolicited correspondence
sent.

1. The correspondences must be properly documented in the correspondence log.
Draw a single line through the Date of Receipt and enter the name, address, and

subject into the Correspondence Index.

2. Repeat step 3 through 6 in section B replacing “response” with “unsolicited
letter.”
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Effective Date / (0141,‘3. 0] &,

Approved By LW{,%AA

Attached Documentation:
Current SOP Log (A7.11)

SOP: D7.06 SOP Creation and Revision

Summary

A Standard Operating Procedure is maintained for each common laboratory activity. If
ever the Glen Canyon National Recreation Area (NRA) Molecular Laboratory institutes or
changes a procedure, a new SOP or revision must be created. Each SOP has an effective
date and issue number, and is signed by the Laboratory Director and QA officer. Each
laboratory and all laboratory personnel possess a current edition of the laboratory SOP.
Alist of current issue numbers is maintained and displayed to keep all copies of the SOP
current. As part of the document control system, old issues are stored at the Glen
Canyon NRA headquarters for at least five years. All staff must follow SOPs. Technical
errors within an SOP should be brought to the Laboratory Director and QA Officer’s
attention immediately, and a Corrective Action Report must be completed.
Grammatical errors should be highlighted and given to the QA Officer at the end of the
season. The QA Officer reviews all of the SOPs annually.

Procedure

A. The QA Officer must create a new SOP or revision every time a procedure is
instituted or changed. Electronic copies of the SOPs are maintained on the Glen
Canyon NRA computer network.

B. The Laboratory Director must edit the document.

C. When the document is error-free the QA Officer and Laboratory Director sign and
record the effective date on the SOP.

D. The Current SOP Log (Attachment A7.11) must be updated along with the Quality
Manual if necessary.

E. The QA Officer must photocopy the SOP and the current SOP log, and distribute
copies to each laboratory and every staff member.

F. The QA Officer must remove the old version of the SOP from the Master SOP file
and placed it into the Old SOP file.

G. The new SOP is placed into the Master SOP file.
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